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Description

This manual is issued for reference only, at the convenience of Arbiter
Systems. Reasonable effort was made to verify that all contents were
accurate as of the time of publication. Check with Arbiter Systems at the
address below for any revisions made since the original date of publication.

Contact Information

Arbiter Systems, Inc.

1324 Vendels Circle, Suite 121
Paso Robles, CA 93446

+1 805 237-3831
www.arbiter.com
techsupport@arbiter.com
sales@arbiter.com

Definition
This manual describes the Model 933A Portable Power Sentinel, Synchro-
nized Power Quality Meter and PSCSV™ software.

Firmware and Firmware Updates

This manual was created based on version 1.12 of the main DSP program,
dated 18 February 2010. To display the firmware date, press DISPLAY >
9-Config & Status > the Version & S/N soft key.

Firmware Updates are available from Arbiter Systems website or by
contacting technical support at the information above.
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LIMITED WARRANTY

Arbiter Systems makes no warranty, expressed or implied, on any
product manufactured or sold by Arbiter Systems except for the following
limited warranty against defects in materials and workmanship on products
manufactured by Arbiter Systems.

Products manufactured by Arbiter Systems are guaranteed against
defective materials and workmanship under normal use and service for
one year from the date of delivery. The responsibility of Arbiter Systems
under this warranty is limited to repair or replacement, at Arbiter Systems’
option, of any product found to be defective. Arbiter Systems shall have
no liability under this warranty unless it receives written notice of any
claimed defect, within the earlier of:

e Thirty days of discovery by Buyer, or;
e One year from the date of delivery.

For warranty service or repair, products must be returned to a service
facility designated by Arbiter Systems. Buyer shall prepay all shipping
charges, duties, and taxes to send the product to Arbiter Systems and
Buyer shall prepay shipping charges, duties, and taxes to return the
product to Buyer.

THE WARRANTY SET FORTH HEREIN CONSTITUTES THE
ONLY WARRANTY OBLIGATIONS OF ARBITER SYSTEMS, EX-
PRESSED OR IMPLIED, STATUTORY, BY OPERATION OF LAW,
OR OTHERWISE. ARBITER SYSTEMS DISCLAIMS ANY WAR-
RANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICU-
LAR PURPOSE, AND BUYER EXPRESSLY WAIVES ALL OTHER
WARRANTIES.

This limited warranty does not extend to any product, which has been
subject to:

1. Improper use or application, abuse, or operation beyond its rated
capacity, or contrary to the instructions in the operation and
maintenance manuals (if any);

2. Accident;

3. Repair or maintenance performed by Buyer, except in accordance
with the operation and maintenance manuals, if any, and any special
instructions of Arbiter Systems;

4. Modification without the prior written authorization of Arbiter
Systems (whether by the substitution of non-approved parts or
otherwise).
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The remedies provided herein are Buyer’s sole and exclusive remedies.
In no event shall Arbiter Systems be liable for direct, indirect, incidental
or consequential damages (including loss of profits), whether based on
contract, tort, or other legal theory.

FOR THE FASTEST POSSIBLE SERVICE, PLEASE PROCEED AS
FOLLOWS:

1. Notify Arbiter Systems, Inc., specifying the instrument model
number and serial number and giving full details of the difficulty.
Service data or instrument-return authorization will be provided
upon receipt of this information.

2. If instrument return is authorized, forward prepaid to the manufac-
turer. If it is determined that the instrument is not covered by this
warranty, an estimate will be made before the repair work begins, if
requested.

See Contact Information on page ii.
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Chapter 1

Introducing the Model
933A

1.1 Scope

The Model 933A Portable Power Sentinel is designed to provide highly-
accurate measurement of electrical power quality and many other electrical
values important to the power industry. A true seven-channel instrument,
the Model 933A allows independent measurement of three-phase currents
and voltages (including neutral), and associated values.

Designed for data recording and storage, memory is divided between
two 128-MB flash cards. One memory card receives data at the highest
sampling rate directly from the DSP for waveform data storage, and
the other memory card stores the more accurate, standard data after
processing.

To enhance portable operation, the Model 933A has an internal Nickel
Metal Hydride (NiMH) battery. It also has a standard TEC-320 line power
inlet for normal operation and for battery charging.

While the 933A was designed to operate independently in portable
situations from the front panel, its capability is enhanced through using
Power Sentinal CSV 933™ software. Hereafter, the application software is
referred to as “PSCSV”.



1.2 Included Accessories

Accessory Ordering Part Number
CT Input Module AS0074100

Country specific AC power cord PO1R — P12R

Safety ground lead with clip 812HC-8

Modular DB-9 to RJ-11 adapter AP0007700

Operation Manual AS0093900

Model 9338 wer sentine!
Po

al
operation Man

Figure 1.1: 933A with Accessories



1.3

933 A Features

Listed below are some of the most obvious and significant features of the
Model 933A, Portable Power Sentinel. While many of the most significant
features of the 1133A Power Sentinel are present, the 933A embodies some
additional features that make it uniquely important as a synchronized
power measurement device.

1.3.1 Features and Accessories

Seven-Channel Measurement, including three voltage, three currents
plus neutral current.

Separate tabular and graphical indications of each measurement
channel, including voltage, current, power values, power factor and
frequency. Includes Min/Max values and Average.

Harmonic Measurement out to the 50th harmonic in both graphical
and tabular format.

Waveform analysis, including high-speed waveform capture
Sophisticated Triggering from the DSP and external signals

Power quality, energy, phasor, combined measurement viewing
Optional current modules for low range, seven-channel measurement

Auxiliary I/O Module for timing external events and controlling relay
contacts

Two separate 128 MB flash memory cards for storing regular data
and high-speed waveform data

Dual inlet power, including wide range AC/DC supply and recharge-
able Nickel Metal Hydride battery

PSCSV Application software to configure the 933A and control
measurement; use either the RS-232 or USB interface.



1.4 Available Accessories

Current and Voltage Lead Sets

Adjustable Bail Assembly

400 Amp Direct Current Transformer

100 Amp Clamp-on CT, current output

100 Amp Clamp-on CT, voltage output

e Low Current Modules

Auxiliary I/O Module

1.4.1 Lead Set Information

Arbiter Systems offers test lead wire with your choice of two insulation
types, Santoprene and silicone. Both silicone and Santoprene insulated
lead wires are made using finely-stranded rope-lay copper conductors for
exceptional flexibility and limpness.

Silicone is our premier test lead wire. Highly flexible over a wider range
of temperatures (-70 to +150° C, -100 to +300° F) than any other flexible
insulation material, with excellent resistance to damage due to flame
and heat, our silicone wire is highly recommended where safe operation
is required with the possibility of high-current through faults. Silicone
is nonflammable, and will not emit toxic or irritating fumes at extreme
temperatures or under overload conditions.

For most applications, our Santoprene insulated test lead wire is a
cost-effective alternative to silicone, offering most of the same advantages
at a price which compares favorably with PVC, neoprene, and other
lower-quality insulations. Because Santoprene is a thermoplastic rubber,
however, it will melt at a temperature of +216° C (+421° F), and it is
primarily recommended for use in applications where high-current faults
are less likely. Santoprene offers excellent resistance to arc ignition and
good resistance to ignition by a hot wire. And, unlike PVC or halogenated
rubber compounds, Santoprene does not emit toxic and irritating fumes
when it is overheated or burned, and it is inherently self-extinguishing.



1.4.2 Three-Phase Voltage Lead Set, 813AT

The 813AT is a three-phase, four-wire lead set that provides safety-
shrouded stackable 4-mm banana plugs on both ends of the lead set;
includes various plug-on accessories compatible with the 4-mm banana
plugs. This lead set is assembled with #16 Santoprene-insulated lead
wire; leads are protected by gray PET armor and include a Velcro lead
strap.

Figure 1.2: 813AT Voltage Lead Set

Intended primarily for applications where high-energy faults are un-
likely. For high-energy applications, see the Model 815AT Three-Phase
Fused Safety Voltage Probe Lead Set.

1.4.3 Three-Phase Voltage Lead Set, 813BT

The 813BT is identical in construction to the 813AT, except that this
lead set is assembled with #16 AWG silicone-insulated lead wire. Silicone
is our premier test lead wire. Highly flexible over a wider temperature
range (-70 to +150°C, -100 to +300°F) than any other flexible insulation
material, with excellent resistance to damage due to flame and heat, our
silicone wire is highly recommended where safe operation is required with
the possibility of high-current through faults.



1.4.4 3-Phase Spade Lug, Current Lead Set, 816AT

The 816AT is a three-phase current lead set, equipped with 1/4-inch spade
lugs on both ends. Spade lugs are gold-plated for long life in demanding
service, and have oversized barrels to accommodate our finely stranded
test lead wire. This lead set is assembled with #10 Santoprene-insulated
lead wire, has overall gray PET armor and a Velcro lead strap.

Figure 1.3: 816AT (A-phase) Current Lead Set

1.4.5 3-Phase Spade Lug, Current Lead Set. 916CT

Identical to the 816AT, the 816CT is constructed with silicone-insulated
lead wire, instead of Santoprene-insulated lead wire. Silicone is our premier
test lead wire. Highly flexible over a wider temperature range (-70 to
+150°C, -100 to +300°F) than any other flexible insulation material, with
excellent resistance to damage due to flame and heat, our silicone wire is
highly recommended where safe operation is required with the possibility
of high-current through faults.



1.4.6 Universal Test Plug Current Lead Set, 811AT

Assembled with our Universal Test Plug on one end and 1/4-inch spade
lug on the other; compatible with ABB/Westinghouse, Superior, Meter
Devices and States series test jacks. Materials and assembly are similar to
the 816AT Three-Phase Spade Lug, Current Lead Set.

Figure 1.4: 811AT (B-Phase) Universal Test Plug Current Lead Set

1.4.7 Universal Test Plug Current Lead Set, 811CT

Identical to the 811AT, the 811CT is constructed with silicone-insulated
lead wire, instead of Santoprene-insulated lead wire.

1.4.8 Universal Test Plug Current Shunt

Designed to allow indirect current measurement using a clamp-on current
probe with the universal test plug adapter. Clamp the current probe over
a loop of wire at the end of the test plug. AS0079001, red; AS0079002,
yellow; AS0079003, blue; AS0079030, three phase — red, yellow, blue.




1.4.9 Adjustable Bail

Order the adjustable handle/bail assembly (part no. AS0035901) for
convenient bench top use that allows positioning the Model 933A at
common angles to the viewer. Adjust handle/bail by loosening the two
fastening knobs, moving the handle/bail to the desired position and
tightening the two fastening knobs.

Figure 1.5: 933A Case Bail Assembly

1.4.10 400 Amp, 20:1 Precision CT

The Arbiter Systems, Inc. Model 09311A 20:1 Auxiliary
Current Transformer extends the outstanding accuracy,
features and performance of the Model 933A Portable
Power Sentinel by increasing the current input capability
to 400 Amperes. Due to the careful design of the Model
09311A Auxiliary CT, overall accuracy exceeds 0.1% of
reading and 0.1 degrees over the entire input current
range of 1 to 400 amperes.




1.4.11 Clamp-on Current Probes for the 933A

AP0012300: 100:1, 0.1 — 150 Amp, 10mV /A, EN61010, 600 V, Cat.III.
Use only with 933A-02 or 933A-03 low current modules.

AP0012800: 1000:1, 0.1 — 150 Amp, 1mA/A, EN61010, 600 V, Cat. III.
May be used with 933A-01 standard current module. Best with 933A-02
or 933A-03 low current modules because of their greater sensitivity.

AP0012900: Has three ranges: 250:5, 500:5, 1000:5; 20mA /A-250A max;
10mA /A-500A max; 5mA/A-1000A max; EN61010, Cat. III. Use with
any current module.

AP0001300: 1000:1, 1000A max, ImA /A, EN61010, 600 V, Cat.III. Use
with any current module. Best with 933A-02 or 933A-03 because of their
greater sensitivity.

1.4.12 Low Current Modules

Two low-current input modules are available for both current-output and
voltage-output CT’s. Each has two ranges; a high range (up to 1.2 Arms
or 2.4 Vrms) and low range (up to 50 mA rms and 100 mV rms) These
two modules are very similar except for the input connectors. The 933A-02
(order no. AS0097800) has two sets of shrouded banana connectors for each
phase, including neutral, that include a voltage input and current input.
The 933A-03 (order no. AS0097900) has a unique single jack that allows
for voltage and current input signals. Arbiter Systems produces dedicated
cable assemblies for the Model 933A-03 to work with this current module.

Figure 1.6: 933A-02 and 933A-03 Low Current Modules



1.4.13 GPS Antenna Module (DISCONTINUED)

To synchronize the 933A with the GPS, order the GPS Antenna Module
(Part No. AS0077600). It includes a 50-feet cable assembly that attaches
between the front panel of the 933A and the GPS module. The antenna
module provides the best accuracy for 933A timing measurements.

Operating at the standard GPS frequency (L1 band) of 1575.42 MHz,
the antenna module receives power from the 933A through the cable
assembly. The same cable assembly communicates time and position data
via RS-485 to the 933A.

If connected before power up, the Model 933A automatically recognizes
the GPS module and sets the internal clock on the Model 933A to the
correct time. If the GPS module is connected after power up, use the
manual programming function to synchronize the 933A (see page 38). The
photo below shows the standard cable assembly and the magnet-mounting
bracket.

Figure 1.7: GPS Antenna Module and Cable Assembly
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1.4.14 Auxiliary I/O Module

The AS0077700, Auxiliary I/O Module, connects to the Model 933A
Auxiliary I/0 input connector and has two main features:

e Four Event Input connections
e Three sets of relay contacts: two Form-C, mechanical contacts and
one solid-state contact (KYZ rated)
Event Input Configuration
See page 115 for information on setting up the Event Inputs in the External
I/0 Module.
Relay Contact Configuration

See page 117 for information on setting up the three relay contacts in the
External I/O Module.

Figure 1.8: External I/O Module and Cable Assembly

11



1.5 Safety Information

Read the safety information before using the Arbiter Model 933A. Specific
warning and caution statements, where they apply, will be found through-
out the manual.

In general, be very careful when working around high voltages and
sources of current. It is possible to receive an electrical shock that could
severely injure you or cause death.

1.5.1 Definitions

e A “Warning” identifies conditions and actions that may pose haz-
ard(s) to the user.

e A “Caution” identifies conditions and actions that may adversely
affect the performance of, or damage, the Arbiter Model 933A.

e Read the Safety Information in the manual.

1.5.2 Terminology

The terms “Isolated” or “Electrically Floating” are used in this manual
to indicate a measurement in which the Model 933A is not connected to
earth ground through the ground terminal on the front panel.

The term “Grounded” in this manual refers to a measurement in which
the Model 933A is connected to an earth ground.
Ground Lug
The purpose of the ground lug is to connect the chassis to a safety ground,
especially during battery operation.
Current Probe

Arbiter Systems may supply various current probes based on availability,
and considers them as accessories to the Model 933A. Make sure to stay
within the limitations of the 933A if supplying your own current probe.

1.5.3 Warnings

e The maximum allowable input to either set of Voltage terminals is
650 Vrms. Over range is 1200 Vpeak, nominal.

12



The maximum allowable input to the current terminals is 40 A peak
and 20 Arms continuous.

Remove all test leads that are not in use.

The front-panel ground terminal should always be connected to the
safety ground for the circuit under test. This is especially critical
for operation with the line cord unplugged, since the AC line input
safety ground will not be connected.

Do not use the Safety Ground connector on the front panel as a
voltage or current input connection point.

Use extreme caution when clamping the current probe(s) around
non-insulated conductors or buss bars.

Never use the current probe on circuits rated higher than 600 Vrms
in overvoltage category III (CAT III) or EN/IEC61010-1.

Keep your fingers behind the finger guard.

Do not use a probe that is cracked, damaged, or has a defective cable.
Such probes should be made inoperative by taping the clamp shut
to prevent operation.

13



Chapter 2

Basic Operation

2.1 Introduction

“Basic Operation” describes all of the 933A keys, connectors and menus,
and how to operate the Model 933 A primarily from the front panel buttons.
You may also remotely control the 933A from a computer running PSCSV
application software. Additional information on PSCSV software is located
throughout the manual where needed and in Chapter 6, entitled, “PSCSV
Basics.”

2.2 Powering the Model 933A

2.2.1 Operation with the AC Power Cord

The Model 933A can be operated from an AC outlet or from an internal
rechargeable battery pack. To operate with the AC power cord.

1. Plug the power cord into the AC outlet (see External Power, under
Specifications).

2. Connect the power cord to the 933A.

3. Press the ON/OFF key to turn on the 933A and the splash screen
will appear on the display.

4. Following the splash screen, the 933A will settle on the DISPLAY
SELECTION screen for viewing measurements.

14



2.2.2 Operation with Battery Power

The Model 933A comes equipped with an internal, NIMH battery pack;
charge by connecting the 933A with the included power cord to an AC
outlet, or external DC Power. Under battery power, the Model 933A
should run for at least 8 hours on a full charge. Operating the 933A using
the LCD backlight will reduce the operating time.

2.2.3 Charging the Internal Battery
To charge completely,

e Connect the power cord between the outlet and the 933A.
e Power OFF the 933A and charge for at least 5 hours.

A Dbattery charge level indicator is visible as part of the Status
Indicators in most of the data viewing screens. The level of charge is
indicated by the dark color in the battery symbol. The battery symbol in
the screen shot below indicates that the charge level of the internal battery
is full.

2018 %
= 156
Battery Symbol /I T

Warning

When operating the 933A under battery power, make sure to connect the
ground lug on the front panel to a handy ground point (see Chassis Ground
later in this section). Otherwise, the 933A will be floating.

For more information on battery status, please see Section 2.4.12.

15



Battery information is also available when selecting configuration and
status information. Select DISPLAY > 9-Config & Status > BATTERY
& FLASH (soft key) to view the screen shot in Figure 2.1.

BATTERY STATUS

Values listed under BATTERY STATUS are for factory use when trouble
shooting a problem with the unit. You may be asked to report these values
if you suspect a battery problem.

BATTERY & FLASH STATUS

ERTTERY STATUS

Tita15GEasEause = 1HEEE

F3IEasEauge = 9337

Batterdloltase = 16,39

BattervCurrent = -1,0608

Internal  Temr = 26.4C
MAIM FLASH STATUS = 0K

EBad Blocks = o@Dy

Elock=Ruail = 1613453
LOG FLASH STATUS =

Elo ks Used = 1

# Records = 3
EUENT FLASH STHTUS = 0K

locks Used = 1

# Records = 2z
DSF FLRASH STATUS =

= FlashStatus = IDLE

EBad Blocks = 5]

Blocksﬂua11 = =]

Elocks Used = 1619

Figure 2.1: Battery and Flash Status Screen

2.3 Controls and Connections

Figure 2.2 depicts the Model 933A’s front panel identifying the main
functional groups of keys, connectors and display.

16
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2.3.1 Inputs and Interface

Front Panel Keys
The 933A has thirty front-panel keys with the following general uses:

e Soft Function Keys (5)
Dedicated Function Keys (8)

e Cursor control with Enter key (5)

Numeric keypad (12)

2.3.2 Front Panel Connectors

Connectors on the 933A have the following purposes:
e Current (C) and voltage (V) input; (C) 4 (933A-03), 6 (933A-01),
16 (933A-02), (V) 4
e Ground/safety lug, banana
e Multiconductor GPS Timing Input (DISCONTINUED)
e IRIG-B Timing Input connector, BNC
e USB 1.1 serial I/O communications
e RS-232C serial I/O communications, RJ11
e Multiconductor Auxiliary I/O; capped when not in use

e [EC-320 inlet power receptacle, with fuse compartment

2.3.3 Chassis Ground

A ground lug is located in the upper right portion of the front panel. This
terminal is connected to the instrument chassis, and also to the safety
ground lead of the AC power connector. When the Model 933A is operated
with the power line cord connected, the chassis of the instrument will be
connected to the safety ground for the AC outlet. However, when operated
from the internal battery with the power cord disconnected, the chassis will
be floating.

The purpose of the ground lug is to allow the chassis to be tied to a
safety ground, especially during battery operation.

CAUTION: Do not use a 3-to-2 prong plug adapter on the ac
power cord. This will isolate the safety ground on the instrument from
a ground point and cause a dangerous condition.

18



2.3.4 Voltage Inputs, 650 Vrms

Four input connectors are available for measuring AC voltages. All four of
the inputs use identical circuitry, which allow for measurement of voltages
up to 650 Vrms between inputs. See Figure 2.3 below.

Safety-insulated banana jacks are used to connect voltage signals to
the 933A, are labeled “A”, “B”, “C”, “N” (for phase A, phase B, phase
C and Neutral, respectively), and have one megohm voltage dividers tied
to a common point. Any unused voltage input will float at the average
value of the used inputs. You can measure voltage between any two of the
inputs (e.g., A and N, or A and B), including any input and a synthesized
neutral. Synthesized neutral is the average of the voltages at inputs A, B,
and C. The 933 does not directly measure Vac or Vbec.

2.3.5 Current Input Module, 20 Arms (933A-01)

The Model 933A-01 Current Module has three inputs, A, B and C, for use
in AC current measurement. Fach of the inputs uses a pair of five-way
binding posts, and has a maximum continuous current capability of 20
amps rms. Peak current is 40 Arms, maximum. See Figure 2.3 below.
For information on alternate plug-in modules (933A-02 and 933A-03) that
offer lower current ranges and different connector styles, see Section 1.4.12.
Optional modules provide connectors for measuring neutral current.

Voltage Inputs: A, B, C and Neutral

650Vrms Max.

A-Phase —p
Current Terminals

VOLTAGE INPUTS

B-Phase — »p
Current Terminals

/\ 20 Arms MAX.

w
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Current Terminals

Figure 2.3: Voltage and Current Inputs
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2.3.6 Synchronizing the 933A

Synchronize the 933A with either an Arbiter GPS Module (AS0077600
DISCONTINUED) or unmodulated IRIG-B time signal. Either of these
two external timing signals will keep all the 933A measurements synchro-
nized.

When not connected to an external timing signal, the internal clock
runs off of the crystal oscillator and typically has a drift of less than one
second per day. When connected to the GPS, the time base error is less
than 1 microsecond when locked to at least one satellite. When locked to
an IRIG-B signal, the time base error will be less than one microsecond
plus the accuracy of the IRIG-B source.

Using the accessory GPS module (see Section 1.4.13), or an available
unmodulated IRIG-B signal, you can easily connect these signals to the
Model 933A for additional accuracy and synchronized measurements. The
following paragraphs will assist you with setting up and using these
features.

2.3.7 GPS Timing Signals (DISCONTINUED)

To use the Global Positioning System (GPS) as the phase reference for
synchronizing the 933A you must have the Arbiter GPS module connected
to the GPS connector located on the 933A front panel. Also, the GPS
module must be locked to the GPS. Since the GPS receiver and antenna
are housed in the same (external) module, it receives power from the 933A
and sends down-converted timing signals through the cable via RS-485.

GPS Setup

1. Mount the GPS module in a stable manner in which the antenna
module has a clear view of the sky in all directions. If this is not
possible, a partial view of the sky may also work.

2. Turn the 933A OFF and connect the cable from the GPS module to
the GPS Receiver connector on the 933A

3. Press the power switch to turn on the 933A.

4. Once connected and operating, the 933A should detect the presence
of the GPS signal as the time reference. If you connect the GPS
signal with the 933A powered on, you will need to select SETUP >
1-Clock Time Set > ACTIVATE GPS RCVR.

20



2.3.8 IRIG-B Timing Signals

To accurately synchronize the 933A to an IRIG-B signal as a reference,
you must have a good IRIG-B signal connected to the IRIG-B IEEE 1344
BNC connector on the 933A. This is an unmodulated IRIG-B (DC Level
Shift) signal. See also Clock Setup in Synchronized Mode in Section 3.3.3.

IRIG-B Setup

1. Connect the IRIG-B signal cable to the IRIG-B connector (BNC) on
the front panel of the 933A.

2. Once connected and operating, the 933A will automatically detect
the presence of the IRIG-B signal and adjust the internal real-time
clock.

2.3.9 Communication Ports

The Model 933A has two communications ports located on the front panel;
USB 1.1 and RS-232C. Both communication ports serve to provide a
configuration and data acquisition link to the 933A.

Use PSCSV to maximize the operation of the 933A. While most
features are available from the front-panel keys, use PSCSV to configure
features and also to download data.

The Model 933A can also send a single bitmapped file to a terminal
or computer running a terminal program by pressing the Print key. For
more information on downloading bitmapped data, see Bitmapped File
Downloading at the end of this chapter.

USB 1.1

To connect to the 933A USB port, the pc requires a virtual COM port
be set up on it. Virtual COM port (VCP) drivers cause the USB device
(i.e. 933A) to appear as an additional COM port available to the PC. In
this way, PSCSV application software can access the 933A USB port in
the same way as it would access a standard COM port. Therefore, to use
the USB port on the 933A, you must install the 933_FTDI_USB _Driver, an
available download from the Arbiter website.. To connect using the USB
port, see Section 6.2.4 in “PSCSV Basics”.
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RS-232C

For RS-232C communications use PSCSV, or for bitmapped downloads use
a terminal program like HyperTerminal. Access the RS-232 port through
a small RJ11 connector on the front panel using the included 6-foot phone
cord and RJ11 to DB-9F null-modem adapter. To connect the 933A to a
computer using PSCSV, see Chapter 6, “PSCSV Basics.” To connect using
a Terminal program, see “Bitmapped File Downloading” in Section 2.6.

2.3.10 Auxiliary I/O Port

The Auxiliary I/O port provides a connection between the Auxiliary I/0
Module (part no. AS0077700) and the 933A using the accessory cable
assembly. The Auxiliary I/O Module includes four event input connections
and three contact outputs: 2 Form-C mechanical contacts and one solid-
state contact. Connect wiring to the module using the screw-terminal strip
connectors.

2.3.11 IEC-320 Power Inlet Connector

To provide a connection to a wide range of AC and DC power inlet sources,
the 933A has one IEC-320 Power Inlet Connector. AC sources include
voltages between 85 to 264 Vac at 47 to 63 Hz, and DC sources from 110
to 275 Vdc. A small door at the bottom of the connector contains a fuse
and space for a spare fuse.

Replacing a Fuse

1. Make sure that the 933A is powered OFF and disconnect the power
cord if attached.

2. Using a small flat-blade screwdriver, pry open the small fuse door
below the power connector. Pull it out toward you.

3. The innermost fuse is the one being used, and the fuse closest to the
door is a spare.

4. Check the suspected fuse for being open, and replace only with a
fuse of the same type.

Replacement Fuse, Part No. FU0001816; 1A, 250V, fast acting,
5 x 20-mm (diameter x length)
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2.4 Function Keys & Indicators

In the following pages you will find descriptions for the main functions
of the Model 933A. Access these functions through either PSCSV, or by
using the 30 front-panel keys. Each key is inscribed with a specific function
name or symbol depicting the function.

e Eight specific function keys include: Power ON/OFF, Display Back-
lighting, Display Functions, Review, Log (Data), Setup (instrument),
Print (a record) and Hold (a reading)

e Twelve numeric data entry keys: data entry or function selection
e Five cursor control keys: right, left, up, down and Enter

e Five soft function keys; change with function

2.4.1 On/Off Key

Quickly, press and release the On/Off key to switch the power to the 933A
on. Press for approximately 1/2 second and release to power off. This
helps prevent you from inadvertantly powering off the Model 933A.

2.4.2 Display Selection Key

Press the DISPLAY key to select the type of data you want to view on
the 933A display. This includes the active signal(s) connected to the 933A
and all of the DSP-related parameters. It also includes any stored records
and related data residing in flash memory. Select to view data using the
associated number key, or with the up or down cursor key, then pressing the
enter key. Selecting “9-Config & Status” submenu also provides firmware
version and battery and current flash information.

DISPLAY SELECTION
B— Tabular Results
1- Harmonic Results
2- Waveform Disprlay
3- U &I Tabulation
g— Eouer Eabtflition
: L) - Power Quality
Figure 2.4: Display 6— Energy Tabulation
Key Menus 7— Phasor Disrlay
8- Basic Data List
9- Config & Status

T4 ARROW kews move selection cursor
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2.4.3 Setup — Configuring the 933A

Press the Setup key to configure all of the features controlling the operation
of the 933A. For example, before actually connecting the 933A to a circuit,
it should be configured to match the measured electrical system. Whether
it is single phase or three phase, with one, two, or three elements, the 933A
is adaptable to most of the commonly-wired systems. Configure triggers
from the setup menu so that the 933A is ready to record events when they
occur. Also, you can set up the Autolog feature to automatically record
the connected signals on a specific day and over a set time interval. For
accurate low currents measurements, configure the 933A with one of the
low-current modules (see Sections 1.4.12 and 3.8).

SETUP SELECTION

B— InPut Setur Menu
1- Clock Time Set
2- Serial Setur

3- AutolLos Setur
4— CT-PT Setur

Figure 2.5: Setup 2: Eﬂf:gﬂthlthtup

Key Menus 7- Trigger Setur

Uze ENTER or # keus to select
ARROW kews mouve cursor to selection

Chapter 3 covers all of the setup and configuration features that control
how the 933A operates. This includes the type of measured electrical
system, setting up the internal clock, setting up the serial (RS-232)
port, configuring the automatic data logging features, setting up current
transformers and potential transformers, setting up current modules and
triggering.

2.4.4 Five Soft Keys

Press any of these keys when the correct label appears in the lower line
of the display that indicates your choice. These keys may change function
whenever a specific function key, or other soft key, is pressed.

OOHHLGO

Figure 2.6: Five Soft Keys
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2.4.5 Display Lighting Key

Press the Display key to view the display lighting menu and adjust it.
Three display menu choices are available: BACKLIGHT ON, BACK-
LIGHT OFF and BACKLIGHT AUTO-OFF. BACKLIGHT AUTO-OFF
provides display backlighting for a period of 10 minutes and shuts off the
backlighting after 10 minutes have expired to save the internal battery and
extend the lifetime of the backlight. The cursor keys provide control over
the backlight intensity and contrast. See Figure 2.7.

LCD BACKLIGHT & CONTRAST

USE_ARROW_KEYS TO ADJUST
BACKLIGHT AMD COMTRAST

BACKLIGHT
T

Figure 2.7: Brightness
Contrast Adjustment .
S —
COMTRAST
USE OFF.0OM.AUTO-0FF TO SAUVE SETTIMGS & EXIT
EXIT GHT | CSRVE
Fi il UTO-0 SETTINGS

Auto-Off and Backlight Life Expectancy

Note: Backlight life expectancy is about 1000 hours. Therefore, it is good
to use the Auto-Off feature to prolong the use of the backlight. If you do
intend to use the Display ON feature, it would be wise to turn it off at the
end of a sustained period of use.

2.4.6 Cursor Keypad / Enter Key

Press any of the Cursor Keys, including the Enter Key (the central key
with dot), to move through menu choices and to make selections. See
Figure 2.8 below.

OEe®

OO G @
Figuze 2. Nuner cno O
®© O @ €)
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2.4.7 Numeric Keypad

Use any of the numeric keys to select various menu items or to enter data
into the Model 933A. When entering numeric data, use the right or left
arrow key to move the cursor to the right or left digits — see Figure 2.8.

2.4.8 Log Key

Press the Log key to immediately record a complete set of data to flash
memory. When retrieving data, the record type will be listed as “K” (see
below under Review Key).

2.4.9 Review Key

Press the Review key to view the contents of records stored in the flash
memory module. Records are displayed in chronological order according
to date and time and contain various identifiers, including what initiated
the recording. For more information on reviewing recorded data, go to
Chapter 5.

e Autolog recording - record type “A”

Pressing the LOG button - record type “K”

User Triggers - record type “T” (Trigger with up/down arrow
indicating that the trigger is active/inactive)

Power Quality Triggers - includes high-speed waveform records (T)

Triggered from optional External I/O Module (T)

Review Key Selections

Press the number of the record displayed (0 — 9) to select and view specific
data. Use Arrow keys to scroll though logged data.

2.4.10 Print Key

Press the Print key to send the information, exactly as it appears on the
933A display, to the RS-232 port. The 933A sends out this information
in a bitmapped file format. Therefore, to receive this file, you would need
to have a terminal program running and set to the same RS-232C port
settings as in the 933A. See “Serial Setup (RS-232 Port Settings)” later in
this chapter. The file size is normally about 10 kilobytes.

Format: X Modem - CRC
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Use the DISPLAY key to cancel the transfer.

To capture a bitmapped file, use a terminal program, like Hyper Ter-
minal or Tera Term Pro; See Section 2.6 “Bitmapped File Downloading”
later in this chapter.

2.4.11 Hold Key

Press the Hold key to alternate between the Measurement Mode and Hold
Mode. The Hold Mode freezes the display and displays the current data
at the time that you press the Hold key. During the Measurement Mode,
the indicator in the meter symbol is moving. The 933A is normally placed
in Hold Mode when reviewing data recorded in flash memory.

2.4.12 933A Status Indicators

A set of status indicators, located in the lower left corner of the 933A
display, describe the instrument operating modes, including time and date.
These symbols appear when viewing any data, except waveform, in the
Measurement or Hold Mode. Figure 2.9 below provides definitions for
each of these indicators.

Battery Level Date
T |
= : H
Data Modes i D e Day of Week & Time

KEY Key LoggiN

. L Viewing Modes
AL Autologging

() Measurement Mode

T2l Trigger Log (1) Hold Mode

50 Review Data

0, Send Data Internal Clock

Timing Modes m Locked to GPS

(5 Internal Clock (free running) = Locked to IRIG-B

[l IRIG-B synchronizing ‘m  Unlocked (as shown)

[a] GPS synchronizing

Figure 2.9: Status Indicator Definitions

Battery Level

On a full charge, the battery symbol should be completely dark and the
battery giving the 933A about 8 hours of operation. When the battery is
drained, the symbol appears as an outline of the battery symbol and may
have the letter L to indicate that the charge is Low, or the letter C to
indicate that it is charging.
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Data Modes

There are five data modes for storing and handling data, including (1) Key
Logging — logging one record to flash by pressing the LOG key, (2) Auto
Logging — logging multiple records to flash using the Autolog feature, (3)
Trigger Log — notification of triggered data being held in flash, (4) Review
Data — notice that you are reviewing data stored in flash, and (5) Send
Data — stored data being sent to one of the communication ports.

Timing Modes

There are three timing modes: (1) Unlocked — the free-running internal
clock, (2) Locked to IRIG-B — internal clock synchronized to an incoming
unmodulated IRIG-B signal, and (3) Locked to GPS — internal clock
synchronized to an incoming GPS signal. When synchronized, we refer
to the internal clock as being “Locked.”

Viewing Modes

There are two viewing modes: (1) Measurement Mode, and (2) Hold Mode.
Press the HOLD key to alternate between the Measurement Mode and
Hold Mode. The Hold Mode freezes the display and displays the current
data at the time that you press the HOLD key. During the Measurement
Mode, the indicator in the meter symbol is moving.

Date and Time

The 933A status indicators also provide you with the current Date, Day
of Week, and Time. In free running mode, you must manually set the
date and time for them to be correct. With a connected IRIG-B or GPS
synchronizing signal, the date and time are set automatically, and kept
accurate. Note: Use the correct IRIG-B type. Set the clock source to
unmodulated TRIG-B, with IEEE 1344 Mode ON. Status Indicators will
state NO DATE DATA and NO TIME DATA if set to any other type of
IRIG-B.

Internal Clock

The internal clock has three modes: (1) free running based on the
internal oscillator, (2) synchronized by an external IRIG-B signal, and (3)
synchronized by an external GPS signal. Timing Mode indicators show
the current mode as seen in the main figure on the previous page.
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In the free-running mode, the clock drift is based on both the physical
characteristics of the clock and operating environment; namely, the
ambient temperature. Unlocked, the clock accuracy is less than 10 PPM
and less than 1 second per day, typical. Make sure to check and, if
necessary, set the clock time before important measurements. If not, time-
based measurements, such as set up under the Autolog mode, may not
occur as anticipated.

Synchronized to an IRIG-B signal, the accuracy will be 1 microsecond
plus the accuracy of the IRIG-B signal. The 933A indicates IRIG-B
synchronization with a symbol of a digital signal. The internal clock will
be set only if the IRIG-B is unmodulated and according to the IEEE 1344
standard.

Synchronized to the GPS, the accuracy is 1 microsecond. The internal
clock (time and date) will be set automatically.

2.5 PSCSV Software

PSCSV software is an included accessory with the 933A. It was developed
by Arbiter Systems to assist you in configuring the 933A, for managing
and downloading logged data. While most features are accessible from the
front panel, some are only available with PSCSV. See “PSCSV Basics” in
Chapter 6, and “Triggers and Event Recording” in Chapter 7.

2.5.1 TUSB or RS-232C

Connect to the 933A USB or RS-232C ports using PSCSV. Make sure that
PSCSV is installed on your PC and connect a suitable cable between them.
Included as an accessory is a DB-9F to RJ11 adapter and phone cord for
connecting between the 933A and RS-232C port on a computer. If your
computer does not have an RS-232 port, use a USB-to-RS-232 adapter.

2.5.2 Connecting

Before using PSCSV, make sure to read over the section on connecting
in Chapter 6, PSCSV Basics. It is necessary to manually connect to the
933A from the computer running PSCSV.
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2.5.3 Configuring
Configure all SETUP functions through PSCSV or through the front panel

keys.

2.5.4 Downloading Data

When downloading data, all of the data is in binary format and can be
located in the directory of your choice on the computer running PSCSV.

2.6 Bitmapped File Downloading

Purpose

The PRINT key has one basic function: to send a bitmapped file of
the current display to the RS-232C port.

Procedure

1.

Verify the RS-232 settings by selecting DISPLAY > 9- Config &
Status. If you need to change the SERIAL settings, then you would
press the SETUP key and 2- Serial Setup. Adjust the settings and
go to step 2.

Open a terminal program of choice and make sure that the port
settings agree with those from step 1 above. Change them if
necessary.

Set the 933A to read the desired information on the display.

Set the terminal program to Transfer the file via Xmodem Receive.
This is done with slight differences between programs.

When requested, give the file a name with a “bmp” extension, click
OK and (when ready) press the PRINT key on the 933A.

Within a few seconds the file should transfer. You should see a
number of bytes received. Generally about 9 kB. This time interval
can vary between terminal programs and baud rates.
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2.6.1 Tera Term Pro BMP File Transfer

To transfer a bitmap of the display using Tera Term Pro, use the same
steps as in Section 2.6. You should normally select File > Transfer

XMODEM > Receive.

File

Mewt connection. ..

Log...
Send file. ..

Transfer

hange directory. .,
Print...

Disconnect
Exit

Edit Setup Control  Window  Help

Alt+r

Kermit |
AMODEM
ZMODEM

B-Flus

Send. 5
Quick-Yak

——

Alt+P

b
»
b
»
b

Al+C

1. A file Save window should appear next. Type in the name with a

bmp extension.

2. Make sure that CRC and Binary are selected and click Open.

3. The SaveAs window should disappear and a new download window

should appear.

Tera Term: XMODEM Receive

Protocol:
Packeth:

Filename:

Bytes transfered:

X
eceive YWindow.png
XMODEM [CRC]

15
1920

Cancel

4. Press the PRINT key and you should see values that indicate that
bytes are being transferred (up to about 9 kB) and disappear.
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2.6.2 HyperTerminal BMP File Transfer

To transfer a bitmap of the display using Hyper Terminal, use the same
steps as in Section 2.6. You should normally select Transfer > Receive

File.

“¢ 933A - HyperTerminal
File Edit wiew Call RIEREES Help

O = g g SendFie...

Capt & Texk...

Send Text File. ..

Capture ko Printer

1. When the Receive File window appears, select the location for the
new file capture and choose Xmodem. Now click the Receive button
and type in a file name with a bmp extension.

2. Press the PRINT button on the 933A and wait for the transfer
process to finish.

Amodem file receive for 933A

Packet:

Retries:

Last emror:

Elapsed:

Storing as:

| C:ADocuments and Settings'Jim\Desktop'HyperT erminal_Receive_Win |

Errar checking: |CF|C |
ICI Total retries: File:

|N0 packet | Throughput:
[ Cancel l ’ cps/bps

3. Normally, it takes at least 20 to 30 seconds for the file to begin
transferring (when you will actually see some bytes changing that
indicate a transfer is taking place).



Chapter 3

The Setup Menu

3.1 Setup Key

The Model 933A has two main function keys named DISPLAY and
SETUP. Most of the interaction between the user and 933A will begin
with these two keys. From the SETUP key you will be able to configure
all of the 933A functions.

Press the Setup key to control the basic configuration of the 933A.
Using the numeric keys, press the number to the left to configure the
desired function. These are depicted in Figure 3.1.

SETUP SELECTION
B— Input Setur Menu
1- Clock Time Set
Z2—- Serial Setur
3- AutoLog Setur
4— CT-PT Setur
5- Custom DST Setur
6— Current Setur
?7— Trigger Setur

Usze ENTER or # kews to select
ARROW kews move cursor to selection

Figure 3.1: Setup Key Display
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3.2 Input Setup Menu

Use the Input Setup Menu to configure the 933A to correctly match the
electrical system you are measuring. The 933A provides six standard
choices incluing a method for customizing the input. A secondary menu
allows you to select the frequency mode, bandwidth, frequency reference
and phase reference.

Input Configuration
Configuration Inputs

0 E*3Ph4W3E Vanla, Ybnlb, ¥enlc

1 0 3Ph4W2.5E  Vabla, Ven, Ic, Ib

2 0 3Ph3W2E Vabla, Venle
Figure 3.2: Input 3 O 1Ph3W2E Vanla, Venle
4 0 1Ph2W1.5E  Vabla,Venle
50 1Ph2WHE Vanla

6 O Custom Input Configuration
use (=4 or # keys to select configuration

| | | | HEXT |

Setup Menu

NOTE: The 933A will compute power and energy qualities when
selecting one of these six standard configurations.

3.2.1 Selecting the System Input
1. Press the SETUP key > 0-Input Setup Menu.
2. There are two methods to select the input type:
(a) Use the UP/DOWN arrow keys to select the Input Configura-
tion Type and press the Enter key to make the selection.
(b) Using the number keypad, press the number corresponding to
the desired Input Configuration (e.g. 0 - 3Ph4W3E).

3. Press the SAVE SETTING soft key to save the changes and return
to the DISPLAY SELECTION menu.

4. Otherwise, press the NEXT soft key to proceed to the Custom Input
Selection menu. The Custom Input Configuration menu allows you
to choose the voltage and current inputs, frequency mode, frequency
reference and phase reference.

Configuration Settings Indicator
weawzel  Note: Input settings appear in the lower right corner of most data
screens, and appear in a small outline of the 933A. The input settings are

written inside the outline.
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Custom Input Configuration Selection

Choose the Custom Input Configuration menu if you want to individually
select the inputs and reference signals. This includes input signals, nominal
frequency (50 Hz, 60 Hz), choice of signal for frequency reference and phase
reference. Choose “Absolute” for Phase Reference if you have a GPS or
IRIG-B input.

Custom Input Configuration

Inputs FreqMode FreqRef Phase Ref
E Van 50Hz [@Va E Van
Bvbn B60Hz OVb O Vbn

E Ven Bandwidth OO Ve E 322
Figure 3.3: Custom O Vab ElLegacy OSeq! g |
Input Configuration Bla OWide Ol g

B b O b O Ic

E e 4.!.. O le O Absolute
Use J}  keys tomake selections

To select Input Configuration:
NOTE: Normally, this menu is entered from the Input Configuration menu
found on the previous page.

1. Press Setup > Input Setup Menu > NEXT (soft key).

2. Use the Arrow and Enter keys to locate and select the Input
signal(s), Frequency Mode, Bandwidth, Frequency Reference, and
Phase Reference.

3. When finished, press the SAVE SETTING soft key, returning you to
the DISPLAY SELECTION menu.

4. Press the BACK soft key if you want to return to the initial Input
Configuration Menu.

Synchrophasors

For synchrophasor measurement, you must select Absolute, under Phase
Ref. For viewing phasors on the 933A itself, see Section 4.10. For
additional information on using the 933A as a PMU and viewing phasors
using PSCSV, see Figure 6.5.

Bandwidth

Measurement bandwidth allows you to set up how the 933A calcu-
lates Volt-Amps (VA = Viyug X Imag), Volt-Amps Reactance (VAR =
VVAZ —W?), and Power Factor (PF = W + VA). Wide band mode
includes the contributions of harmonics in the calculation of VA, PF and
VAR.
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3.3 Clock Time Set
3.3.1 Internal Real-Time Clock

Before making measurements, take time to set up the real-time Clock. Ca-
pable of operating in three different modes, each clock mode offers different
performance advantages. Whatever mode you ultimately decide to use, it
is important to understand the performance differences, and to configure
the clock so that the clock performance matches your expectations.

TIME SETUP
Instrument Time:UTC

Setur Values

28 Noy _2@11
Mon 16:34:88

Figure 3.4: Clock Setup ENTER ZONE: B8hBBm

USE ARROW KEYS TO CHAMGE TIME Z0HE

Clock Set:Above

USE <HEXT ENTRV: KEY WHEH ENTRY COMPLETE
<GAVE CHAMGES: KEY SETS CLOCK TO SETUP TIME

SALE.
CHANGES EXRIT

Clock Operating Modes

There are three clock-operating modes from which to choose: (1) free
running, (2) synchronized to the GPS, and (3) synchronized to IRIG-B.
For a complete list of specifications, please see Chapter 8.

Free Running

Clock time is based on the internal oscillator, with no external timing input
for stabilization. Clock time depends on initial setup, with a characteristic
drift of less than 1 second per day.

Synchronized to an External IRIG-B signal

Uses an IRIG-B signal from an external clock to synchronize the internal
clock of the 933A. Accuracy: Better than 1 microsecond plus the accuracy
of the IRIG-B source.

Synchronized to an External GPS Signal (DISCONTINUED)
Use the accessory GPS module (see Section 1.4.13) to synchronize the
internal clock of the 933A to the GPS time standard. Accuracy: Better
than 1 microsecond.
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3.3.2 Clock Setup in Free-Running Mode

In free running mode the internal oscillator in the 933A is not disciplined
by an external clock signal, such as IRIG-B or GPS. When manually
setting the internal clock on the 933A always set it to your Local time.
Verify this in the second line of Figure 3.4, which states, Instrument
Time:LOCAL. If it says, Instrument Time:UTC, you will need to
press the far left soft key, SELECT LOCAL, to switch it to local time.

TIP: In free running mode, use an accurate external time source as a
reference and set the 933A time ahead enough so that you can “set it”
when the reference time arrives at the top of minute. The Model 933A
clock time is “set” when you press the SAVE CHANGES soft key.

Setting up the Internal Clock

1. Press SETUP, then select 1-Clock Time Set to access the internal
clock setup menus.

2. TIME ZONE. If necessary press the UP or DOWN key to adjust the
Local Offset to your time zone.

3. DST Preference. Press the NEXT ENTRY soft key and press the UP
or DOWN key to adjust the Daylight Saving Time to your preference:
OFF, ON, Auto USA, Auto EUR, Auto AUSS, Auto AUST, Auto
NZEL, Custom.

4. YEAR. Press the NEXT ENTRY soft key and enter the year
information from the numeric keypad — the Local Time symbol
should then appear to the right of the year indication.

5. MONTH. Press the NEXT ENTRY soft key and using the UP or
DOWN keys, enter the current month.

6. DAY. Press the NEXT ENTRY soft key and adjust the Day using
the numeric keypad.

7. HOUR. Press the NEXT ENTRY soft key and adjust the Hour using
the numeric keypad.

8. MINUTE. Press the NEXT ENTRY soft key and adjust the Minutes
using the numeric keypad.

9. Press the SAVE CHANGES soft key before leaving this menu.
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3.3.3 Clock Setup in Synchronized Mode

1. Set the internal clock in the free-running mode as described in
Section 3.3.2.

2. Connect the timing signal from an IRIG-B or GPS source.

3. Check your clock settings. Make any changes as required.

Select UTC or Local

1. Set the internal clock in the free-running mode as described in
Section 3.3.2.

2. If you wish to set the internal clock to Local Time, press the SELECT
LOCAL soft key to set the system clock to your local time zone (Adds
the offset in the ZONE menu including any DST offset).

3. If you wish to set the internal clock to UTC, press the SELECT UTC
soft key.

4. Make sure to press the SAVE SETTINGS soft key before leaving the
clock setup menu.

Notes on Using an External Timing Signal

When connecting an external IRIG-B timing signal, be sure that the source
clock is transmitting UTC and IEEE 1344 mode ON. This is because the
933A will add the Local Offset (including sign) to the time received from
the source clock, and needs the calendar year.

For example, if you are located in the Pacific Time Zone of North
America, the Local Offset would most likely be - 8 hours. If the external
clock is sending local time (i.e. Pacific Time), then the 933A internal clock
will indicate 8 hours earlier than expected.

When using a GPS module, remember that the GPS module always
sends the time as UTC time, so that the 933A Local Offset should be set
according to the normal method. For example, if you are located in the
Eastern Time Zone for the United States, the Local Offset would be -5
hours.

Manually Programming GPS Module (DISCONTINUED)

To synchronize the 933A to the external GPS module (i.e. AS0077600,
see page 10) after it is operating, select SETUP > 1-Clock Time Set >
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ACTIVATE GPS RCVR (soft key). After it is programmed, you will see
the GPS synchronizing symbol in the status indicators (see Figure 2.9).

3.4 Serial Setup

RS-232 port parameters include Baud Rate, Word Length, Stop Bits and
Parity.

RS-232 Setup
BaudRate Length StopBits Parity
0900 0O5Bits @ One @ Off
019200 O6Bits O Two O Odd
028800 O 7Bits O Even
Figure 3.5: RS-232 Setup Elggggg &1 8 Bits
O 115200

Use d—i-b keys to make seiecnions

SAVE
SETTIMGS

3.4.1 Setting up the RS-232 port

In each of the menus described below for specific port settings, use the
cursor keys and Enter key to select the desired values.

1. Press the SETUP key and then choose 2-Serial Setup. To exit, press
either the DISPLAY or the SETUP key.

2. Select the Baud Rate and press the Enter key.

3. Select the Length (word length) and press the Enter key.
4. Select the number of Stop Bits and press the Enter key.
5. Select the Parity and press the Enter key.

6. Press the SAVE SETTINGS soft key before leaving this menu, or
any new settings will be lost.
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3.5 Autolog Setup

If you need to automate the tasks of measuring and logging data to the
internal flash memory card, then you may want to configure the Autolog
feature. The purpose is to allow you to begin logging automatically at a
specified time and date, at a chosen rate, and then quit.

Autolog requires a future start time, a recording rate and recording
duration. You can program this feature through the soft keys located at
the bottom of the display.

AUTO-LOG OPERATION AUTO-LOG OPERATION
Auto-Loa Start Time Auto-Loa Start Time
NO DATE DATA 29 Nov _2811
Tue B89:38:01
Auto-Loz Stor Time Auto-Loz Stor Time
NO DATE DATA 29 Nov 20811
Tue B9:46:31
Ruto-Los Entries Auto-Los Entries
Auto-Los Rate Auto—Los Rate
Once every 08:00:01 Once every 06:0808:10

Restart MinMaxAvs with each log entra: Disabled Restart MinMaxAvs with each los entra: Disabled

AUTO LoS | AUTO_LOG | AUTO_LOG
STRART RATE 2URATIO

Figure 3.6: Autolog Setup

Example: Let’s suppose you need to record data for about fifteen minutes
at 10 second intervals, starting on November 29*" at 9:30:01 a.m. The
starting screen at the left indicates no date and time, and the AUTO
LOG ENABLE soft key is vacant. The completed configuration, shown
on the right in Figure 3.6, indicates a start time, stop time with a total of
100 records.

To Configure Autolog Operation:
1. Press SETUP > 3-AutoLog Setup.

2. Press the AUTO LOG START soft key and set the date and time
by selecting Minutes, Hours, Days/Year when the soft keys change.
When finished with Start, press the Exit Start key.

3. Press the AUTO LOG RATE soft key to select the measurement
interval; select in hours, minutes and seconds. When finished with
Rate, press the EXIT RATE soft key.

4. Press the AUTO LOG DURATION soft key to set the stop time for
the measurement. Duration really means (for the above example)
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“How many 10-second intervals do you want?” For 15 minutes, this
means 100 intervals (realize that the first record occurs at 9:30:00
a.m.). When finished, press the EXIT DURATION soft key.

Press the AUTO LOG ENABLE soft key to arm the Autolog feature
so that the 933A begins measuring when its clock reaches the Start
Time. NOTE: the AUTO LOG ENABLE will be vacant without a
future start time and date to the internal clock.

3.5.1 Logging Data Indication

When the Autolog start time is reached, the 933A will begin logging data
based on the connected input signals and Auto-log Rate. Auto-log Entries
(shown as “0” in Figure 3.6) begin incrementing with each new record
stored. “AL”, appearing within the Status Indicators, indicates logging
activity. Autolog indication is described in Figure 2.9.

Figure 3.7: Review
Log Data

REVIEW LOG DATA

Log Date/Time And Log Reason ¢ALL>

22 How 2011 Tue 18:21
'3 How 2811 Tue 15:21
'3 How 2811 Tue
'3 How 2811 Tue
'3 How 2811 Tue
'3 How 2811 Tue
'3 How 2811 Tue
'3 How 2811 Tue 1
'3 How 2811 Tue 15:
9 - 29 How 2811 Tue 15:19:58

Use &5 To Search And #'s To Select Review Item
og Item: 188

Dldest D Newest
— —

0000000
FIRILIEIRIEIEIR

a- 2@
1- g
z - L)
3 - )
4 - ;46
9 - ;36
& - i 26
v - )
g - 96

FIRIRIRIRIRIRIR
IDTDDDDDDD

1
{3}
{3}
{3}
{3}
{3}
{3}

L—Total Log Items: 166 —!
Search Rate: One Percent Steps
IMCRERSE REUIEW

RATE

SELECTIONS|

To Access Recorded Data

1.
2.

3.

4.

Press REVIEW key > SHOW LOG (soft key).

Press REVIEW SELECTIONS (soft key) > SHOW AUTO LOG
(soft key). This sorts Autolog data from other logged data.

Press the number keypad corresponding to the index number at the
left of the record. This will open the DISPLAY SELECTIONS menu,
as if you pressed DISPLAY key. Now, press the number of the data
type you wish to view.

Press any other number key to change data types (i.e. that
corresponds with the Display key).

When viewing recorded data, the instrument is effectively in HOLD
mode and is symbolized by a small magnifier icon among the Status
Indicators. This is shown at the right of the battery symbol in Figure 2.9.
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3.6 CT/PT Setup

To automatically compensate for CT’s and PT’s (current and potential
transformers), the 933A provides the CT/PT Setup menu to install these
constants. By doing this, the 933A can directly display the primary current
or voltage by converting the actual secondary current or voltage to the
primary value. It does this by multiplying the secondary current or voltage
by the CT/PT ratio and adding the phase difference to zero reference
phase.

In the CT/PT Setup menu, you will find space to enter magnitudes
and phase angles for each configured phase as seen in Figure 3.8.

CT/PT RATIO & PHASE
APHASE B PHASE CPHASE N PHASE

[ 1. GEEE 1. 8088 1.8808 RATIO
cT EXT) .00 .08 .60 PHASE
PT[ 1.0660  1.0000  1.0009 --——--— RATIO
. a0 .60 LI pe— PHASE
. Use Arrow Kess to make selections
Flgure 3.8: CT/PT Use Humber or Enter Rews o snable adiust
Setup Menu
A-PHASE CT RATIO

Setting up CT & PT Values:
1. Press the Setup key and choose 4-CT/PT Setup.

2. Use any of the cursor keys to select the desired value (e.g. A-PHASE
CT RATIO). The rectangle will surround the chosen value and it will
be described in large letters in the lower portion of the display.

3. Use the number keys to enter the CT ratio or phase offset and press
ENTER to install.

4. If the value is nominal for all phases press the APPLY TO A, B &
C soft key.

5. Press the SAVE ALL soft key to save the new CT/PT values.

CT Table

The method above allows a single calibration point for each phase CT.
Using the PSCSV-933 application software, a 12-point CT table may be
entered into the 933A that compensates for a broad operating range. See
Section 6.2.6 for more information on entering a CT table.
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3.7 Custom DST Setup

Use the Custom DST (Daylight Saving Time) Setup if you want to
customize the daylight saving changeover feature to one that is not offered
under Clock Time Set. Features include setting the start and stop date
and time. To set the internal clock, see Section 3.3.2, Clock Setup in Free
Running Mode.

CUSTOM DST SETUP
DST Start Time
B4 Mar 2812
Sun B2:00:80
DET Stor Time
B4 Nov 2812
Sun B2:00:80

Figure 3.9: Custom
DST Setup Menu

ALJUST ADJUST
START STOF

ERIT
HO SAUE

To Set up Custom DST

1.
2.
3.

Press SETUP > 5-Custom DST Setup.
Press the ADJUST START soft key.

Press the YEAR soft key and UP/DOWN arrows to adjust the value
for the next occurring.

Press the MONTH soft key and UP/DOWN arrow keys to adjust
the starting month.

Press the DAY soft key and the UP/DOWN arrow key to adjust the
starting Day of Week.

Press the HOUR/MINUTE soft key and the UP/DOWN arrow key
to adjust the starting hour and minute.

Press the EXIT/ADJUST soft key to return to the previous menu.

Press the ADJUST STOP soft key to adjust the DST ending date
and time. Use the same method as with ADJUST START.

Make sure to press the SAVE SETTINGS soft key before leaving the
Custom DST Setup menu. Otherwise, press either EXIT NO SAVE.
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3.8 Current Setup

Use Current Setup to adjust the current input sensitivity by a factor of
approximately 20. Adjustable settings are either 1 or 20 Amps for each
channel (A, B, C or N). By switching to 1 Amp, you are increasing the
sensitivity of any one, or all, of the current input channels. Switching
to 20 Amps, removes the current input preamplifier thereby reducing the
sensitivity!.

Current Module Settinas

Current Moduyle ID: 933-A1 S-M 1681
2ZBHrm=s DIRECT INPUT CURREMT MODULE
Madule Calibration Date! 18-0ct-ZHEY

Channel Ranse Settinas

Figure 3.10: Current
Setup Menu

Note: Over driving the 933A current input (to greater than 1 Amp) when
configured to the 1 Amp range will not damage the unit, however it will
saturate the input amplifier and may produce unwanted harmonics.

To Setup the Current Range Sensitivity
1. Press the Setup key and choose 6-Current Setup.

2. Press the CHANGE CHANNEL A, CHANNEL B, CHANNEL C
and CHANNEL N soft keys individually to toggle any or all of the
channels to the preferred range — high or low current.

3. Press END MODIFY soft key and SAVE SETTINGS to save the
changes made to Current Module Settings.

4. Press the EXIT soft key to leave this menu without changes.

Low Current Modules — 933A-02, 933A-03. The 933A-02 and 933A-
03 Low Current Modules also include two ranges, and accept input voltages
as well as input currents. This allows them to work with current-output or
voltage-output CTs. For further information on these optional modules,
see Section 3.9.

1The 1-Amp setting has 1% accuracy compared to 0.05% accuracy for the 20 Amp
setting.
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3.9 Using Optional Low Current Modules

Two low-current input modules for the Model 933A are available for both
current-output and voltage-output CT’s. Each has two operating ranges;
a high range (up to 1.2 Arms or 2.4 Vrms) and low range (up to 50 mA
rms and 100 mV rms) Both modules are identical except for the input
connectors. The 933A-02 has two sets of shrouded banana connectors for
each phase, including neutral, voltage and current inputs. The 933A-
03 has a unique single jack that allows for voltage and current input
signals. Arbiter Systems produces dedicated cable assemblies (purchased
separately) for the Model 933A-03.

Current Module Settings Current Module Settings
Cyrrent Modyle IDi 933-@2 Cyrrent Module ID: 933-@3
CT INPUT CURRENT MODULE CT INFUT CURRENT MODULE
Module Calibration Date: 11-Rpr-2606 Module Calibration Date: 25-Jul-2806
Channiel Ranse Settinss Channel Ranse Settinss
Channel A 8 mAmF, 168 mUolt Channel A! 1.2 AmF, 2.4 Uolt
Channel B: 58 mAmF, 108 mUolt Channel B: 1.2 AmF, 2.4 Uolt
Channel C: 58 mAmF. 188 mUol+t Channel C! 1.2 AmP. 2.4 Uolt
Channel H: 58 mAmF. 106 mUolt Channel N: 1.2 AmP, 2.4 Uolt
Channiel Input Settinss Channel Input Settinss
Channel A Current Chanrmel R: Current
Channel B Current Chanrnel Bf Current
Channel Cf Current Chanmel Cf Current
Channel N: Current Chanrmel N: Current

" MODTFY MODIFY SAVE
EXIT s HEL SETTIHGS

Figure 3.11: Low Current Module Setup Menus

3.9.1 Installing

To configure either the 933A-02 or the 933A-03, you will need to replace
the current module already installed in the 933A with the 933-02 or 933-03.
The expected current and voltage ranges will not appear without installing
the specific current module.

Make sure to power OFF the Model 933A before replacing a current
module. Keep your fingers away from the ON/OFF Power Switch!

1. Loosen the hold-down screws using a medium slot screwdriver.
2. Grasp the module and pull it out slowly.

3. Align the new module into the nylon guides and gently slide it into
the slot guides.

4. Tighten the two hold-down screws to secure the module.

5. Start the 933A and press the SETUP key and 6-Current Setup to
check the settings displayed for the module (as seen in Figure 3.11).
Select range as desired.
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3.9.2 Configuring

Before using the current module, make sure to press the SETUP key, then
6—Current Setup to configure the range. You should see the screen/menu
similar to that shown in Figure 3.11.

Notice from the table in screen shot that there are two ranges for
current and two ranges for voltage. The two ranges for current are 50 mA
and 1.2 Amp. The two ranges for voltage are 100 mV and 2.4 Volts.

Soft key Selections

1. Make sure to press the MODIFY RANGE soft key to select the
desired current or voltage input range for each channel.

2. Press the MODIFY INPUT soft key and select either current or
voltage corresponding to the input type.

3. Before leaving this menu, press the SAVE SETTINGS soft key. To
leave without saving press the EXIT soft key.

3.10 Trigger Setup

The last selection in the setup selection screen is called “Trigger Setup.”
Triggers allow the Model 933A to automatically record to internal flash
specific data when either the measured input signal, or calculated DSP
value, meets the defined conditions.

The example Trigger Setup shown below illustrates the configured fields
to trigger an event when the A-phase voltage exceeds 130 Vrms. For
complete details on setting up triggers, go to Chapter 7, Triggers and
Event Recording.

TRIGGER SETUP

TRIGGER #
SELECT MODE DSP
CURRENT MODE: DSP
Ineut Siga.:  Uoltaze
Channel A
Limit Ture: x>limit
. . Limit r 138,688
Figure 3.12: Trigger reterenee t 2,20

. MasterTris: —-
Rev1ew 1\161111 Dwell Time: S.88
Trigserlos:  OFff
Max Loz Time: 16256
Fost Fault: @
3 HRROW kews to cucle throush selections
T4 HREROW kess move selection cursor

RELRAY EVENT
SETTIMNGS | SETTIMGS
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Chapter 4

The Display Menu

4.1 Display Selection

Press the DISPLAY key to select and view the various electrical mea-
surements. This includes the active signal(s) connected to the 933A and
any data stored on flash. When using the REVIEW key to view recorded
data, the Display Selection menu is again used to help you select the type
of data. This is possible because the Model 933A stores a complete set of
data for each record. Press the number on the left corresponding to the
data type you wish to view.

To change between display selections, press the number on the numeric
keypad corresponding to the desired data type.

DISPLAY SELECTION

B— Tabular Resul+ts
1- Harmonic Results
2- Waveform Display
3- U & I Tabulation
4- Power Tabulation
5- Power Quality

6—- Energvy Tabulation
7— Phasor Display

8- Basic Data List
9- Config & Status

4 ARROW kews move selection cursor

Figure 4.1: Display Menu
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4.2 Min—Max Setup

Use the Min—-Max Setup, within any data display screen, to view the
normal, minimum, maximum and average data values. To restart Min—
Max accumulation, press the RESTART MIN/MAX in the Min—-Max

menu.

A+B+C & NEUTRAL RESULTS
168. 1133 Uolts 965.8614 U
———————— Udes -559.4966 UA
4.1398 AmPs  1.1162kUA
_ [ ——— Ades  ©0.8653 PF
Figure 4.2: Min-Max 9.0935 Aneu 60,8092 Hz
Setup -76.35 Ndeg

|L{I4dJ‘f2'4§'a?? Hilm|
2o 45 i
* Cae s an e

To select Min / Max / Average or Normal:

1. Press the DISPLAY key and choose 0-Tabular (or other Data Type
selection key) to access the selections from the Min—Max menu.

2. Press the Min—Max SELECTION soft key to activate the Min—Max
soft menu at the bottom of the display.

3. To view the minimum, maximum or average results, press any Min—
Max function soft key below the display.

4. Press the RESTART Min—Max soft key to reset the minimum,
maximum and average values to zero, and begin storing new values.

5. Press the EXIT Min—Max to return to the Phase A Results screen.

Note: Remember that the Min—Max function is always active from the
time that the 933A is powered ON. It may be important to press the
RESTART Min—-Mazx if you are starting a new measurement and do not
want any previous measurements (startup conditions, noise, etc.) included
with your new measurement.

48



4.3 Tabular Results

Tabular Results include the measured electrical and power-related values
for the selected phase, including minimum, maximum, average and normal.
The figure below shows all of the A-phase tabular results.

PHASE A RESULTS
119.8695 Uolts 321.5448 U
8.88 Udes -186.5174 UR
3.1848 Amps 372.8708 UR
36.89 Ades 8.8653 PF
-30.09 Des* €0.8003 Hz

Dey = Phase- I Phaze

Figure 4.3: Tabular Results

Tabular Results include

e all configured voltage & current phases

e phase angles (Vdeg, Ideg)

active/reactive/apparent power (Watts, VARs & VA)
e power factor (PF)

e frequency (Hz)

Use the soft keys to select individual phases and totals. Use the separate
soft key shown below the display to select Normal, Minimum, Maximum,
or Average, and to Restart values.

Status Indicators also show the internal clock time and date, the current
instrument configuration and also the charge level of the internal battery.
For definitions of status indicators in the lower part of the display, see
933A Status Indicators in Section 2.4.12.
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4.4 Harmonic Results

Harmonic Results includes all harmonics from the fundamental to the
50th harmonic for the specific phase voltage and current. Soft keys allow
selection of phase and neutral.

4.4.1 Graphical Harmonics

Select 1-HARMONICS from the Display Selection menu to view Graph-
ical Harmonics. Soft keys allow you to select each configured current and
voltage. Press the MAGNIFY & TAB KEYS soft key to switch soft key
menus for the magnify and tabular menu.

A PHASE HARMONICS

F=37.93a41)

Figure 4.4: Graphical
Harmonics Display

Fea, 98741
:
O 10} Masnification 3P 41 3E

MAGHIFY
UF

AEBLCH
COMTROL

TRAELULER
HARMONICS

DOWH

4.4.2 Tabular Harmonics

In the Graphical Harmonics display, press the MAGNIFY & TAB KEYS
soft key, then press the TABULAR HARMONICS soft key. Press PRE-
VIOUS 8 HARMONICS or NEXT 8 HARMONICS soft key to progress
through tabular harmonic values. Press GRAPHICAL HARMONICS soft
key to return to the previous display.

TABULAR HARMONICS

———-UOLTARE--——
B C

OB ARY

Figure 4.5: Tabular G TVOLTAGE——
Harmonics Displa 7EE e 7Y
play 786 141865 32
EHD @.2ex% @.27% 8.03%
Kfactor 1.82 1.14 1
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4.5 Waveform Display

Waveform Display indicates the waveforms of rms voltages and currents for
the configured system. Also provides a magnification function for better
viewing. Tabular values displayed at the bottom of the waveform display
are instantaneous voltages and currents for configured system.

Figure 4.6: Waveform
Display

To Display Waveform Results:

1. Press the DISPLAY key and “2-Waveform Display” to view the
waveforms.

2. Press the VOLTAGE WAVEFORMS soft key, CURRENT
WAVEFORMS soft key, or V & A WAVEFORMS soft key to view
the respective waveforms.

3. Press the MAGNIFY ON/OFF soft key to view the magnified
individual waveforms only. New soft keys allow switching between
phases.

Note: This display does not include a complete set of Instrument Status
indicators (lower left of display) when viewing Waveforms.

View Instantaneous Values
Use the right and left cursor keys to move the vertical cursor for better
viewing of peak values.
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4.5.1 Magnify Waveforms

Magnify Waveform Press the MAGNIFY ON/OFF soft key to view a
magnified display of the waveform. Use the right and left cursor keys
to move the vertical line cursor for viewing instantaneous values. Soft
keys allow you to separately view the voltage and current waveforms.

A PHASE V & C WAVEFORMS

Cursor:-173.2 Uolts & -4.5 Ames

Figure 4.7: Magnified
Waveform Display

Press the Magnify ON/OFF soft key to switch back to viewing the
combined waveform results.

4.6 V & I Tabulation

Press the Display key and select 3-V&I Tabulation, to view all phase
voltages, currents and neutral current. Select the Min—-Max SELECTION
soft key to switch between Normal / Minimum / Maximum / Average
Results, and to Restart the counting for these results. For additional
information on Min—-Max selection, see Section 4.2.

UOLTAGE & CURRENT

PhA 187.8689 U B.6378 A
PhB 187.6328 U p.8188 A
PhC 958.1175 U ©.8534 A
PhN ———————- U 0.0082 A

Figure 4.8: Voltage &
Current Tabulation

SHOW
IMPECAMCE
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4.6.1 Show Sequence

Press the Show Sequence soft key to replace the Neutral reading with any
sequence voltages or currents.

4.6.2 Show Ratio

Press the Show Ratio soft key to display the ratios of Va to Ve, Va to Ia
and Ia to Ib. These measured components are fixed and no other ratios are
available. Also, the data is only available on the display of the 933A, not
available through the normal data stream from the 933A using PSCSV.

RATIO RESULTS

Magnitude Phase
VasUc 1.1995 -1.9708
VasI1al78.6823 B8.1409
7 . .
Figure 4.9: Show Ratio laslb  @.7385 1.8847
Display
o 1hs 12785
lt O e O

4.6.3 Show Impedance

Press the Show Impedance soft key to switch from voltage and current to
impedance - resistance (R) and reactance (X). Indicates the impedance of
all configured phases and sequence components.

IMPEDANCE RESULTS

PhA 186.1762 R 19.3128 X

PhB 118.2262 R 16.4622 X

PhC 183.7175 R 12.3491 X

. Se®  0.90008 R 0.00008 X

Figure 4.10: Show Sal  ©.9836 R 9.0894 X

Impedance Display Sa2  9.0807 R 0.0006 X
i ¥

B3P 410l 3E

| I | s | B
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4.7 Power Tabulation

Displays the Active, Reactive, Apparent and @ Results, as well as Power
Factor, of power measurements for the configured system. Min—-Max
Results changes the soft keys to allow access to Normal, Minimum,
Maximum and Average Results.

POWER RESULTS VAR RESULTS

PhA B88.4237 U 8.9838 PF FhA 16.8312 VAR ©.9839 FF
PhB 79.9447 U 8.988% FF PhE 11.9437 UAR 0.9889 PF
PhC 91.6636 W 8.9929 PF PhC 18.8933 UAR ©.9929 PF
Sum 268.6326 U 8.9885 .PF Sum 38.8682 UAR ©.9886 .FF

% PhA.PhE, PRC auerase

# PhA.PRE.PRC susrsse

s St
VA RESULTS R RESULTS
PhR 89.4606 UR B.9839 PF PhA 57.7436 Q B.9839 PF
PhRB 88.3322 UR ©8.9889 FF PhB 49.9297 Q B.9898 PF
PRC 91.5516 UA B.9929 PF PhC 54.6226 Q B.9538 PF
Sum 261.3444 UA  B.9886 .PF Sum 162.2958 Q B.9886 .PF

* PhA. PhE. PHC aver ase

# PhA:PhE, PhC averase

W3P i SF

o @ i
e I

Figure 4.11: Power Tabular Display

Press the EXIT Min-Max soft key to exit the Min-Max RESULTS menu
and return to the Power Tabulation main menu.

4.7.1 Power Calculations

Power and Energy are determined by making twenty separate measure-
ments per second with each measurement using 1024 samples (i.e. it takes
data from a 100 millisecond window). This yields a 50% overlap for all
readings to preserve accuracy. Therefore, since power is averaged over
the interval, the displayed value may not exactly match what you would
compute by multiplying the currents and voltages for each second.

For more detailed information on power calculations, see Appendix A:
Model 933A Functional Description.
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4.8 Power Quality

Displays two types of flicker; Instantaneous (One Second) and PST (10
minute). One-second flicker is displayed every second and PST continually
indicates a 10 minute count-down timer with the result of the calculation
in the same display. Press indicated soft key to switch between 1-Second
and PST. Press Min—-Max soft key to view minimum, maximum, average
and normal values.

POWER QUALITY

PST FLICKER

VOLTAGE CURRENT
PhA B.25 Under Ranae
PhB B.31 UnderRansae
PhC 8.51 UnderRanae

Figure 4.12: Show Power

Quality Next: @1:31

O
3P 410 3E

To select power quality:

1. Press the DISPLAY key and choose 5-Power Quality to select the
One-Second Flicker results.

2. Press the Min—Max SELECTION soft key to open the NORMAL /
MINIMUM / MAXIMUM / AVERAGE / RESTART of the power
quality results.

3. Press RESTART Min—Max to restart tabulating power quality
readings.

4.8.1 Min—Max

Press the Min—Max SELECTION soft key to open the Min—Max selection
menu. For more information on using the Min—Max function, see
Section 4.2.

H
B3P 4l 3E
ESTART

Figure 4.13: Min-Max Control

95



4.8.2 Flicker Information

Flicker measurements deal with a fluctuation of the line voltage. It is a
very specific problem related to human perception and incandescent light
bulbs, but not a general term for voltage variations.

The basic concept behind placing limits on voltage fluctuations is that they
cause lights to flicker, which can be irritating and may cause discomfort.
Voltage fluctuations are caused by loads on the power distribution system,
which are located near lighting equipment (within the same building or
powered by the same distribution transformer), and have changing power
or current levels.

Based on groups of people tested for irritation from light fluctuations,
most tend to be irritated when the light fluctuates at around 1000
changes/minute. Apparently above 1800 changes/minute light flicker is
no longer perceived. Fluctuations in the rms voltage of only 0.25% are
sufficient to cause noticeable flicker in light bulbs.

The 933A measures flicker according to IEC 61000—-4-15.

Definitions

Voltage Fluctuation: a series of voltage changes or a continuous
variation of the rms voltage.

Flicker: Impression of unsteadiness of visual sensation induced by a light
stimulus whose luminance or spectral distribution fluctuates with time.

One Second Flicker (or Instantaneous): is defined as the flicker
measurement that is updated each second. The Model 933A displays this
measurement.

Short-term flicker indicator, Pst: The flicker severity evaluated over
a short period (10 minutes); Pst = 1.0 is the conventional threshold of
irritability. A reasonable goal might be to limit Pst values to less than 1.0
for 95% of the time. The Model 933A displays this measurement.

Long-term flicker indicator, Plt: The flicker severity evaluated over a
long period (over 2 hours) using successive Pst values. The Plt threshold
is 0.8. The Model 933A does not display this measurement.
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4.9 Energy Tabulation

Energy Tabulation makes all energy-related parameters accessible from
one screen. This includes Watt-hours, VAR-hours, VA-hours, Q-hours
and energy restart function (soft key on the far right).

ENERGY (Wh> RESULTS ENERGY <VARh> RESULTS
RECEIVED DELIVERED RECEIVED DELIVERED
FhA @.0000 6.6166 Wh PhRA 0. 8088 7.9854 URh
PhB 2.088088 5.9762 Wh PhB B. BB6B 7.1753 URh
PhC 8.8888 6.8891 UWh FhC |G MIG1G15]5] 8.1411 URh
Sum @.0000 19.4817 Wh Sum B.0008 23.3817 UAh

IM3P A1 3,

7}
RESULTS

ENERGY (Qh> RESULTS ENERGY (VUARK 1-2) RESULTS
RECEIVED DELIVERED ARN 01 WARN 02
PhA 0.0000 5.7894 Gh PhAR 1.7348 8.808688 UARh
PhB 0.8088 5.8873 @h PhB 1.2898 8.80688 URRh
PhC 9.88088 5.4614 G@h PhC 1.1638 8.8088 UARK
Sum 8.9000 16.2581 Qh Sum 4, 1869 8.08000 UARh

3P 41 3F.

3P 410 3E

Figure 4.14: Energy Tabular Display

To select Energy Tabulations:

1. Press the DISPLAY key and choose 6—Energy Tabulation.

2. Press the specific soft key to view Wh, VAh, Qh and VARh
RESULTS.

Energy Restart Press the ENERGY RESTART soft key to reset the
energy totals to zero.
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4.10 Phasor Display

Displays the voltage and current phasors for the configured system
measured by the 933A. Screen includes tabular and vector data, soft keys
for viewing the voltage phasors, current phasors or both. Display also
includes instrument data including time, date and battery charge level.

For synchrophasors, using “Absolute” phase reference will cause the phasor
display to rotate as the measured frequency differs from nominal. Selecting
any other phase reference will cause that voltage or current phasor to
appear in the zero-reference position (horizontal, pointed to the right).

To select Phasor Displays:

1. Press the DISPLAY key and choose 7—Phasor Display soft key to
view the phasor display.

2. Press the VOLTAGE PHASORS soft key to view the graphical and
tabulated results of the voltage phasors.

3. Press the CURRENT PHASORS soft key to view the graphical and
tabulated results of the current phasors.

4. Press the V & C PHASORS soft key to view the graphical and
tabulated results of the voltage and current phasors.

5. Press the Log key to record any data to flash memory.

UOLTAGE & CURRENT PHASORS

——FHRSOR A-- ——FHRASOR E-- ——FHRSOR C--
97,5688 Uolts 94,3428 Uolts 97,1987 Uolts

=93, 87 Dea 147, 32 Dea 26,93 Dea
B. 73 AmF= B.2466 HmMF= B, F306 AmF=
—1B3.33 Deg 138,85 Des 28,18 Dea
—=FREQUEMCY -~
58.92v5 Hz
§.8418 Hz s
Y1 s
N, Ic

Figure 4.15: Phasor Dis-
play
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4.11 Basic Data List

Basic Data List summarizes many measured and calculated values on
one screen, including all configured voltages, currents, power and energy-
related data and totals. Refinements include Energy Delivered, Basic plus
Quality, Basic plus Sequence, Basic plus Phase and Min—-Max Selection.

To select basic data list items:

1. Press DISPLAY > 8-Basic Data List.

2. Press any of the soft keys to choose the desired results with Basic
Data. See screens below for individual information.

BASIC+ENERGY RESULTS BASIC+QUALITY RESULTS
A PHASE B PHASE C PHASE TOTALS A PHASE B PHASE C PHASE TOTALS
97.9745 U 94,4681 U 97,3156 U (Newtral Cur? 92,1567 U 94,6782 U 97.6851 U <Hewtral Curd
B, 2e=7 O wigdrr @.3312 B 0,007 A n,718g o 0.3437 H @.3356 A A
18,29 Deo g,48 bao &u00 Des 8,08 Dea 1@,32 Des 2.58 Deoa E.BA Dea  =29.9F Dea
8.3855 FFT B.389a FF a. 5551 FF B.9038 PP @.9889 PF @.9923 PF
B7.4968 W TE.3ZAF W 52,9751 87.7751 Ul T3.2646 W S0.E7L9 W 25F.FLLE
15:8937 Unr 110655 Uoe  14Ié5er U 1509051 U 1108980 UAR  [@.02091 UAR ~Z8 /231 URR
eOlEvEE DR vei7eRd UR ga) U 82,2205 YA 8B.1926 VA E1.3163 YA 28E.6534 WA
Sr.45e3 @ 43l6E43 O 54,7150 © SE.TIS 00 48858 4 Sd.7I4E @ [E203961 O
ENERGY RECEI YOLTAGE CURRENT
B.0EEQ Wh  6.8088 Uh a. a.11 6.1436 U @, 4165 U
2,4987 Rih 78522 Blh & UnderRanse  UnderRanse UnderRanss
GI0BAR K24 BLARGA Reh A,
B.BO0G URh  ©.0aad Udk A
B,0E08 Bh ©,0800 Gh a
Deg = o Phaze-1PY Dew = W Phase-I Phase

a9 Hou 2087
iFr’i 12127139
= el

BASIC+SEQUENCE RESULTS BASIC+PHASE RESULTS
A PHASE B PHASE C PHASE TOTALS A PHASE B PHASE C PHASE TOTALS
F5.3I1Z Y 486D W 98,8700 Y tNewtral Cury 9%.3204 U 94,8618 U 98,8453 U <Mewtral Curd
B, 3117 o [ lie] 6.2354 0 o.0E62 0 B,9116 A 8.8516 A A.3352 A B, AA62 A
18,32 De= 2,51 Des €.81 Des 90,10 Des 18,32 Deg 8,31 Dasg £.8L Des  50.65 Deg
B.983E FF B.98B3 FF @.9523 FF B.9838 PF 6.9839 FF 6.5529 FF
65,8953 W __ 79.5362 U 91, . . . .
758972 o ITI335 e 100EEES M T3ECSE0E Doe TE:8008 toe (103802 Boe 503033 Hop 2380005 e
23.04P2 U 29,4892 UR 22,8403 UR 262.9922 UA 83.5268 WA B8.4388 VA 3L.3354 WA 262.8843 LA
5r.9542 o S8.1515 0 5501625 & 18302600 97,9390 U 50.1431 1 5501293 0 183.ZI14 O
SEQUENCEN SEQUENCE1 SEQUENCE 2 A B ¢
. 9897 U 97.0626 U 2.3312 U
B.eE1a A B.9UEl H LiEEI2 A
+ + +
-0 =5 =0

Deg = W Phase-I Phase

89 Hou 2087 .
iF” . paeay V¥ Phase = | Phase
L IR

Figure 4.16: Basic Data Display
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4.12 Config & Status

Press 9-CONFIG & STATUS to view configured electrical system, com-
munication, time and date, calibration information, firmware versions by
date. Also included is a battery and flash status screen that breaks down
each category in more detail: Battery Status, Main Flash, Log Flash,
Event Flash and DSP Flash. See screen shots below.

CONFIGURATION

MELG ¢ ZFh 40 3E EREQUENCY MODE:&GHZ
ERMEE: g-ggil) FREQUEHCY REF:Uan
ERHBE: B-28 H PHRSE REF:Hbsoluts

COMMUNICATION
FIAL: Baud: 38400 Lensth:=& Stor:l Parite:0ff
OHDCRST! Off
SEL. L: Inactive

TIME-DATE~STATUS

IHPUT CoOl
UOLTREE
CUREENT

Mode! Local DST OW Battera Uoltassii@.2u
Source! RTC Chat aer Inactive
M Errors: Ll UC0 Tune Uolt: 2,580

T3
o

VERSION & SERIAL NUMEBER
UNIT

Uersion Humber: 178er@7 1,08
Serial Humber: 182
Calibration Date: 180CT20A7

Figure 417 Conﬁg and 1dentificatE:onUHRumRbEt{;l;S—FUDULE
Status Display Falioration Duter 180cter

BATTERY & FLASH STATUS

BATTERY STATUS

Tind15GasGause = 5419
933Gashauge = 2433
Batteruloltase = 10,02
BatterdgCurrent = -A, 75
Internal Temr = 335,30
MAIN FLASH STATUS = OK
EBad Elocks = 1¢ay
BlocksAuail = 1821(1B21)
LOG FLASH STATUS = OK
Blocks Used = 1
# Recaords = 5
ELENT FLASH STATUS = OK
Blocks Used = 1
# Records = 2
DSP FLASH STATUS = OK
DEF FlashEtatus = IDLE
Bad EBlocks = 2
BlocksAuail = 4]
Blocks Used = lBle
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4.12.1 Status with GPS Synchronization (DISCON-
TINUED)

When selecting 9 — Config & Status with GPS connected for clock
synchronization, a soft-key named SHOW GPS STATUS will appear.
Press the SHOW GPS STATUS soft key to view GPS status information.
Press the SHOW GPS STATUS soft key to display geographical position
and satellite tracking information. Press the SHOW SATELLITES soft key
to display the satellite positions and relative signal strength information.

CONFIGURATION

MELG ¢ ZPh 4l ZE EREQUEMCY MODE: &BHZ
ERMEE: g-ggil) FREQUEHCY REF:Uan
ERHBE: B-28 H PHRSE REF:Hbsoluts
ZERIAL: Baud: 115280 Lensth:& Storsl Farito:Off
BEOHDCRST! Off

Lol Rotive

IHPUT CoOl
UOLTREE
CUREENT

TIME-DATE~STATUS

Mode! Local DST OW Battera Uoltass=ii@. 1l
= _Sourcel GRS Chat aer Inactive
EOH Errors: Ll UC0 Tune Uolt: 20150

GPS STATUS
GPS RECEIVER HEALTH: OK
SATELLITES TRACKED: &
pilution 0f PrecisionyDOP: 4.2

ANTENNA LOCATION
Figure 4.18: GPS Status LONGITUDE: W12@° 417 33, B24"
LATITUDE =N 35°35’5@.976"
ALTITUDE : 213.17 Meters

|7 How  20d7
iued 11:32:29
€ [

[~R=]

Display

! SHOW
H [ERTELLITES

@7 How 2067
iued 113512
% bl
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Chapter 5

Reviewing 933A Data

Review event and data records stored in the Model 933A by pressing the
REVIEW key and selecting the type of records you want to review. The
main data-review screen is shown below.

SELECT REVIEW TYPE

SHOL ERASE
SHE SWELL LOG DATH

Figure 5.1: Main Review Screen

5.1 Review Data Selections

The following choices are available by pressing the appropriate soft key
from the menu above:
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5.1.1 Show Log Data

SHOW LOG refers to the 1-second data that is logged during a LOG key
press, an Auto Log function, or from a Trigger (User, Power Quality, or
from the optional Auxiliary I/O Module).

5.1.2 Show User Event Records

SHOW USER refers to the event record, including the exact time and date
of the User programmed event. It does not refer to the data that may be
stored before, during and after the event.

5.1.3 Show Power Quality Event Records

SHOW PWR QUAL refers to the event record, including the exact time
and date of the power-quality event. It does not refer to the data that
may be stored before, during and after the event.

5.1.4 Erase Log Data
Press the ERASE LOG DATA soft key to clear all the data from the flash

memory card.
The following pages describe, in short steps and in more detail, how to
view and download data from the 933A.

5.2 Steps to Locate & Review Records

Listed below are steps to assist you with identifying and locating the
specific data you want to review. Basically, there are two types of records
stored in the 933A: data records and event records. Decide which record
type you wish to view; a record of the event, or the data recorded during
the event?

5.2.1 Locating the Data Logged During an Event

To find actual data measured by the 933A, proceed as follows:

1. Press the keys, REVIEW > SHOW LOG > REVIEW SELECTIONS

2. Press the appropriate soft key that indicates the source of the data
- Event Logs, Key Logs, Auto Logs or All Logs.
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3. You can reduce or increase the rate at which you can search through
records by pressing the REDUCE RATE or INCREASE RATE soft
keys.

4. Press the numeric key that corresponds to the data record you wish
to review.

5. Press the numeric key corresponding to the data type from the
DISPLAY SELECTIONS screen to view the actual data record.
Press any other numeric key to change the data type.

5.2.2 Locating Event Records

To find the event record information in the 933A, proceed as follows:

1. Press the keys, REVIEW > SHOW USER, or SHOW PWR QUAL
2. Press the REDUCE RATE or INCREASE RATE soft keys if

necessary.

3. Press the numeric key that corresponds to the event record you wish
to review. Notice that the event record always indicates the trigger
by number and whether it is active (up arrow) or inactive (down
arrow).

4. The next screen will always show the high-speed waveform record
of the event, and within 50 ms of the event. Remember that there
should be either 25 or 30 cycles of pre-event data.

5.2.3 Reviewing Recorded Data (Show Log)

To view any recorded data (following an Event or LOG key press, or
Autolog session) press the keys:

REVIEW > SHOW LOG > REVIEW SELECTIONS > (EVENT LOGS,
KEY LOGS, AUTO LOGS or ALL LOGS)

Press the soft key corresponding to the type of data you wish to review.
This does two things: (1) it opens the specific data record selection window,
and (2) returns you to the previous menu. From here you can review a
record, choose other record types to review, press the REDUCE RATE or
INCREASE RATE soft keys to improve record searches.

Figure 5.2 below shows how the 933A sorts the data records according to
type. If you choose SHOW EVENT LOGS, only the Event records would
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show up in the list. The “T” symbol on the right side of the individual
record indicates that the data record is from a trigger.

REVIEW LOG DATA

Log Date/Time And Log Reason ¢ALL>
W ERT T BT

Figure 5.2: Notice that
11 records show up in the
list. “A” indicates
Autologs, “K” indicates
Key Logs and “T”

an 28835 Wed

indicates Trigger Logs. og Ttem: 13

Compare the time and Ojdest: [) Mewest
L—Total Log Items: 13 —!

da‘te Of reCOrd number 0 Search Rate: One Entry Per Step

with the time and date of
Figure 5.4.

For view Trigger data, press the REVIEW key > SHOW LOG > REVIEW
SELECTIONS > SHOW EVENT LOGS. Next to view data, press the
record number (left side). You should see the DISPLAY SELECTION
screen as in Figure 5.3 below.

DISPLAY SELECTION
B— Tabular Results
1- Harmonic Results
2- Waveform Display

Figure 53 Review 3- U & I Tabulation

Display Selection; g— Eouer aabtiq:tion
- Power Quality

appears the same as 6— Energy Tabulation

pressing the DISPLAY 7— Phasor DisPlay

key, but during review it g: ggﬁﬁgbgtgtgiﬁﬁ

1S 1n HOId 1\40(16. ‘b ARROW kews move selection cursor

Press any of the number keys on the keypad to select the desired data
type. Remember that the 933A stores a complete 1-second record of all
measured data. The date and time of the data record in the list should
agree with the date and time of the actual data record shown here — see
Figure 5.4.
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VOLTAGE & CURRENT PHASORS
——FHRSOR A-- ——FHRSOR E-- ——FHRSOR C--
95,0482 Uolts 94,9767 Uolts 94,9670 Uolts
=111.32 Dea 129,29 Des 2.8¢ Dea
B.9144 HmF= B.5734 HmF= B.2134 HmF=
-1208.52 Deg 128.81 Des 2,92 Dea

535966 Hz
Z5l8i6e Hz-s u

Figure 5.4: Phasor
Record Review; compare .
the time and date with

: e /
Figure 5.2 record 0. 1
[ B2 b iy
o 1] 93P 40 5E

Owl

5.2.4 Review Selections Soft Key

Press the REVIEW SELECTIONS soft key to select the type of logged
data you wish to view — Event Logs, Key Logs or Auto Logs.

SHOIW SHOIW

SHOW N I EXIT
VENT LOGS] KEY LOGS i 055 | ALL LOGS PSELECTIOHS

e Show Event Logs — reveals only the recorded data from an event.

e Show Key Logs — reveals only the recorded data from a LOG key
press.

e Show Auto Logs — reveals only the recorded data from an Auto Log.
e Show All Logs — reveals all three types of logged data.

e Exit Selections — returns to the previous screen (e.g. Review
Selections).

Reduce Rate / Increase Rate

Use the REDUCE RATE or INCREASE RATE soft keys to adjust the
scanning rate through the stored records. RATE keys will save time
searching when the 933A has hundreds or thousands of records. The 933A
indicates the search rate just above the soft key labels at the bottom of
the display.
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5.3 Reviewing User Event Records

In general, records are stored chronologically with the latest record at the
top of the list. When viewing event records held in flash memory, the
instrument is placed in Hold Mode, and you may access all recorded event
data from the keypad. The User Event Record screen is described below.

Press REVIEW > SHOW User EVENT (soft key) to view the event
records.

5.3.1 Interpreting a User Event Record

The data line in the small window (shown in Figure 5.5) indicates an event
record. The values and symbols in the record indicate some things about
the event.

e The event number, on the left of the display, includes the sequential
number (0 — 9), the trigger number (01) and the arrow symbol. The
arrow symbol signifies if the trigger is either active or inactive. An
up arrow indicates an active trigger and a down arrow indicates an
inactive trigger.

e Date & Time — date and time that the event occurred, including
fractional seconds (in 50 ms increments).

e Type — Indicates the type of event record, User or Power Quality.

REVIEW USER EVENT DATA

Event#

Current Record

Numbered Records

Searching for Records

g
Oldest [ D Newest
Ap— —
—Total Log Items: & —
Search Rate: One Entry Per Step

Changing Search Rate REDUCE

Figure 5.5: Review All Logged Records
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5.3.2 Searching for Records

Use the soft keys and the right/left cursor keys to page and scroll through
the records list. This is very useful when there are hundreds or thousands
of records. Note that once moving, the search has inertia after lifting your
finger off the cursor key.

Current Record Number

The current record is shown in the small window entitled Log Item: nnn...,
where “nnn...” is the current record number. Press the right or left cursor
arrows to step through the records. The vertical line in the window
between “Oldest and “Newest” indicates the position of the current record
relative to the total number of records.

Total Log Items

The number of “Total Log Items” indicates the total number of records in
the Log file. Flash storage capacity is approximately 16,000 records.

Reduce Rate / Increase Rate

If the total number of records is very large, press the rate adjust soft keys
then to speed up the location of individual records.

To change the review rate, press the REDUCE RATE or INCREASE
RATE soft key. The rate changes as follows: One Entry per Step, One
Percent Steps, Five Percent Steps, Ten Percent Steps, Twenty Percent
Steps.

The Record Number Indicator (vertical line) gives a visual clue to where
the current list of records lies within the entire list of stored data.

To Return to Measurement Mode

To return to the Measurement Mode from Hold Mode (while reviewing
event records), press Display key and choose a data type. The 933A will
again begin displaying current measured data on the display.

To Review Recorded Data Again

Press the REVIEW key again to start over reviewing data.
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5.3.3 Viewing Waveform Data at Time of Event

When viewing event records, the 933A can immediately reveal the high-
speed waveform data recorded at the time of the event. Press REVIEW
> SHOW USER > Event# (press the enter or number key corresponding
to event record) to reveal the waveform record. See Figure 5.6.

REVIEW USER EUENT DATA [
Event# DatefTime Type A \/Wwi
a1t T Ze0ctis iEZE T
: : 6a  USER |

- BSE6
2oEREa  USER
IpEaen  USER

Use ¥ To Search And #'s To Select Review Item

Ik C
| ———
Oldest ( D Newest
— —
= Lursorc
T8l CurzorTime

—Total Log Items: 4
Search Rate: One Percent Steps

Figure 5.6: Reviewing Records

1. To view other forms of data (e.g. per second data) press the numeric
key related to the data form in Display Selection menu (as seen in
Figure 5.7).

2. For example, press the “0” numeric key to view Tabular Results, or
“2” to go back to waveform from previous view.

3. To view a specific data type, press any of the numeric keys according
to the numbers shown in the Display Selection screen on the left in

Figure 5.7.

DISPLAY SELECTION PHASE A RESULTS
IFLTIY- T 98.5359 Uolts 88.4496 U
2- Waveform Displau -76.84 Udeg 16. 1335 UAR
2— g &1 ;agu%aiim’! 8.9137 AmPs 89.9989 UA

- Power Tabulation _

S5- Power Qualits 87.16 Adeg 9.9838 PF
6- Energy Tabulation 19.32 Deg* 59.9927 Hz

7- Phasor Disrlay
8- Basic Data List
9- Config & Status

14 ARROW kews move selection cursor

[Deg = Phase-1 Phase

Figure 5.7: Selecting Records
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5.4 Reviewing Power Quality Event Data

The 933A treats Power Quality event records in much the same way as
User event records, only it follows the rules of IEC 61000-4-30, paragraph
5.4, for Voltage Dips and Swells. When you select a specific event record
(using either the ENTER or numeric keys) it will reveal the waveform at
the time of the event.

1. Press the REVIEW key and select the SHOW PWR QUAL soft key.
A list of any power-quality event records will appear in the display,
if the 933A has captured any (see Figure 5.8, left screen).

2. Press the ENTER key, or any numeric key corresponding to the
record number in the list, to view the waveform record at the time
of the event (see Figure 5.8, right screen).

3. To access other power-quality event records, press REVIEW >
SHOW PWR QUAL as in step 1.

REVIEW PWR RUAL. DATA f T
Event# DatejTime Min  Max [a] &V
T 4.5 4.5

Bz4+T 1ZAus 1? 55380
8z1T 1ZAus 17: 41633 - 4
a1+T 1ZAus 17: SEEIT 4.6 4.6
a1tT 1ZAus 17 » 335388
az+T 1ZAus 17  2E5388 24,3 4.5
a1+ 1ZAus 17 . FLEE3S 4.6 4.6 B
a1tT 1ZAus 17 83300
aztT 12Ru5 1? i a3417
§- BZ4T 12 17:d 28913 4.3 4.5
Ead BZ?T 12Ru5 17: 41 83.655115 - 4

Use &5 To Search And #'s To Select Review Item
0 : c
Dldest [ D MNewest
— iy

Total Log Ttems: 2@ — 182 CursorTime Cursorf CursorB o
Search Rate: One Entry Per Step I Tz 41 44 1165 17:8 H L2315 g
_|

Figure 5.8: Selecting and Viewing Power Quality Records

Notice that each data record provides a record number, trigger number,
date and time of event, max and min values attained while the trigger
was active. Maz and Min values are only produced after trigger becomes
tmactive.

5.4.1 Viewing 1-Second Data Records

To view 1-second data logged at the time of the event (as viewed from
Figure 5.8), press any of the numeric keys corresponding to the desired data
type. Otherwise, you could press REVIEW > SHOW LOG > REVIEW
SELECTIONS > SHOW EVENT LOGS. To use this effectively, you would
need to know the time of the event to locate the record correctly.
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5.5 Reviewing Data using PSCSV

To review 933A data using PSCSV software, you must first make a
connection to the 933A. For information on making a connection between
the 933A and PSCSV-933, go to Section 6.2.4 in PSCSV Basics.

To review data recorded in flash triggered by an event, click the
Download Event button and a small window (see Figure 5.9) should appear
with the following data types:

DSP Log (User Event) — all User event records.
Per Second — all one-second data recorded due to an event
Sag Swell (Power Quality) Event — all Power Quality Event records.

[ ]
[ ]
[ ]
e Waveform — waveform data recorded due to a power-quality event

Choose event data to download. g|

" Per Second

C |
(™ Sag Swel Event ance

" whaveform

Figure 5.9: Download Event Screen — PSCSV

NOTE: “User” and “Power Quality” include records of the event itself,
not the data records collected at the time of the event. To download the
actual data recorded at the time of the event, see Sections 5.5.2 and 5.5.4.

Record Selection

Record selection in Figure 5.10 allows you to choose either to Select All
records or Select Range. Select Range allows you to limit the number of
records you want to view by date and time.

933 DSP log,

* Select Al

" Select Range:

Fram (UTC): |

H |
Tomutey | BN =
m Cancel

Figure 5.10: Selecting Events to Download — PSCSV 933
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5.5.1 User Event Record Example

Outlined below, is an example of downloading User Event records. Select
USB for downloading waveform data, otherwise the download time could
be very lengthy.

Description Estimated Records Begin|_ End
933 D5P lag 3 10-24-...  11-2..,
Tatal Recvd: 3
Total Possible: 3

I~ Closs This Dialog Upon Completion

i

Figure 5.11: Downloading User Records with Progress

Downloading Procedure

Make sure that you are connected to the 933A. If not connected using
PSCSV, see Section 6.2.4.

1.

Begin by clicking the Download Event button to open the ”Choose
event data to download” window — see Figure 5.9. Select the DSP
Log radio button, and click OK.

. From the Data Selection window, choose either Select All or Select

Range data by date and time — see Figure 5.10. If choosing Select
Range, date and time values are in UTC format.

A SaveAs window should appear that allows you to save a record
of the download. Click the Save button and the records should be
transferred from the 933A to the computer.

When the User Log window appears, a progress window will indicate
the progress of the record download graphically and by number of
records — see Figure 5.11.

When the download is complete, select the line that indicates 933
DSP Log (User Event) with your cursor and click once. The previous
window should immediately be minimized and a second SaveAs
window should appear.

72



6. Click Save, or choose another filename and click Save, and a list of

event records should appear as seen in Figure 5.12.

ADDDOD107-2011-12-01.933DSP
PC Local
12-01-11

Trigger
.7ooooo 2

Description

DSP trigger actiwve.

12-01-11
12-01-11
12-01-11

.rooooo
.oooooo
.1oo0oon

1 DSP trigger actiwve.

1 DEP trigger inactive.

Z DBP trigger inactive.

Figure 5.12: Viewing Triggered Event Records — notice the trigger number
and Trigger activity.

5.5.2 Per Second Data

Per—Second Data are the actual data recorded during an event. Click the
Download Event button or select Connection > Flash > Download Event.

1. Choose the Per Second radio button and click OK.

2. Choose to select all data records or a smaller selection by time and
date and click OK.

3. Choose a file name and click OK to save the file log. During this time
a window will appear that shows both the progress and the record
files being transferred from the 933A to a file on your computer. See

Figure 5.13.
fex C:\DOCs_SYN\PD0031100_933A_Manual\A00000102-COM5-rs232-.1133D = ES

Description
933 One sexa...
Total Recvd:
Total Possible:

Estinated Records | Begin|  End
84 10-24-.. 11-1..
g4

L]

COM5-rs232 Progress

84/633

I Close This Dislog Upen Campletion

Cancel

Figure 5.13: Downloading Per—Second Data

4. Now select the top line in the log with your cursor and a Save-As
window will appear. Click OK, or type in a different name and click
OK, and a window should appear with the data.
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AD0DD0102-PSCSY 933 One Second Log-2007-10-24.9330S

Date / Time A W MNAG AV PH B V MAG E V PH C WV MAG CV PH A I M
10-24-07 23:16:02 98.226 90.458 94.857 -27.269 87.318 -147.63 .209

10-24-07 23:16:03 62.346 -90.618 95.368 -26.744 97.608 -147.07 .91z

10-24-07 23:16:05 92,799 92.283 94,997 -25.310 97.448 -145.75 .210

10-24-07 23:16:086 98.3860 92.461 95.030 -25.137 97.647 -145.57 .910

10-24-07 23:19:32 98.532 B0.831 95.184 -36.765 87.911 -157.20 511

11-19-07 16:23:32 . 00654 -76.481 00682 46.598 .00742 -93.808 .ooo

11-19-07 16:23:33 . 00641 -22.09%9 .00680 -15%.57 .00742 -g7.010 .ooo

L R PR ann

}NorlnnléMﬁmmumbMammum Averages Enerdy s Harmanicap, THOA Even O,

Figure 5.14: Downloaded Per—Second Data in Spreadsheet

Notice that the spreadsheet of data types are organized by the tabs at the
bottom of the window and fills to the right. See Figure 5.14.

The data window above contains normal one-second data including volt-
ages, power, frequency and flicker. Select minimum and maximum values
from the tabs below.

5.5.3 Power Quality Event Record Example

Make sure that you are connected to the 933A. If not, see Section 6.2.4 in
PSCSV Basics. Click the Download Event button or select Connection >
Flash > Download Event.

1.

Choose the Sag Swell Event (Power Quality) radio button and click
OK.

From the selection menu, choose to all data records or a smaller
selection by time and date, and click OK.

In the SaveAs window, choose a file name and click OK to save the
file log. During this time a window will appear (see Figure 5.15) that
indicates both the progress and the record files being transferred from
the 933A to a file on your computer.

. Now select the top line in the log with your cursor and a Save-

As window will appear. Type in a name (or accept the suggested
file name), click OK and a window will appear with the data (see
Figure 5.16).

Notice that each record begins with the time and date, followed by
the trigger number, followed by a description of the event and finally
the maximum and minimum values attained during the time the
trigger was active.
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Description Estimated Records Begin End

933 Saq swell log 20 11-21-07 00:55:53 11-21-07 00:56:45
Tokal Recyd: za
Total Possible: o COM5-rs232 Progress

21/

[ Closs This Dislog Upon Completion

oK

Figure 5.15: Downloaded Power-Quality Event Data

A00000102-2007-11-21.93355

Date

11-21-07 00:55:53.896778
11-21-07 00:55:54.513378
11-21-07 00:55:55.413378
11-21-07 00:55:56.4965683
11-21-07 00:55:56.546583
11-21-07 00:55:56.0796862
11-21-07 00:55:58.163163
11-21-07 00:56:03.825980
11-21-07 00:56:03.788281
11-21-07 00:56:17.473046

/ Tine Trigger Description Minimum Mazimum ]
Sag / swell voltage/current active. - -
Sag / swell voltage inactive. 98.487686 98.509934
Sag / swell voltage/current active. - -
Sag / swell voltage inactive. 98.470158 98.509407
Sag / swell voltage/current active. - - L
.484772 98.509514
.493809 98.504871
.244211 98.500819
Ssag / swell voltage/current active. -— -—
.251462 98.509758

@

sag / swell woltage inactive. 9

@

Sag / swell voltage inactive. 9

o

sag / swell voltage inactive. 9

@

PRSI SR SRS VI CEE SRS

Sag / swell voltage inactive. 9

Figure 5.16: Downloaded Power-Quality Data

5.5.4 Waveform Data

Recorded waveform data may be the result of User or Power Quality
triggered events. Make sure that you are connected to the 933A. If not,
see Section 6.2.4 in PSCSV Basics. Click the Download Event button or

select
1.
2.

Connection > Flash > Download Event.
Choose the Waveform radio button and click OK.

Choose to select all data records or a smaller selection by time and
date and click OK.

Choose a file name and click OK to save the file log. During this time
a window will appear that indicates both the progress and the record
files being transferred from the 933A to a file on your computer.

Now select the top line in the log with your cursor and a Save-As
window will appear. Type in a name, click OK and a window will
appear with the data.

Notice that waveform record includes a cursor with the time and
date at each point along the waveform, the corresponding voltage at
the cursor, and the trigger number.
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A0DDDD102-2007-10-24. 933Wave EEKX

134.43

-.29732

-135.03
2007-Nov-21 00:55:53.900000 UTC 250 ms 2007-Nov-21 D0:55:54.1499802 UTC
2007-Nov-21 00:55:54.004590 UTC A V:-16.009
User triggers active: 1, 2

Figure 5.17: Downloaded Waveform Data

PSCSV933 provides trigger information the bottom of the waveform
display, whether the trigger is active or inactive during the waveform
recording. For example, if the triggering condition is false the display
will indicate, ”No triggers active”. If a specific trigger is active, then it
will indicate a message with the trigger number; for example if Trigger
number two is active while the recording is going on, it will say, ”User
Triggers Active: 2”. If more than one trigger is active, then all of them
will be listed.

Event Time Tracking. See event wavefore in Figure 5.18 below. Note
that the actual event time appears below the dark vertical cursor in the
middle of the waveform.

400000107-2011-12-01.933Wave FEx
139.16 1‘
-2.5400
-144.26
2011-Dec-01 14:54:59.950000 BC 500 ns 2011-Dec-01 14:55:00.449902 PC
2011-Dec-01 14:55:00.173828 BC B V: 124.12
User triggers active: 1

Figure 5.18: Downloaded Event Waveform

By carefully examining the waveforms, you will notice that there are
“holes” in the waveform that correspond with different events. If two
events are recorded at different times, then the waveform records will be
connected piecewise, however there will be a discontinuity at the end of
the first waveform record and start of the second waveform record.
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Chapter 6

PSCSV Basics

6.1

Introduction

Power Sentinel CSV 933, or PSCSV, is the application software designed
to operate with the Model 933A. This chapter was written to help you
become familiar with how to use PSCSV to configure the 933A operation
and manage data collected with the Model 933A.

6.1.1 PSCSV Features

Analyze Power Quality: Harmonics, Flicker, K-factor and Interrup-
tions

Capture Events from 32 Configurable Triggers

Log Data from Triggers — See Chapter 7

Autolog based on Time and Date

Synchronize with GPS or IRIG-B for Phasor Measurement
Optional Event Inputs and Relay Contacts

6.1.2 Linking

The first step in using PSCSV with the Model 933A is by linking the 933A
to a computer running PSCSV. To link them:

connect the proper cable between the computer and the 933A
open a connection to the 933A using PSCSV software
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6.2 Windows, Menus and Toolbars

The PSCSV main screen (shown in Figure 6.1) provides access to its many
features by assembling them together according to functional groups called
Menus, Toolbars, Function Buttons and Windows.

TIP: When you first start PSCSV, only a few icons in the program will
be available, but PSCSV will NOT be linked (having an open serial
connection) to a specific Model 933A. You must click the Connection
button or select Connection > Open to initiate a serial connection.

One function that is available when PSCSV is not linked to a Power
Sentinel is viewing data files. You can open data files using the Open
button without being connected to a 933A.

6.2.1 Main Window

PSCSV English - test3.11338-C37-118

O % %6 %N |Jam o |l a0 @ en | w0
— =

| |n/zs/znn7 ~| |15‘1z‘qs

@& test3.11338-C37-118

ure *11-26-07 23:14:14.650000
Freq. (Hz) 59.995

— Input Magnitude  Phase (deg)]
Ch &V 97.867 327.829
Ch AT 0.906 317,529
Ch BV 94,836 209.977
Ch BT . 1

Choo

Ch CI 0.927 B8Z.891

[+ sequences Hagnitude  Phase (deg)]

B C  Total

Figure 6.1: Main PSCSV Screen

Switching Toolbars ON or OFF

To switch Toolbars on or off depending on the need and available space,
select ‘View’ on the Main menu.

Moving and Viewing Features

You can move any Toolbar and dock it around the Main window by
selecting and holding one of the Toolbar handles and dragging the Toolbar
to a preferred location.
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6.2.2 Menu Definitions

Most of the Menu selections are duplicated by the Toolbar buttons.

File Menu

The File menu > Open command allows you to open a 933A data file
already saved on your computer. Use the Connection menu to open a
connection between the 933A and a computer. Other File menu commands
include, saving a snapshot (data capture while receiving a broadcast of
data), exporting data in several protocols (see Section 6.4) and printing
data.

Connection Menu

Most of the actual work is done from this menu. From opening a
connection, to configuring the 933A, to collecting data, or to finally
closing a connection, begin with the Connection menu or associated toolbar
buttons.

Edit Menu

e Copy. copies the selected data to the clipboard.
e Select All selects all of the data in the Data window.

e Preferences. selects window for setting various time and date
viewing preferences. Select colors of signals in Waveform and Phasor
views. Click the Edit menu to open. See Figure 6.2.

M Edit Preferences E|

Description Walue
Time
Standard UTCTime  ~|
D aplight S avings &0 j
Custom [minutes] E0
[ ata Wiew
Colors
Font Courier Mew, 12 ..

# Broadcast Harmonics 13

Figure 6.2: Edit Menu, Preferences
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View Menu
Use the View menu to control the appearance of data streaming from the

Model 933A. Items that can be controlled are described below.

e Time Format: format accompanying data in either GPS Local,
UTC or PC Local time.

e Filter Data: selects and limits the data being viewed in the active
PSCSV window.

e Waveform Smoothing: smooths the waveform appearance caused
by the limited number of data points used to construct waveform.

e Time Interval: changes the time scale for waveform and phasor
data — similar to an oscilloscope — to expand or compress the
horizontal scale. Certain values are only available under preset
viewing conditions.

e Auto Scale: Used by some functions to automatically scale data to
fit in the window size.

e View As: view most data in real time or spreadsheet, harmonics
also as vertical bars and phasors as a vector or frequency plot.

e Toolbars: switch on or off any combination of toolbars.

Window Menu

The Window menu helps you keep track of the open data channels and
organize the data windows inside the main PSCSV window.

Help Menu

Help gives the PSCSV version information, connects you to the PSCSV
page on the Arbiter website and can also pop up the Tip of the Day.
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6.2.3 Toolbar and Button Definitions

Main Toolbar

= & = &

Open: opens a specific 933A file (saved to a computer running PSCSV)
— has browse features

Export CSV: exports selected 933A file records to .CSV for use in
spreadsheet programs. Select either current data, or from data files.

Create a Snapshot: saves a sample of data being broadcast from the
933A, to a separate file for viewing.

Copy: copies selected records in a file under review in the PSCSV main
window.

Home page: connects you to the PSCSV home page at:

www. arbiter.com/support/downloads

Connection Toolbar

ISl |USB 933-usb |

Open a Connection: allows users to select a connection type, specify
parameters and open a connection between the 933A and computer.

Close a Connection: immediately closes the current open connection
(shown in the Connection Window) between the 933A and a computer.

User Login: PSCSV-933 does not use this feature; it is available for other
Arbiter products. All 933A features are available with an open connection.

Connection Window: indicates the open connection(s) between the
933A and computer (See drop-down window in Connection Toolbar).

Broadcast Toolbar
D@ S T
Stop All: stops all broadcast data streaming from the 933A.

Stop This: stops the current broadcast data and leaves others alone.
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Pause: pauses the flow of data from the 933A into the PSCSV data
window. Broadcast data accumulates while paused.

Basic Data: initiates the flow of basic data into the main window.
Energy Data: initiates the flow of energy data into the main window.

Harmonic Data: initiates the flow of harmonic data into the main
window.

Harmonic Summary Data: initiates the flow of harmonic summary
data into the main window.

Waveform Data: initiates the flow of waveform data into the main
window.

Phasor Data: initiates the flow of phasor data into the main window.
Indicated as PMU-1.

Flash Toolbar
@ % &

Flash Status: opens a summary window of flash memory status.
Erase Flash: erases all records held in flash memory.

Download Events: opens the Download Event window. Allows selection
of records for downloading from flash memory.

Erase Events: not used in the Model 933A. Use the erase flash function.

Input Toolbar

HUNAITRE M BITRR U 1)

Voltage Channels: selects voltage channel(s) when viewing waveform(s)
or phasor data.

Current Channels: selects current channel(s) when viewing waveform(s)
or phasor data.

Increase Vertical Scale: increases vertical scale resolution when viewing
phasor data from Frequency Plot tab.
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Decrease Vertical Scale: decreases vertical scale resolution when
viewing phasor data from frequency plot tab.

Records Toolbar
&S )' [tyjzmpmnr | | |o6i00ss =

Use the records toolbar to page through the data, especially when there
are a large number of records.

Configure Toolbar
7 ™G B

Configure toolbar buttons allow you to configure ports, configure measure-
ment parameters and configure trigger parameters. Select the question
mark to return the instrument status. Information on configuring ports
and measurement parameters are located in this chapter. For complete
details on configuring trigger parameters, see Chapter 7.

e Measurement Parameters: includes DSP mode, CT-PT Ratios,
(transformer) Loss Compensation, Anti-Creep, Internal Calibration
and Voltage Linearity. See Section 6.2.6

e Ports: includes RS-232 Port Settings and PMU-1 settings. See
Section 6.2.5.

e Trigger Parameters: includes two distinct triggering methods: (1)
User Triggers, and (2) Power Quality Triggers. See Chapter 7.
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6.2.4 Connecting with the 933A

Two communication ports are available for remotely configuring the 933A,
or for downloading the data to a computer. To link the 933A to a
computer, you will need to: (1) connect the correct cable between the
933A and the computer, and (2) open a connection from the Connection
window.

= Cannection E|

Connect coMs i
Contfiguration Capt
i Hgnz;g;ralun aplure o Fole p—
Coma DataBitSize |5
COM3
% LISB Devices

tions

Paiity [Mone

[EN|ENIE]

Stop Bit Size |1

Cancel

Figure 6.3: Connection Window, RS-232 Selected

RS-232 Port
To open a connection between the 933A and a computer (refer to
Figure 6.3):

1. Connect the included RS-232 cable (phone cord) and adapter (RJ11
to DB-9) between the 933A and the computer.

2. Press DISPLAY > 9 — Config & Status (look under the heading,
COMMUNICATION) on the 933A to verify the communication port
settings (especially Baud Rate).

3. Start PSCSV and click the Open a Connection button in PSCSV, or
choose Connection > Open.

4. Click the plus sign, next to RS-232, to reveal the COM selections,
which refer to the computer serial port. Choose the desired COM
port and check to see if the port settings agree with that on the
933A.

5. Click OK and the Connection Window should show a connection;

nine buttons should also become active on the Broadcast Toolbar.
This shows that there is an RS-232 connection between the 933A
and computer.
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6. At this point, you have access to the instrument for configuring or
downloading data. Go to the appropriate sections to perform these
actions (e.g. see Section 6.3).

USB Port

1. Make sure that the 933 FTDI USB driver is installed on your pc. See
Section 2.3.9 for further information on communicating via USB.

2. Connect the included USB cable between the 933A USB port and
the computer USB port.

3. Start PSCSV and click the Open Connection button or select
Connection > Open, and click on the “4” sign next to RS232.

4. Select the COM port number you set up with the FTDI Driver and
click the OK button below (see Figure 6.3 above).

5. On some older 933A units, you may be able to connect via USB by
selecting the “+” sign next to USB Devices, choosing USB 933 and
clicking the OK button below.

Ethernet

The Model 933A does not have an Ethernet port and does not support
Ethernet, however you may use an Ethernet-to-Serial converter to connect
remotely to the 933A.

6.2.5 Configuring the 933A

Use PSCSV to remotely configure the various features of the Model 933A
and accessory equipment. You can configure most features from front panel
or all features by using PSCSV software.

Configuring Ports

Available settings in the Configure Ports menu include Communication
Port 1 and PMU-1. All of the other items in the Configure Ports menu
are not available. See Figure 6.4.

RS-232, Communication Port 1

Remember to use the USB port if you are going to configure Communica-
tion Port 1 settings. Otherwise, you will most likely lose your connection.
For example, if you connect to Communications Port 1 at 38400 baud and
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change the baud rate, the 933A will not respond. You will have to close
the connection and reconnect at the new baud rate.

The available settings are Baud Rate, Data Bits, Stop Bits and Parity.

D COMB-rs232 Configure Ports

Configure Ports Communication Port 1 I
Communication Part 1 =
Communication Part 2 % Description Vélue. =
Etheret Made
IRIG todem Init String
DNF Baud 115200 =
Modhie Diata Bits 8 ~
C37.118 PMU-1 Pty Bi " E=
C37.118 PMU-2 Sl e =

- C37.11B PMU-2 Stop Bite i =

Protocol | 2

oK Cancel

Figure 6.4: Configure RS—232 Port

PMU-1

When dealing with phasor data, PSCSV is both a configuration and data
acquisition tool. It is designed to configure the 933A to produce C37.118-
type data. This means that while data is very similar to C37.118, the
938A does not have an Ethernet port and is not C37.118 compliant. See
Figure 6.5 to better identify the Phasor Terminology listed below.

Phasor Terminology

Active means that PMU-1 is poised and ready to send data — set to ON
if you want it to be active. Set to OFF if you want it to be inactive (or
unresponsive).

Station (or STN) is the station name, in 16 bytes in ASCII format, given
to the PMU. This field helps to identify the location of the equipment.

ID (or IDCODE) is the 16-bit integer, assigned by the user that uniquely
identifies the device sending and receiving messages (like the 933A).

Header contains additional information on any subject concerning the
PMU, of 64 bytes in ASCII format. Type in the information and press the
Enter key. This field could be used to identify the type of equipment.

Input allows you to select the type of signals you want to include in the
phasor report or broadcast. This includes all phase voltages and currents,

86



D COM5-rs232 Configure Ports .
Confaue Pers

Comrunication Part 1

Communication Part 2 Description Walue
Ethernet C37.118 PMU 1
IRIG Active On i
onP Station dutiter 333 PMU
Modbus D 3
Eg; H: ;mﬁ; Header 933 Portable Power Sen...
C37.118 PMU-2 Input

ABC Yoltage On

ABC Current On

Positive Sequence QFf

MNegative Zero Seque... Off
Digital DSF Trigger QFf

Lelele]a]s

Analog
Wwalts ulij I~
WARs uli} =
WA ulij =]
arf hd
O |~
“window Length in Cycl... 10
Estimated Fate Hz. 20 =l
Cycles Used
Drata Format
Coordinate System
Phasar 32 Bit Float Paint =]
Analog 16 Bit Fixed Point I~
Freq. / Delta Freq. 32 Bit Float Paint [~
Maminal Freq. B0 Hz I~
Adaptive Tuning QFf =l
E stimator Algorithm Faized Cosine |
Digital Channels <Click to edit...>

ok Cancel

Figure 6.5: Configure Phasors, PMU-1

Positive Sequence, Negative Sequence, Zero Sequence components and
Digital DSP Triggers. Turn them ON or OFF.

Analog allows you to select all of the power-related parameters (Watts,
VARs, and VA) that you wish to activate.

Window Length sets the integer number of measurements averaged for
stability; if you choose 1 for example, the values will update more quickly,
however appear less stable; range of window length is from 1 to 24.

Estimated Rate, Hz is the integer number of phasor samples per second.
Equals 25 sps for 50 Hz and 20 sps for 60 Hz.

Cycles Used is a calculated value based on multiplying the Estimated

87



Rate (R) times the number of cycles (or Window Length, W). Cycles
Used = R x W. For example in the screen shot from Figure 6.5, this value
is 20 x 10 = 200. Maximum values for Cycles Used are 1440 for 60 Hz
and 1200 for 50 Hz.

Data Format allows you to set up the computation resolution and speed
of which the 1133A processor can send data

Nominal Frequency is either 50 Hz or 60 Hz, nominal.

Adaptive Tuning is used to help eliminate the possibility of losing the
signal due to filter rolloff effects by continuously adjusting the receiver
center frequency. Adaptive tuning is disabled if the error exceeds the
limit. Set to 2, £5 or +10 Hz.

Estimator Algorithm The 933A offers a wide range of window functions.
All window functions serve the same purpose (as a low-pass filter) and
work in the same manner. The main difference between windows is
the magnitude of the ‘sideband lobes,” which are peaks in the rejec-
tion band. Select a window function (Estimator Algorithm) based on
desired performance. Test algorithm performance using WindowFunc-
tion.exe, the free software tool available on the Arbiter web site. See
http://www.arbiter.com/software/downloads.php

Digital Channels The 933A allows you to select any of the 32 available
User (DSP) trigger records to accompany the regular phasor data. Select
to report in either the normal or triggered state.

6.2.6 Configuring Measurement Parameters

Configure several measurement options by selecting Connection > Config-
ure > Measurement Parameters or by clicking the Measurement Parame-
ters button. You are not able to set “Internal Calibration,” and “Voltage
Linearity” from PSCSV.

DSP Mode

DSP Mode includes setting the system frequency, input configuration,
voltage range, current range, current auto range, and enabling Anticreep
as seen in Figure 6.6.

CTPT Ratios and Constants

CTPT includes setting CT and PT nominal ratios, and twelve points for
magnitude and phase error, and the calibration point for each.
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¥\ COM5-1s232 Configure Measurement Parameters

DSP Mode CTPT | Lozzs Compengation | Anticresp ‘ Internal Calibration | “/oltage Linearity Comection |

Description Walue

Frequency B0 Hz ﬂ
Input Configuration 1Ph 2w 1e j
“oltage Range (- 600 Mazimum j
Current Range 0-20.0 Maimum ﬂ
Current Auto Range Qrf j
Anticreep Qif ﬂ

Cancel Apply

Figure 6.6: Configure Measurement Parameters, DSP Mode

Loss Compensation

Loss Compensation allows you to compensate for the iron and copper losses
(real and imaginary) when connecting through a transformer. Compensate
for transformer loss only through PSCSV, not through 933A front panel.

Anticreep

Anticreep sets a threshold below which the 1133A will not accumulate
energy in the specific registers. This is similar to restricting an older style
(electromechanical) meter from spinning when the energy value was below
a certain threshold. Older electromechanical meters would spin due to the
fact that they were merely energized and energy was not consumed by the
user. Anticreep may only be configured from PSCSV software. First, set
to “ON” in DSP Mode, then set Anticreep.

6.2.7 Other Windows
Save As

When selecting to broadcast any data, it will open with a Save As window.
Since the data that you are broadcasting is ending up on your computer
(monitoring the 933A measurements), it needs a file name. The SaveAs

window provides a default file name. Choose this one, or you can type in
another, and click OK.

Limit File Size

So that the data file does not take unlimited memory on your computer,
the setting allows you to specify how much data you want to collect before
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overwriting previously stored data. At the bottom of the Save As window
is a check box with an associated size in megabytes.

Filter Data Tool

Select View > Filter Data to configure the types of data that will appear in
any of the Broadcast Data screens. Filtering applies to both Summary and
Spreadsheet views but must be selected separately. Filtering only limits
what is being displayed in PSCSV, not what is saved in the file.

M Select ltems rg|
Ayailable in Docurment Currently Viewed
AN PH A A% MAG
B PH 5 B Y MAG
C%PH . FREQ
A1PH A | MAG
BIPH B I MAG
CIPH CIMAG
0% SEQ MAG CY MAG
0 SEQFH
1V 5EQ MAG v

Figure 6.7: Data Filter Tool

One-Second Data

Many of the Broadcast Data items (like voltage, current and frequency)
are averaged values over a one second interval, providing more accurate
measurements. For details on how the 933A computes these values, please
see Appendix A, Functional Description.
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6.3 Broadcast Data

6.3.1 Basic Data

Basic Data includes all of the configured input signals (voltages and
currents - magnitude and phase), sequence components, frequency and
frequency-related quantities, power-related quantities, and flicker. These
values are computed as one-second data and a fresh measurement appears
on the screen each second. Broadcast data can be synchronized to the
GPS or IRIG-B and simultaneously saved in a file of choice.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums and
maximums. Fields include the named parameters, using the Filter Data
tool.

*s; COM5-rs232-Basic Data-.1133B

*21:59:27 UTC 17 seconds *21:59:44 UTC minimum maximum

AV MAG 95.308 »)H/**“\/»Vf”” 98.384 95.201 55.398
B WV MAG 95,171 T T 95,245 95.050  95.266
FREQ 60.003 A £0.003 59.998  6£0.004
MAG .903875 »«H/’h__\/nvf“ .51043 . 908853 .91064
MAG .B5218 T T .B5298 .B5096 . 85321
MAG . 93493 “’"’Aﬁ(‘v/\”ij . 93647 . 93278 . 93688
MAG 97.741 »-""“\V/\f" 97.835 97.525 97.536

:Summarv Spreadsheet,

00 me
< H H H

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates
and one-second, measured parameters as filtered using the Filter Data tool.

%o COM5-rs232 Basic Data-. 11338 |E
UTC Time GPE Local Time A V MAG FLICK...|FLICK... FLICK.*
*11-27-07 21:5 *2007-Now-27 14:59:27 9§.3088368 0.009407 0.012546 0.02Z
*11-27-07 21:5 *2007-Nowv-27 14:59:28 98.301086 0.008974 0.007853 0.020!
*11-27-07 21:5 *2007-Nowv-27 14:59:29 98.319298 0.0061768 0.005328 D.01m
*11-27-07 21:5... *2007-Now-27 14:59:30 958.295410 0.005849 0.005903 0.01z"
*11-27-07 21:5 *2007-Now-27 14:59:31 95.334534 0.023251 0.024692 0.082:
*11-27-07 21:5 *2007-Nowv-27 14:59:32 95.398064 0.012711 0.011405 0.038!
*11-27-07 21:5 *2007-Now-27 14:53:33 95.386414 0.005454 0.004292 0.007:s
< | =
Surmman Spreadsheet,

et —
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6.3.2 Energy Data

Energy Data includes all energy-related qualities, including Watt-hours,
Volt-Amp-hours, VAR-hours and Q-hours These values are computed as
one-second data and a fresh measurement appears on the screen each
second.

To limit the number of items on the screen, use the Filter Data tool, which
allows you to select only the items of interest. Note that filtering does not
limit what is being stored in the data file; it only limits what is being
displayed.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums and
maximums. Fields include the named parameters, using the Filter Data
tool.

¥ COM5-rs232-Energy Data-.11338

*22:25:20 UTC 13 =econds #22:25:39 UTC minimum ma. . .
A WH REC 4.7261e+033 4.7261le+033 4.7261e+033 4
A WH DEL 4.72681=+033 4.7261let033 4.7261e+033 4...
A VAH REC 3.6233=+014 3.6233=+014 3.6233e+014 3...
A VAH DEL 7.2466e+014 7.24660e+014 7.24606e+014 7
TOTAL WH REC 4.72681=+033 4.7261let033 4.7261e+033 4

TOTAL WH DEL 11s5.03 116.39 115.03
TOTAL VARH Q1 o400 17. 444 17.240

TOTAL VAH REC 3.2610e+015 LZ2610e+015 .Z26l0e+015  3...

L
Ly

b Summaué spreadsheet

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates
and one-second, measured parameters as filtered using the Filter Data tool.

*, COM5-rs232-Energy Data-.1133B FEX
UTC Time GES Local Time A WH REC A WH DEL A VAH RE™
*11-27-07 22:25:20 *E007-Nov-27 15:Z... 47261437... 4726143728... 36232807..
*11-27-07 22:25:21 *2007-Nov-27 15:2... 47261437... 4726143728... 36232807..
*11-27-07 22:25:22 *2007-Nov—27 15:2. .. 47261437... 4726143728... 36232807..
*11-27-07 22:25:23 *Z007-Nov-27 15:Z... d47261437... 4726143728... 36232607..
*11-27-07 22:25:24 *2007-Nov-27 15:2... 47261437... 4726143728... 36232807..
*11-27-07 22:25:25 *2007-Nov-27 15:2. .. 47261437... 4726143728... 36232307..
*11-27-07 22:25:26 *2007-Nov—27 15:2... 47261437... 4726143728... 36232807..
:M Am Am mm A Am amAAm o Am A A e e mmansnnnn Ammmm A Z‘:
MN&W Spreiﬂeel
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6.3.3 Harmonic Data

Harmonic Data includes all harmonic voltages and currents, magnitude
and phase, from the fundamental to the fiftieth harmonic; that is 200
values for each phase. These values are computed as one-second data and
a fresh measurement appears on the screen each second.

To limit the number of items on the screen, use the Filter Data tool, which
allows you to select only the items of interest. Note that filtering does not
limit what is being stored in the data file; it only limits what is being
displayed.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums and
maximums. Fields include the named parameters, using the Filter Data
tool.

[ COM5-rs232 Harmonics Data-. 11338

*22:31:03 UTC 10 seconds *22:31:13 UTC minimum maximum

Fundamental A V¥V mag 97.635 U\m 97.467 97.467 97.648
A W 3 mag 6. 6093 F—/\f_\ &. 5097 6.5097 6.6351

AWV 3 ph 39,444 -14.783 -14.783 39.444

A W 5 mag 2.9518 >‘ 3.0585 2.9114 3.0585

A WV 5 ph 133. 62 N_\—\R_\__ 43.095 43.095 133. 62

A W 7 mag 3.9750 "\/’-__\‘*\/. 3.9454 3.9065 4.022%9

AW 7 ph 58.876 N_\\___‘ -&7.420 —-&67.420 58.876
Fundamental A I mag L90374 *‘\//’*\_ .o0z204 .90204 .90386

\ Summanry A Spreadsheet ), Harmonics Bars,

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates
and one-second, measured parameters as filtered using the Filter Data tool.

[ Harmonics Data: & V.

UTC Time GPS Local Time Fundame... Fundamen. .. A WV 3 mag

*11-27-07 22:31:03 *2007-Nov-27 15... 97.635393 56.622761 6.603349 39.444115
*11-27-07 22:31:04 *2007-Nov-27 15... 97.624054 54.368004 6.617058 33.05629%3
*11-27-07 22:31:05 *2007-Nov-27 15... 97.647339 52.132145 6.635110 25.974619
*11-27-07 22:31:06 *2007-Nowv-27 15... 97.49346% 50.078201 6.555853 19.743788
*11-27-07 22:31:07 *2007-Nowv-27 15... 97.585520 47.880238 6.607522 12.497149
*11-27-07 22:31:08 *2007-Nowv-27 15... 97.620361 45.738073 6.602055 6.212630
*11-27-07 22:31:08 *2007-Nov-27 15... 97.648216 43.954540 6.600854 1.56949Dv
i — - O, JE [ S
SSummaEh Spreadsheet Harmonics Bars

Harmonic Bars include vertical bar graphs of the harmonic currents and
voltages including the fundamental.
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6.3.4 Harmonic Summary Data

Harmonic Summary Data includes RMS THD, RMS K, THD F, THD T
and K Factor for all of the configured voltages and currents. All harmonic
summary values are delivered to the open window.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums and
maximums. Fields include the named parameters, using the Filter Data
tool.

[ COM5-rs232-Harmonics Summary Data-. 11338

*22:59:35 UTC 27 seconds *23:00:06 UTC minimum maximum

A ¥ RMS THD 8.5040 W 8.3434 8.2479 8.5040
A ¥ RMS K 108.26 W 107.76 107.40 108.31
A ¥ THD F 8.7152 W 8.5592 8.4687 8.7152
A ¥ THD T 8.6823 W 8.5280 8.4385 8.6823
A V E FACTOR 1.10%4 “\/‘_\4—/""—;‘ 1.1055 1.1027 1.1087
A I RMS THD .0&E853 W .0&754 L0&702 .0&E853
A I RMS K . 54887 W . 84627 . 594358 . 54887
A I THD F 7.5871 W 7.4888 7.4380 7.5871

\ Summary £ Spreadsheet/

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates
and one-second, measured parameters as filtered using the Filter Data tool.

[ COM5-rs232-Harmonics Summary Data-. 11338

UTC. .. GPS Local Time A W RMS THD AV RMS K A V THD F| & V THD T A V K%
*11-... *#2007-Nov-27 1.. §.50328%2 108.255951 §.7151%6 6.66022084 1
*11-... *2007-Nowv-27 1.. §.471642 1068.308601 8.679911 8.647397 1
*11-... *#2007-Nov-27 1.. §.468547 108.273582 8.676705 6. 644227 1
*11-... *2007-Nowv-27 1.. §.45%010 106.174530 8.669496 8.637097 1
*11-... *#2007-Nov-27 1.. §.35775%2 107.812561 g.566052 6.534797 1
*11-... *2007-Nowv-27 1.. 8.34879%6 107.742050 8.557486 8.526322 1
*11-... *#2007-Nov-27 1.. §.342914 107.696541 8.552775 6.521666 1
:11,___ *2007-Hov-27 ‘1 §.33%040 107.736313 8.548260 8.517198 >1‘:
S_Summaii 5 Spreadsheet —
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6.3.5 Waveform Data

Waveform Data includes a number of cycles of all configured phase voltages
and currents. Control the number of complete cycles using the View >
Time Interval window control and choose a time interval value (from 50
ms to 5 seconds). A cursor allows you to pick out instantaneous voltages
or currents.

To control the number of items on the screen, use the Input toolbar, which
allows you to select only the voltage or current of interest. Note that
filtering does not limit what is being stored in the data file; it only limits
what is being displayed.

Waveform Data Screen

Graphical view displays current and voltage waveform data within a small
time interval that is somewhat adjustable. Use the Input Toolbar to select
only the voltage or current of interest.

Waveform samples are at 600 per second or approximately 10 per cycle at
60 Hz.

COM5-rs232-.1133BWave

_2007-Nov-27 23:44:41.375000*% UTC
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6.3.6 Phasor Data

Phasor Data includes all configured phase voltages and currents, frequency
and sequence values. Data log times are also indicated in the display.

To control the number of items on the screen, use the Input toolbar, which
allows you to select the voltage(s) or current(s) of interest. Note that
filtering does not limit what is being stored in the data file; it only limits
what is being displayed.

Displays

Two phasor views include a phasor with tabular data view and a frequency
plot view. In the phasor data view, you can select to display the desired
phase voltages or currents, and expand to view some tabular data.

& COMB-rs232-PMU-1-933-PSCSY Broadcast C37-118 Phasor.9338-C37-118

EMU-1 Arbiter 933 PMU
BC Lozal 12-05-11 11:30:10. 400000 105 20 75
Freq. (Hz) 59.999
[ - Input Magnitude  Phase (deg)]
ThoA W 94.724 0.o0o0
Ch a1 0.933 348,718
Ch B WV 90.456 244.698
Th B I 0.829 236.158
Ch T v 97.732 124, 447
Ch oI 0.937 117.864
‘ + Sequences Magnitudse Phaae(deg)l
Phasors A Frequency Flo,

& COMB-rs232-PMU-1-933-PSCSV Broadcast C37-118 Phasor. 9338-C37-118

933 Portable Power Sentinel Arbiter Systems, Inc. (805) 237-3831
60.012
59.996
59.980
15:47:36.750 Gps* 30 seconds 15:48:06.700 Gps~
59.980 min:59.9380 max: 60.012 53.934
Phasorsh Frequency Plot
— —

For tabular phasor data, use the CSV button, or select File > Export
CSV. The SaveAs window will appear and will prompt you to open the
data in your spreadsheet application.
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6.3.7 Lists of Broadcast Values

Data values available when selecting Basic Data from the Broadcast
Toolbar are listed below.

Basic Data — 55 Values
1. A, B and C phase voltages and currents — magnitude and phase
angle
2. Positive, Negative and Zero Sequence Voltages and Currents —
magnitude and phase angle.
3. Active Power (Watts) for A, B, C phases and Total.
4. Apparent Power (VA) for A, B, C phases and Total.
5. Reactive Power (VAR) for A, B, C phases and Total.
6. Power Factor (PF) for A, B, C phases and Total.
7. Q for A, B, C phases and Total.
8. System Frequency (Hz)
9. System Frequency Deviation
10. System Frequency Rate (df/dt)
11. System Time Deviation, Seconds
12. System Time Deviation, Cycles

Energy Data — 40 Values
1. Watt-Hours, Delivered and Received: A, B, C phases and Total
2. VAR-Hours, Q1 — Q4, A, B, C phases and Total
3. VA-Hours, Delivered and Received: A, B, C phases and Total.
4. Q-Hours, Delivered and Received: A, B, C phases and Total.

Harmonics, Fundamental to the 50th — 600 Values

1. Voltage: A, B and C phases — magnitude and phase angle.
2. Current: A, B and C phases — magnitude and phase angle.

Harmonic Summary — 30 Values
Includes RMS THD, RMS K, THD F, THD T and K-Factor for each
voltage and current phase.

Waveform Data — 6 Values
Includes 3 phases for voltage and current.

Phasor Data — 6 Values
Includes 3 phases for voltage and current.
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6.4 Data Conversions

6.4.1 Exporting COMTRADE Files

These instructions cover exporting COMTRADE files generated from
waveform data captured by the Model 933A. During the exportation
process, two COMTRADE files, a .dat and a .cfg file, are generated from
waveform file and saved on the host pc.

Running PSCSV 933 Software, the opened waveform data is converted
directly into these two files. The method used to capture waveform data
in these instructions is by setting a voltage trigger to create a waveform
record. The Model 933A automatically creates a waveform record when a
configured 933A trigger becomes active (when the required event occurs).
The specific trigger configured in these instructions initiates recording
when the phase voltage exceeds a limit, and the 933A begins recording
data to flash memory. This waveform record is then downloaded to the
host pc. Once stored on the pc, the record is easily converted into two
COMTRADE files. Without a captured waveform file there will be no
information to convert to COMTRADE.

Basic Steps Required
1. Set up triggers in the 933A (using front panel or PSCSV).*

2. Connect signal wires.*

3. Erase previous logged data.

4. Instigate or wait for an event.

5. Download the event and waveform data (separately).

6. Export COMTRADE Files.

*Note: Order of these steps may be changed according to type of testing
performed. For complete instructions on triggers, see Chapter 7.

Power Sentinel CSV Software version 1.129, dated April 2010, was used in
creating these instructions.
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6.4.2 Exporting to CSV Format

While you are reviewing any data downloaded from the 933A, you may
choose to convert it to CSV format and review it on your spreadsheet.

In the session below, Per Second data is viewed after being downloaded.
Notice that there should be a CSV button, also accessible by selecting File
> Export CSV.

When you select either, a Save As window should appear with a suggested
file name. Either click the OK button or type in a new file name and click
OK.

A00000102-PSCSV 933 One Second Log-2007-10-24. 93305

-123.51 .00672  155.47 . 00746 -22.562 .oo027

Figure 6.8: Downloaded One-Second Data

A second window should appear and ask if you want to open your
spreadsheet application with the data loaded. You can choose either Yes
or No. If you select Yes, then the data converted to CSV format should
appear in the spreadsheet (see Figure 6.9).

A B € D E F G H 1 J =i
1 [UTC Time IGPS Local Time AWHREC AWHDEL AWAHREC AVWAHDEL TOTALYWWH REC TOTALWH DEL =
2 *11-26-07 7*2007-Now-26 12.21:15 | 472614E+33 472614E+33 3.62328E+14 7 24B56E+14 2517E+26  AT2B14E+33
3 [*11-26-07 "2007-Now26 12:21:16 | 4.72614E+33 4.72614E+33 3.62328E+14 7.24656E+14 2817E+26  4726514E+33
4 [*11-25.07 72007-Now26 12:21:17 | 4.72614E+33 4.72614E+33 3.62328E+14 7.24656E+14 2817E+26  4726514E+33
5§ "11-26-07 "2007-Mow-26 12:21:18 | 4.72614E+33 4.72614E+33 3.62320E+14 7.24656E+14 2817E+26  AT72614E+33
B *11-26-07 *2007-Now-26 12:21:20 | 4 72614E+33 472614E+33 3.62328E+14 7 24B56E+14 2517E+26  AT2B14E+33
7 ["11-26-07 "2007-Now26 12:2121 | 4.72614E+33 4.72614E+33 3.62328E+14 7.24656E+14 2817E+26  4726514E+33
8 [*11-25-07 "2007-Now25 12:2122 | 4.72614E+33 4.72614E+33 3.62328E+14 7.24656E+14 2817E+26  4726514E+33
9 "11-26-07 72007 -Mow-26 12:21:23 | 4.72614E+33 4.72614E+33 3.62320E+14 7.24656E+14 2817E+26  AT72614E+33
10 *11-26-07 7*2007-Nov-26 12:2125 | 4.72614E+33 4.72614E+33 3 B2328E+14 7 24B66E+14 2517E+26  AT2B14E+33
11 *11-26-07 7"2007-Now-26 12:2126 | 4.72614E+33 4.72614E+33 3.62328E+14 7.24656E+14 2817E+26  4726514E+33
12 *11-26-07 72007-Now-26 12:2127 | 4.72614E+33 4.72614E+33 3.62328E+14 7.24656E+14 2817E+26 472614E+33
13
14 «[» [ M)\ Energy Data / |«| s [ |
Ready

Figure 6.9: Converted Data to Excel Format

Note that the “Export CSV” feature works on any data that has been
downloaded or is being broadcast from the 933A. Any data broadcast
after you save the converted data will not appear in the file. If you want
to include any later data in the same file, simply go through the Export
CSV procedure again.
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6.4.3 Exporting to PQDIF Format

While you are reviewing any data downloaded from the 933A, you may
choose to convert it to PQDIF format.

In the session below, Figure 6.10 illustrates Per Second data being viewed
after being downloaded. Export the selected data by selecting File >
Export PQDIF.

A Save As window should appear with a suggested file name. Either click
the OK button or type in a new file name and click OK.

A0D000102-PSCSV 933 One Second Log-2007-10-24. 9330S
Date / Time AV MAG AV PH B V MAG| B V PH C V MAG C V PH| A T MAG A I PH B I MAG

.00644 -123.51 .00672  155.47 . . 112.20

Figure 6.10: Downloaded One—-Second Data

Note that the “Export PQDIF” feature works on any broadcast data
(except waveform or phasor) that has been downloaded or was broadcast
from the 933A. Any data that was broadcast after you saved the converted
data will not appear in the file. If you want to include any later data in
the same file, simply go through the export CSV procedure again.

6.4.4 Save As Snapshot

Save As Snapshot creates a separate data file of all of the data recorded
during a normal broadcast session up to the time that you create the
snapshot file. Broadcast data will continue to fill the original broadcast
data file. If you decide to create a later snapshot, the file will have all of
the original data but with added data records determined by the interval
number of seconds between the two snapshots created.
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Chapter 7

Triggers and Event
Recording

7.1 Introduction

Triggering is very useful for testing and troubleshooting electrical power
systems. During the occurrence of an electrical event, the 933A can begin
recording essential data for analysis. In this section we will look at how
the Model 933A uses triggers to record data, and how to configure these
triggers from both the 933A front panel and from PSCSV. For reviewing
triggered events and logged data, see Chapter 5, Reviewing 933A Data.

7.1.1 Recording Data to 933A Flash Memory

When an event occurs the 933A will store a record of the event and begin
recording all of the available electrical parameters into flash memory. The
total number of records is based on the time interval configured under the
LOGGING TIME screen, including in fault and post fault. Fault recording
always includes at least one-half second of prefault data.

Data Recording Methods in the 933A

e pressing the LOG key

e using the Autolog feature

e configuring User Triggers

e configuring Power Quality Triggers
e using the External I/O Module
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7.1.2 User Triggers

User triggers are general purpose in nature (compared to power quality
triggers) and allow more flexibility. When active, a trigger signals the
Model 933A to record data based on measured parameters, which are then
processed by the Model 933A DSP. There are a total of 32 different triggers
available that you can assign as either a User or Power Quality trigger.

7.1.3 Power Quality Triggers

Power quality triggers are set up in a manner very similar to User triggers,
however they conform specifically to IEC 61000-4-30, Section 5.4, Supply
Voltage Dips and Swells.

7.2 Setting a User Trigger

Follow the procedure in this section to configure a user trigger from the
front panel. Remember that whenever you select a user trigger number,
it is removed from the pool of 32 available triggers until turned off or
reconfigured.

7.2.1 New Trigger

1. From any screen, press the SETUP key, then select 7- Trigger Setup
from the number keypad. You should see a screen similar to that
shown in Figure 7.1.

TRIGGER SETUP
TRIGGER #
SELECT MODE OFF
CURRENT MODE: OFF

Figure 7.1: Initial Trigger
Setup

3 ARROW kews to cwcle throush selections
T4 ARROW kews mowve selection cursor
= L RELAY EVENT
SETTIMGS | SETTIMGS

2. Using the left/right cursor keys, choose a Trigger number (1 —
32); using the up/down cursor keys move the cursor to SELECT
MODE, then use the left/right cursor keys to choose USER. Press
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the ENTER key to open a screen entitled EDIT User TRIGGER. (by

number).

Figure 7.2: Selecting a
User Trigger Mode

TRIGGER SETUP
TRIGGER #

1
SELECT MODE USER
CURRENT MODE: OFF

3 ARROW kews to cwcle throush selections
1 RARROW kews moue selection cursor

_RELAY I _ EVENT _
SETTINGS | SETTIMGS

3. Choose the triggering parameters in this screen. Use a combination
of the cursor keys, enter and numeric keys to enter the data.
Normally, you will not need to press the Enter key each time you
select a new field — use the up or down arrow to move between fields.

Definitions for the User Trigger values are found in Section 7.2.5.

Figure 7.3: Selecting
User Trigger Values

EDIT USER TRIGGER 1
InPut Sis.

Channel A
Limit Ftn. x>limit
Limit 94.50
Reference 95.088
Dependency off
MasterTris -
Dwell Time % 195]%]
Wrt To Los On
A e e e

LOGGING
TIME
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7.2.2 Logging Time

4. Press the LOGGING TIME soft key to define the time period to
log data when a trigger becomes active. There are two values to
set: MaxLogTime and PostFault (time). MaxLogTime defines the
number of seconds to record data during which the specific trigger is
active (i.e. faulted). PostFault time defines the number of seconds
that the 933A records data after the trigger becomes inactive (i.e.
after the fault has disappeared).

Figure 7.4: Configuring
Data Logging Times

TRIGGER 1 LOG TIME SETUP

MaxLoaTime NEHIIEEEEEEEEE
PostFault 2

T4 ARROW kews mowve selection cursor

CLEAR
ALL

5. Press the BACK soft key to return to the previous (Edit User

Trigger) screen.

7.2.3 Back Soft key

6. Press the BACK soft key to return to the trigger summary screen
and view any of the trigger settings by trigger number.

Figure 7.5: User Trigger
View

TRIGGER SETUP
TRIGGER #

1

SELECT MODE USER
CURRENT MODE: USER

InFut Sia.:  Uoltase

Channel A

Limit Ftn.: s limit

Limit @ 94,50

Reference : 33.08

Derendenca:  OFfF

MasterTris: —-

Dwell Time: ©.08

Wrt To Los:  On

Max Loz Time: 2
Post Fault: 2

3 gERUM kews to cucle throush selections
r
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7.2.4 SAVE SETTINGS Soft Key

7. Press the SAVE SETTINGS soft key to store any trigger changes.
You may do this after setting up a number of triggers. Without
pressing the Save Settings key, you will lose any configuration settings
that you just made. It is always possible to return to TRIGGER
SETUP to configure additional triggers as needed.

Dependency and Master Triggers

For more complicated triggering, where you would like to capture an event
that depends on the occurrence of another event, use the Dependency
option. For example, suppose that you wish to see the how frequency
deviation is related to voltage sags. You could set up a frequency trigger
that looks for a frequency deviation outside of a specified range. However,
before you will allow the trigger, you must set up the dependency to
another trigger that watches for a voltage sag. In this example, the voltage
trigger would be called the Master, and the frequency trigger would be the
dependent trigger.

Master triggers are subdivided into two groups: ActiveMaster and
InactiveMaster. For Active Master, a dependent trigger could become
active only after the master trigger became active. Conversely, for Inactive
Master, a dependent trigger could become active when the Master trigger
became inactive.

Dependency may also be set up in PSCSV software. See Section 7.6.

7.2.5 User Trigger Parameter Definitions

Input Signal: Voltage, Current, Watts, VARS, VA, Power Factor (PF),
Seq V Comp, Seq I Comp, Ph Bal Ratio, Freq & Time, THD Voltage,
THD Current, Harmonic Vrms, Harmonic Irms, K-Factor V, K-Factor I,
Flicker, Inst V, Flicker, Pst V, Flicker Inst I, Flicker, Pst I, Reserved(0 —
4), SchulzLaiosCh(1 — 6)

Channel: Select the phase of input signal, noted as A, C, B and Ave.

Limit Ftn.: (Limit Function) These are the logical conditions used to
compare the Input Signal to the Limit; x > limit, x < limit, |x| > limit,
|z — ref| > limit, where x is the measured signal.

Limit: a numerical value (floating point) to which x (the input signal) is
compared.
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Reference: Sets a numerical value (floating point) used with the Limit
Type |z — ref| > limit for the value of ‘ref’. Can be used in a window
comparison. For example, use |z — ref| to determine the frequency

deviation, 6f. 6f = |x — ref| = |59.995 — 60| = 0.005H z.

Dependency: Sets the condition of the Master Trigger as Off, Active-
Master, InactiveMaster; “Off” turns off the Master Trigger feature; use
the other two values to set up this trigger as a Master Trigger.

Master Trig: (Master Trigger) Assigns the specific Trigger number (1 —
32) as the Master Trigger, and upon which the current trigger is dependent.
Set the Master Trigger prior to the dependent trigger for it to be available.

Wrt to Log: (Write to Log) Defines a period in seconds during which the
triggering condition is true before it switches to Active. If set to zero, the
triggering response time is immediate.

TriggerLog: ON or OFF; OFF means that when a trigger occurs, no event
data will be recorded, but one-second data will be recorded, ON means
that when a trigger occurs, an event record and data will be recorded.

MaxLogTime: MaxLogTime defines the amount of time in seconds that
the 933A will record data while the triggering condition is true (i.e. the
specific trigger is Active) — counts from 0 to 65535.

PostFault: Defines the amount of time in seconds that the 933A will log
data after the triggering condition has disappeared (i.e. the specific trigger
is Inactive) — counts from 0 to 65535.

7.3 Setting a Power Quality Trigger
Follow the procedure in this section to configure a power quality trigger.

The set of 32 available triggers are shared between User triggers and power
quality triggers.
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7.3.1 Setting Up a New Trigger

1. From any screen, press the SETUP key, then select 7- Trigger Setup
from the number keypad. You should see a screen similar to that in
Figure 7.6, depending on whether the trigger is already configured,
or OFF. Using the left/right cursor keys, choose a Trigger number.

TRIGGER SETUP
TRIGGER # 2

SELECT MODE PWR QUAL
CURRENT MODE: OFF

Figure 7.6: Power Quality
Trigger Selection

EVENT

SETTINGS | SET

2. Using the up/down cursor keys move the cursor to SELECT MODE,
then use the left /right cursor keys to choose PWR, QUAL and press
the Enter key. You should see a screen entitled EDIT PQ TRIGGER
(by number) as in Figure 7.7.

EDIT PQ TRIGGER 2
Channel

Limit Ftn. x<limit
Limit 94,50
Limit Mode Absolute
Ref. Mode Absolute
Figure 7.7: Selecting PQ Husteresis 0.85
. Hust. Mode Absolute
Parameters MultiPhase off
Dwella-z cvoess 2]

3 ARROW kews to cwcle throush selections
T4 ARROW kews mowve selection cursor

LOGGEING
TIME

3. This is the screen in which you configure most of your power quality
settings. After you are finished with all of the settings in this screen,
press the LOGGING TIME soft key to set the how long you want the
933A to log one-second data. See power quality parameter definitions
in Section 7.3.2.
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Edit PQ Trigger (#) — Category Screen

Choose a value for each category where applicable. Generally, you can
select each category using the up/down cursor keys and select a value
in that category using the left/right cursor keys. Numerical values (e.g.
Limit) are entered directly from the numeric keypad.

7.3.2 Power Quality Trigger Parameter Definitions

Channel: AV, Al, CV, CI, BV, BI, NI - includes all of the input voltages
and currents, including neutral. Set the Channel value to the input signal
you want to compare to the Limit.

Limit Ftn.: (Limit Function) « > Limit, < Limit; the first indicates a
measured value greater than the limit, and the second indicates a measured
value less than the limit.

Limit: Floating point value; constantly being compared to the input
Channel value (x) in order to capture an event trigger. For example,
Limit = 130 and & > Limit would mean that a trigger would occur if the
measured input voltage became greater than 130 Vrms (i.e. z > 130).

Limit Mode: Absolute or Percent; choose the limit mode that suits your
application. For Absolute, the limit is the same number as the value
entered in for Limit. For example, a Limit of 130 could generate an event
trigger if the voltage swings above 130 Volts. For Percent, the measured
value is compared to a percentage of the measured signal. Ten percent
above nominal would be entered as 1.1.

Ref. Mode: (Reference Mode) choose either Absolute or Sliding.
Absolute means that the reference value is fixed and compared directly.
Sliding means that Reference value is not fixed (or absolute) and can
change slowly, such as with a gradually rising or dropping voltage. See
page 111.

Hysteresis: a floating point value; reduces extraneous records from
accumulating when a measured value wavers around a limit or reference.

Hyst. Mode: (Hysteresis Mode) Absolute or Percent; absolute refers
to a fixed value for hysteresis, and percent refers to a percentage of the
measured value. As the measured value increases or decreases, so the
hysteresis will change according to the given percentage of hysteresis.

Multiphase: B, C, BC or OFF; means that the trigger parameters can
also apply to B phase, C phase or both B and C phase, without defining
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another trigger.

Dwell (half cycles): Dwell, an integer, refers to the time in half cycles
(at the nominal frequency) for the triggering condition to be true before
which the trigger will become active.

Hysteresis

Hysteresis allows the user to set up some triggering conditions to reduce the
tendency of a wavering signal (e.g. voltage) from generating unnecessary
triggers. Figure 7.8 illustrates a voltage wavering around 130 Vrms, which
is the set Limit for a trigger. To avoid unwanted triggers occurring at
points A, B, C and D, a hysteresis value of 2 was chosen. This prevents a
trigger from occurring unless the voltage drops at least 2 volts below the
Trigger Limit. For the trigger to again become Active (i.e. after point E),
Va would need to again cross the 130-Vrms Limit.

130 — l
128 /

126

124

RMS Volts
Igyd
J

100 200 300 400 500 600 700
Time in Seconds

Figure 7.8: Example of Hysteresis

Power Quality Reference

For power quality triggers, install the Power Quality Reference values
by pressing the PWR QUAL REFERENCE soft key seen in Figure 7.9.
Figure 7.10 shows the power quality reference configuration screen. Use
this to set the reference values. In this case, Reference refers to an initial,
nominal voltage/current value, which is preloaded into the register for
Sliding Reference voltages.

Press SETUP > 7 — Trigger Setup > Pwr Qual Reference soft key as seen
in Figure 7.6. Install the values for any required reference. Press BACK
to return to the Trigger menu. Remember to press the SAVE SETTINGS
soft key to retain any changes to these settings.
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TRIGGER SETUP
TRIGGER # 1
SELECT MODE USER
CURRENT MODE: USER

InFut Sis.: Uoltase

Charnnel
Limit Ftn.: =*limit
Limit P 94.50

Reference @ 95.88
Derendencw:  OFF
MasterTris: -—
Cwell Time: @.80
Wkt To Los:  On

Max Loa Time: 2
Fost Fault: 2

€= ARROW kews to cocle throwsh selections
T4 ARROW kews move selection cursor

FPUR GILAL EUEHT

3 RELAY SHUE
REFEREMCE | SETTINGS | SETTIMGS | SETTIHMGS

Figure 7.9: Power Quality Reference Selection Softkey

REFERENCE INPUT UALUES
Input AV EECA I

" AI B.80
" cu 90.00
" CI B.80
" BU S0.00
" BI B.80
" NI 8.00

T4 ARROW kews move selection cursor

Figure 7.10: Configuring the Power Quality Reference
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Sliding Reference

Set the Reference Format to Sliding when you want to follow daily
variations in voltage or current that do not require a trigger unless it
exceeds the expected rate of change. For example, if due to usage
requirements the line voltage sags during the day and swells during the
night, you might want to use a sliding reference to avoid unnecessary
triggers. A sliding reference would generate a trigger only if the voltage
unexpectedly sags or swells at a rate greater than expected.

Calculating a Sliding Reference Voltage

Per the specification IEC61000-4-30, the sliding reference voltage is
calculated by using equation 7.1; it is of first-order and uses a one-minute
time constant.

(71) Usr(n) = 0.9967 x Usr(n—l) + 0.0033 x U(lo/lg)rms

Where
Usr(n) is the present value of the sliding reference voltage;
Usr(n—1) is the previous value of the sliding reference voltage; and
U(10/12) is the most recent 10/12-cycle r.m.s. value.

Note that even though the specification defines the input signal (U) as a
voltage, it has been applied in the 933A to include measured input currents,
as calculated using the same formula, with U as a current.

Logging Time

There are two available settings of which you can choose to control how the
933A logs one-second data when a trigger becomes active: MaxLogTime,
and PostFault.

MaxLogTime: defines the number of seconds to record data during which
the specific trigger is active (i.e. faulted). Setting MaxLogTime to 10
seconds will cause the 933A to record 10, once-per-second records after a
trigger becomes active.

PostFault: defines the number of seconds that the 933A records data
after the trigger becomes inactive (i.e. after the fault has disappeared).
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Remember that if you have several triggers armed, any of them may be
responsible for the 933A logging data if they become active.

7.4 Event Waveform Capture

7.4.1 Capture Method and Features

The Model 933A samples each of the six measurement channels at 10,240
samples per second at 16 bit resolution, and begins sampling when
triggered from a specified event. Event recording always begins with one-
half second of prefault data, so that you will always capture conditions in
the 25 or 30 cycles of waveform data preceding the fault.

To capture this data the 933A has 128 MB of flash memory that is devoted
entirely to waveform storage, and should be able to store sufficient data
to analyze all channels. Thus, depending on the application, the 933A is
able to capture inrush currents, sags and swells, transients and many other
non-periodic phenomena.

7.4.2 High Speed Waveform Capture

The 933A begins recording data (including high-speed waveform) whenever
a specified event trigger occurs. To assure that you capture the waveform
anomalies you want, make sure to carefully configure the triggering
conditions in the 933A.
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Figure 7.11: Reviewing Captured Waveforms

When a specified event happens, the 933A will begin recording data in both
flash modules for the time specified in LOGGING TIME setup screen.
There are two items to configure in this screen: (1) Maximum Logging
Time, and (2) Post Fault Time.
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7.4.3 How Much Data do I Record?

It takes about 18 minutes to fill up 128 MB of waveform flash with the
six input channels - three voltages and three currents. Decide how much
waveform data you really need to record following an event. A few seconds
of data is should be ample for each record, however the 128 MB allows for
additional event recordings, providing the postfault data is kept short. For
example, if each record includes one half second of prefault data and one
second of post fault data (90 cycles), the 933A could provide approximately
720 fault records.

When selecting one of the event records by number, use the numeric keypad
or enter key. The 933A will immediately open the waveform view at the
time of the event and allow you to scroll forward and backward with the
cursor keys to inspect the waveform. Use the right and left cursor keys to
locate and examine specific points on the waveforms. Instantaneous values
are computed where the cursor and the waveforms intersect and tabulated
at the bottom of the screen.

Press the COMPRESS WAVEFORMS or EXPAND WAVEFORMS soft
keys to view more or less of the captured event waveforms.

7.4.4 Event Capture Example

The waveform screen shown in Figure 7.12 is an example of an event caught
through setting a power quality trigger on C-phase voltage. The voltage
limit was set for 85 Volts rms, and trigger with < Limit. The 933A also
caught a one-half second of the prefault waveform data, which is about 30
cycles.

Figure 7.12: Captured

Event Waveform C ﬂw

e 46243, Foo8 146.6 U —FZ.0 W -4.1 U
2 ec 20l H H H

SELECT
WALEFORMS

By using the Expand or Compress soft keys and the right and left cursor
keys you can review specific points of the event chronologically.
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Note: The 933A records complete sets of one-second data around the
occurrence of the event, depending on the set Logging Times. The 933A
stores the main data records in the standard flash module, and stores high-
speed waveform in another 128 MB flash module used exclusively for that
purpose.

Viewing One—Second Log Data

1. Press REVIEW > SHOW LOG (soft key) to view a complete list of
one-second log data. See Figure 7.13.

2. Press the REVIEW SELECTIONS soft key to separate all of the one-
second log data into groups, and press the SHOW EVENT LOGS
soft key

3. Look through the one-second data to find the time of occurrence of
the event and press any of the number keys to select a data point.

PHASE C RESULTS
79.9553 Uolts 48.2138 U
-126.38 Udeg -12.8331 UAR

0.8728 AmPs 49.6919 UA
43.74 Ades 8.9782 PF

Figure 7.13: Captured -178.94 Des* 59.9989 Hz
One—Second Record

Deg =" Phase-I Phaze

4. Press any of the number keys to select the data type for viewing (e.g.
0-Tabular Results).

5. Press any of the soft key selections to choose to view any configured
phase, or to view Min/Max information.

Erasing Captured Waveform Data

To erase any records stored in flash, press the REVIEW key, followed by
the ERASE LOG soft key. You will be asked if you really want to erase
all of the stored data in the flash memory modules. Select either the NO
or YES soft key to proceed. No partial data erasures are possible.
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7.5 Auxiliary I/O Module

Triggering with the Auxiliary I/O Module is very straightforward and is
easy to set up. See Page 11 for accessory information.

7.5.1 Auxiliary I/O Module Description

The Auxiliary I/O Module has three contact outputs and four event inputs.
One of the output contacts is a solid state set (KYZ-rated) and the other
two are standard Form C mechanical contacts. The Event Inputs are
separated into three groups: one set rated at between 24 to 240 Vdc, one
set rated at TTL-level voltages (5 Vdc), and two sets are contact closure.
Signals are connected to the module with ring terminals and connection
to the Model 933A is by a nine-foot cable assembly.

The Auxiliary I/O Module is powered from the Model 933A and must be
installed with the Model 933A powered OFF.

7.5.2 Configuring Event Inputs

1. Open the Auxiliary I/O connector cover on the 933A and slide in
the plug on the end of the cable into the connector until it snaps in
position.

2. Power on the 933A.
3. Press the SETUP key > 7 — Trigger Setup.

4. Press the EVENT SETTINGS soft key and choose the Event Input
number with the right/left cursor keys.

5. Select the Mode (depends on the Event Input number), Max Logging
Time (MaxLogTime) and Post Fault Time (PostFault).

6. Press the BACK soft key, and remember to Save Settings.

Terminology

In the Event Input Setup Window of the 933A are several terms: EventIn-
put, Mode, MaxLogTime and PostFault.

EventInputs: 1 — 4
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EVENT INPUT SETUP

EventInrPut
Mode Active Close
MaxLogTime
PostFault 1
Figure 7.14: Event Input
Setup, Active EUVENT INPUT STRATE: B

3 ARROW kews to cucle throush selections
T4 ARROW kews move selection cursor

Mode: configures which input state triggers the 933A to begin recording;
for voltage inputs: Active Hi or Active Lo; for contact inputs: Active Close
or Active Open.

MaxLogTime: time the 933A will log data while the triggering conditions
are active (i.e. that the triggering conditions are true).

PostFault: time the 933A will log data after the triggering conditions are
inactive (i.e. that the triggering conditions are no longer true).

Checking the Event Inputs

To verify the event inputs, you can apply a correct voltage to event inputs
1 or 2, or use a short length of wire to short across the contacts of event
inputs 3 or 4.

1. Press the SETUP key and 7 — Trigger Setup.

2. Press the Event Settings soft key to view the event screen (see
Figure 7.15).

3. Connect the triggering signal to the desired event connection.

4. Watch the value in the line that states “EVENT INPUT STATE”
change from 0 to 1 when the event occurs.

5. You can also watch the events stack up by pressing the Review key

> Show Log. For each new event, you will see a number of records
recorded based on the specified logging time.
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EVENT INPUT SETUP

EventInrPut
Mode Active Close
MaxLogTime 1
PostFault 1
Figure 7.15: Event Input
Setup’ Inactive EVENT INPUT STATE: 1

3 ARROW kews to cucle throush selections
T4 ARROW kews move selection cursor

7.5.3 Configuring Relays

The Auxiliary I/O Module has three relays; one solid state (KYZ) and two
mechanical, Form C contacts. Relays 2 and 3 are useful for signaling by
change of state from any one of 32 triggers.

RELAY SETUP
RELAY 1 (KYZ):

CHRN
TYPE WH DEL
SCALE 1. 0080
RELRY 2:
Figure 7.16: Relay Setup REL551§= 2
TRIG 1

s to cucle throush selections

&3 ARROW keus
T4 AEROW keus move selection cursor

Relay 1, KYZ-Rated Contacts

Relay 1 is a set of solid state contacts useful for keeping track of energy
using the KYZ method. To set up these contacts, refer to Figure 7.16.

1. Select SETUP (key) > 7 - Trigger Setup > RELAY SETTINGS (soft
key).

2. Specify the channel (A, B, C or Total), the type of signal (e.g. Watt-
hour), and the scale (see below under Kp Register Scale Factor).

Kp Register Scale Factors

Correct scaling is necessary for accurate KYZ pulse metering. Enter in
the value using the numerical keys on the front of the Model 933A keypad.
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Scale factors are expressed in basic units (e.g. Watt Hours per Pulse)
and should be set up not to exceed 20 pulses per second, the limit of the
933A. To arrive at the minimum scale factor value so not to exceed this
threshold, take the maximum value of the basic unit being measured and
divide by 72,000. This should give you the absolute limit (minimum value)
for a scale factor.

For example, if the maximum input value (including CT-PT ratios) is 240
kWh, then the minimum scale factor for Watt Hours should be greater
than 3.3333333 (240,000 = 72,000 = 3.333...). The value produced is the
Scale Factor (e.g. 3.3333 Wh per pulse). Scale Factors will be directly
proportional to the value measured. Therefore, the greater the measured
value, the greater will be the minimum Scale Factor.

Over-Range Condition: An over range input condition will exceed the
20/second output capability of the 933A, causing KYZ pulses to stabilize
at that rate. If this is the case, for momentary periods, the accumulator
in the 933A will store these counts not degrade the Model 933A accuracy.
If data has accumulated in the 933A, then when the signal has dropped
below 100% (by Scale Factor) the output will put out the additional pulses
until the accumulated overage equals zero.

Relays 2 and 3, Mechanical Contacts

Relays 2 and 3 are two separate mechanical contact sets and each have a
limited lifetime of about 100,000 cycles. Contacts are designed to change
state based on the configured Trigger for each relay. For example, Relay
2, in the Figure 7.16, is set to trigger based on the state of Trigger 2.
When the trigger limit condition is exceeded, then the trigger is considered
Active and the relay will change state. When Trigger 2 changes back to
the previous state, then the relay will revert to its previous state. Relay 3
is identical to Relay 2 and can be set up in the same manner as Relay 2.

As seen in Figure 7.17, Trigger 2 is responsible for activating Relay 2 when
A-phase voltage drops below 85.0 Vrms. Notice that a hysteresis value of
2.00 was used to reduce the chatter from a signal on the measured channel
fluctuating above and below the limit value.
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7.5.4 General Relay Setup Procedure

1. Set up the Trigger (either User or Power Quality ) on the 933A or
by using PSCSV software.
2. Set up the desired relay by specifying the trigger in step 1, as seen
in the RELAY SETUP screen in Figure 7.16.
TRIGGER SETUP
TRIGGER # 2
SELECT MODE PWR QUAL
CURRENT MODE: PWR QUAL
Lot Fens  olinit
Limit i 94,58
. Limit Mode: Absolute
Figure 7.17: Relay- barterocizt oo
Trigger Reference Hlbirheees orr

Duwell : A

Max Loa Time: 5

Fost Fault: 2

3 ARROW kews to cwcle throush selections
T4 ARROW kews mowve selection cursor

PUR QUAL REI EVENT
= ML G5 | SETTIMGS

7.6 Configuring Triggers with PSCSV

Use PSCSV for the 933 to configure both User and Power Quality Triggers.
Configure both user and power quality triggers from the same location:
Configure Trigger Parameters.

1.

Open a connection between the Model 933A and your computer. For
RS-232 and USB connections see Section 6.2.4.

. Open the window by clicking the Configure Trigger Parameters but-

ton, or by selecting Connection > Configure > Trigger Parameters.

Once the Configure Triggers window is open, in the left panel select
the type of trigger you want to use, either User or Power Quality.

There are 32 possible triggers you can set. For each one you intend
to use, selecting any item that best defines what you are measuring.

See Sections 7.2.5 (User Triggers) and 7.3.2 (Power Quality Triggers)
for definitions of the various parameters in the user triggers and
power quality triggers configuration panel.
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7.6.
1.

g COM10-1s232 Configure Trigger Parameters X

1 User Triggers

Select “Users Triggers” in the left panel of the Configure Trigger
Parameters window.

Select an unused trigger (by number) by choosing the drop-down
arrow under the column named “Input Signal” and adjacent to the
desired trigger.

Begin choosing and filling in parameter values. Note that not all
parameter fields are required (e.g. Reference & Dependency). See
Section 7.2.5 for details on each parameter selection.

. Indented from User Triggers are Schulz-Laios settings. See Sec-

tion 9.26 for more detail on Schulz-Laios filters.
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Figure 7.18: User Trigger Setup using PSCSV

120



7.6.2 Power Quality Triggers

1. Click the Power Quality Triggers label in the left panel of the
Configure Triggers window.

2. Select an unused trigger (by number) by choosing the drop-down
arrow under the column named “Input Signal” and adjacent to the
desired trigger. Input Signal value will indicate OFF if it is not
selected.

3. Begin choosing and filling in parameter values. Note that all fields
are required for Power Quality Triggers, however some field values
may be “OFF” or “0”. See Section 7.3.2 for details.

4. Note that “References,” the values across the top of the individual
trigger parameters, are the RMS voltage and current values you
would expect under normal operation.

< g COML0-rs232 Configure Trigger Parameters x
= User Tringers References
- Sehulz Laias Y Al BY Bl (oY) cl ]
Power Quality iH [5 [115 [5 [115 [5 o
Triggers
Trigger|  Channel|  LimtFunction| Limt|  LimtModz|  Reference Mode | Hysteresis|  Hysteresis Mode | Mult »

1 ChAY v ws it 0 Absohz v Absalute
0 Abschte v Absolute
0 Absolute v Absolute
0 dbsoluiz v Absolute
0 fbsohuiz = Absolute
0 Absohiz = Absolute

0 Absolute
0 Absolute
0 absolute
0 &bsolute
0 Absolute
0 Absolute

2 ChEY | %> lmt
3 ET- >
1 of v lmt
5 of v lws lmt
3 of  =lws fmt
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[ENENRNRUENE!
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Lelelelalals
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Figure 7.19: Power Quality Trigger Detail

7.6.3 Auxiliary I/O Module

The Auxiliary I/O Module cannot be configured from PSCSV. Perform all
event input and relay setup from the front panel of the Model 933A. See
Section 7.5 for details.
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Chapter 8

Specifications

8.1 Introduction

While the Model 933A directly measures voltages, currents and frequency,
all other values — such as power and energy — are derived from these
measurements and the internal clock. Flexible input connectors and
instrument configuration allow you to connect to most common electrical
systems. Optionally, a GPS module or IRIG-B signal may synchronize
the internal clock to provide synchronized measurements. Possible input
configurations and ranges are specified below.

8.2 Input Configurations

3 Phase (3P) 3-element, 2 %—element, 2-element

1 Phase (1P) 2-element, 1 3-element, 1-element

Input Voltage

Range (3P/1P) 1 — 650 Vrms, maximum — selectable (phase-
to-phase for 2 element, phase-to-neutral for 2 %
and 3 element).

Overrange 700 Vrms, nominal, 1200 Vpeak



Input Current

Range (3P/1P) 1 - 20 Arms, maximum - per element
Low range 1mA-1A

Overrange 23.5 Arms, nominal (maximum continuous input
current: 20 Arms per element).

Volt-Amps, Watts, Volt-Amps-Reactance

Range Product of rated voltage and current ranges and
number of elements.

Compensating Constants and Ratios

CT and PT Nominal ratios, magnitude and phase compensa-
tion, CT uses 12-point non-linear interpolation.

Transformer Both iron and copper loss.

Input Frequency Range

Range 45 — 65 Hz, for specified accuracy.
Harmonics 3 kHz

Input Connector Ratings

Voltage Safety Banana, color-coded per phase
Current 5-way binding post, including safety banana
Insulation 400 Volts, nominal, to neutral/chassis, surge

voltage class II1

600 Volts, nominal, to neutral/chassis, surge
voltage class 1T

8.3 Instrument Interface

Front Panel Indicators and Controls

Keyboard 30 keys, for status and configuration; including
5 soft function, 7 dedicated function, 5 cursor
control, power on/off and 12-button numeric key
pad

Display Graphical LCD — 3 x 3.9 inches, 240 x 320 dpi,
backlighted
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Communications

Serial
USB

Protocols

Proprietary
Supported

RS-232C, RJ11 modular connector
Version 1.1, B-Type receptacle

PowerSentinel CSV (PSCSV)
CSV, COMTRADE, PQDIF

Flash Memory Data Storage

Capacity

Data

Storage Rate

Lifetime
Data Retention

128 MB x 2, standard; 2 separate flash cards
One used for 1-second data

One used for waveform

Selectable from all functions measured and total-
ized by 933A; each record is stored with a time
tag

Selectable

Event data stored upon occurrence

100,000 cycles

Indefinite; no power or battery required to retain
data

DSP Configuration

Configure

Unit Type

Configuration

Mode

Using PSCSV, configure DSP Mode, CT-PT ra-
tios and transformer loss compensation. Internal
calibration set at factory.

Texas Instruments, TMS320C32 Floating-Point
DSP

(Default) 120V, 5A, 60Hz, 3PH4W3EL; Other
system configurations made through the front
panel or PSCSV software.

All structures initialized to know default settings
(calibration values done after initialization).
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8.4 Optional Auxiliary I/O Module

Connection between the Auxiliary I/O Module and the Model 933A is
through dedicated cable on the Auxiliary I/O Module that connects to
the Auxiliary I/O Connector on the Model 933A.

Programmable Contacts

Type 2 each, Form C (SPDT)
1 each, Solid State (KYZ rated)
Connections screw terminal
Rating 250 Vac/125 Vdc, 8 A maximum, 2000 VA /150

W maximum
Isolation 4000 Vrms for 1 minute to chassis

Event Input Connections

Type and Four, optically-isolated; one at 24 to 240 Vdc,
Number one 5 V logic level, and two contact closure
Isolation 4000 Vrms for 1 minute to chassis

Resolution 1 ps

8.5 System Control and Monitoring

System Time, Phase and Frequency

System Time Unlimited accumulation with 41us resolution
Frequency 7 digits, xx.xxxxx Hz
System Phase 0 to 360° with 0.01° resolution

8.6 Synchronization

Optional IRIG-B Unmodulated Input

TTL-Level Shift per IEEE 1344 as output from any Arbiter Systems clock
model.
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Optional Remote GPS (DISCONTINUED)

Tracking GPS-L1 (1575.42 MHz)
12 channel (tracks up to 12 satellites)
Acquisition 2 minutes typical
Accuracy UTC-USNO =1 us (only 1 satellite with
correct position needed)
Out-of-Lock Via system interface and status display;
Indication optional, via contact closure.

Timebase Error

GPS locked Less than +1 us, when locked to at least one
satellite with correct position

Unlocked 10 ppm, typical, after being locked to
10 minutes minimum (< 1 second/day unlocked,
typical)

IRIG-B Less than +1 us + accuracy of IRIG-B source

8.7 Measurement Specifications

NOTE: Accuracy specifications include all sources of uncertainty. Except
as noted, specifications apply for the full operating range, including
temperature (-10° to +50° C), line voltage, input range including specified
over-range, power factor, input frequency, and drifts over a one-year
calibration interval. Specifications assume synchronization to GPS and
operation in 3-element mode or in a well-balanced system where imbalance
does not degrade accuracy.

Accuracy

Watts, Wh 0.05% of reading, for voltage 7 to 650 Vrms and
current 10 mA to 20 Arms and PF > 0.2

Underrange 0.005% multiplied by (10 mA /I rms) for current
< 10 mA rms, typical

Vrms 0.05% of reading! or £5 mV, whichever is greater
Arms 0.05% of reading! or +0.1 mA, whichever is
greater
Low range 1% of reading
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Accuracy, continued

Phase Angle, ¢
Under range
VA, VAh

VAR, VARh

Power Factor

Harmonics

Frequency

System Phase
System Time
Event Inputs

0.01°, phase-to-phase or voltage-to-current!
0.05° (current 10 to 50 mA rms)

0.05% of reading?

0.1% (current 10 to 50 mA rms)

Same as W, Wh except replace PF with
V1—PF?

0.0002 x sin(¢p)*

0.001 x sin(¢) (current 10 to 50 mA rms)

0.1% THD or 5% of reading, whichever is greater

< 1 ppm (0.0001%) of reading, 50 or 60 Hz
nominal, plus timebase error

0.03° + [timebase error x360°x frequency]?

1 us + [timebase error]?
+10 us (typical)

L For voltage 50 to 650 Vrms and current 50 mA to 20 Arms.

2 With GPS option.

Phasors

Standard
Rate

Per IEEE Standard 1344 or PSCSV
20 Measurements/second

8.8 General

Physical

Size
Weight

Environment

Temperature

Humidity

205 x 305 x 225 mm (8 x 12 x 8.8 in.)
5.8 kg (12.8 lbs), maximum

-10° to + 50° C, Operating
-40° to +75° C, Nonoperating
Noncondensing
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8.9 Power Requirements

Internal Battery

Type NiMH

Operation 8 hours, typical
Charging 4 hours

Standby Use 5 VA, typical

External Power

Range 85 to 264 Vac, 47 to 63 Hz or 120 to 275 Vdc, 25
VA typical 5 VA typical stand by use
Input IEC connector with fuse; surge withstand per

ANSI C37-90.1 and IEC801-4 standard

128



Chapter 9

Functional Description

9.1 Scope

Information in this section describes some of the components, functions
and capabilities of the Model 933A.

9.2 Overview

The Arbiter Systems Model 933A Portable Power Sentinel consists of
several blocks. They are: voltage and current inputs, and analog-to-
digital converter; digital signal processor; host processor; display and
keyboard; I/O functions; battery with charger, and power supply; IRIG
(GPS optional DISCONTINUED) timing synchronization. The button
features of the instrument and its measurement functions are described in
the sections, which follow.

Two microprocessors are required to handle the many tasks being per-
formed continuously in such a highly integrated portable instrument.
A Texas Instruments TMS320C33 floating-point DSP unit performs the
digital signal analysis tasks. Instrument I/O functions and interface
to the “real world” are handled by an SGS-Thompson ST10F167 16-
bit microcontroller. Both of these processors have significant additional
processing power, which is not used in the initial version of the 933A. This
will allow for the future expansion of features, which is sure to come, with
a minimum amount of upset; indeed, many future enhancements should
be possible with only a firmware upgrade.
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9.3 Clock Synchronization

To provide accurate time synchronization for power measurements, the
933A can use either IRIG-B timing signal from a GPS clock, such as the
Arbiter 1084A/B/C or 1093A/B/C or an optional twelve-channel global
positioning system (GPS) receiver. Proprietary technology developed by
Arbiter Systems and refined in several generations of GPS timing products
also help to achieve accuracy. By comparing the internal 10-MHz crystal
oscillator to the 1 PPS from an IRIG input or the output of a GPS receiver,
the 933A can maintain its frequency at any time within a few parts in 1010,
and time within one microsecond. All of the internal timing signals are
derived from this accurate timebase. If no external timebase is provided,
the 933A keeps time with an internal real-time clock.

9.4 Current Inputs

The current inputs of the 933A are implemented in a removable module.
The standard current module is a three-phase, current input designed to be
accurate to a few ppm over time and temperature (see “Error Analysis”).
This current input section uses a two-stage process, similar to a two-stage
current transformer except that the first stage, with active feedback is
designed to cancel transformer errors and the second stage provides the
current-to-voltage transfer. The current inputs have an accuracy of a few
parts per million.

9.5 Voltage Inputs

The voltage inputs uses low-TC (temperature coefficient) voltage-divider
resistor networks as signal attenuators. Voltage inputs may be configured
as a three-phase, three-element input, with four connections (A, B, C, and
N), or configured as a two-element input, with independent connections to
each element (A+, A-, C+, and C-, for example).

130



9.6 Error Analysis

All identified sources of error in the 933A have been quantified using worst-
case manufacturers’ performance data. These have then been combined
using a root-sum-of-squares (RSS) method to yield a performance estimate.
Effects due to initial calibration, measurement noise, temperature, and
aging are all included. The reason for using RSS analysis is beyond
the scope of this paper. However, we have found in our many years’
experience building calibration instruments that this method yields the
most realistic estimate of actual worst-case performance, provided that
numerous errors contribute significantly to the overall performance (i.e.,
no one error dominates), and provided that worst-case actual data is used
for the analysis.

The error analysis, used for the 933A power or energy measurements, is
shown in Table 9.1. Similar analyses have been performed for the other
functions of the instrument, and include most of the same factors shown
here.

Temperature Errors, 0-50° C Error, PPM

Current Input, resistor TCR 63
Voltage Input, resistor ratio 50
Voltage Reference (x2) 50
Cal. Source, resistor ratio (x2) 25
Time Stability, 1 year —
Current Input, resistor 25
Voltage Input, resistor ratio < 20
Voltage Reference (x2) 36
Cal. Source, resistor ratio (x2) < 40
Measurement Noise 10
Total RSS Error, Basic 117
Calibration Errors -
Cal. Artifact, Rotek MSB-001A 50
Traceability to National Standards 50
Total Error, RSS 136
Specification (0.05%) 500

Table 9.1: Power/Energy Error Analysis
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9.7 Signal Sampling

Each of the signals, representing the scaled voltage and current inputs have
their own ADC. Each signal is sampled simultaneously at a rate of 10,240
samples per second. If connected to an external timing source (e.g. GPS)
it provides the sample clock to the 933A, it is synchronized to UTC-USNO
(GPS), allowing measurements of phase angle across a power grid to be
compared directly.

9.8 Power and Energy

Power and energy are determined by making twenty separate measure-
ments per second of the cross product of voltage and current for each
phase. Each measurement uses 1024 samples (i.e., it takes data from a 100
millisecond window), yielding a 50% overlap.

Apparent power (VA) and reactive power (VAR) are determined from
the results of the voltage and current magnitude measurements (see
next section), using standard identities. The active power measurements
and reactive power measurements are then compensated for PT and CT
corrections (see below) using a complex multiplication, and corrections are
performed for transformer iron and copper losses, if enabled.

At this point, two different things are done with the resulting measurement
data. First, a determination is made of the quadrant in which this
data should be registered (Wh delivered or received, VAR delivered or
received.) The results of each measurement cycle (20/sec) are then added
to the proper set of registers. These registers are stored periodically, and
accumulation restarted from zero. The user may configure the unit for
different intervals to register energy.

The second thing that is done with the data is to determine the actual
power level. This number will be displayed on the front panel (as watts
or VARs), and it will be returned via the serial interface if a simple
request for “power” is made. This result is calculated by averaging the
20 power measurements made during each second. Therefore, the update
rate for this quantity is once per second. This data is not registered
separately depending on the quadrant, as the energy data is; therefore, it
is theoretically possible, if the direction of power flow changes periodically,
that the sum of measurements reported over the serial interface may
gradually depart from the registered energy data. This is due to the loss
of information in the averaging process; the registered data are the most

132



accurate. The averaged data are provided primarily as a convenience or
for system control purposes; it is not intended for billing purposes.

9.9 Voltage and Current

Voltage and current are measured in a similar fashion to power, using
overlapping 1024-point measurements. In this case, however, the cross
product is replaced with the square of the voltage or current samples.
The square root of the resulting sum is proportional to the rms voltage or
current value during the measurement interval. This value is corrected for
the CT and/or PT correction factors before further use. The 933A uses
the resulting data to correct the energy measurements, as described above.
It also provides data to the host system by averaging it over one-second
intervals.

9.10 CT and PT Compensation

To correct for the inaccuracies of the CT’s and PT’s used in the metering
setup, CT and PT compensation may be enabled. Since the system voltage
is relatively constant, the PT compensation factor is a single, complex (i.e.,
magnitude and phase, or real and imaginary) correction factor.

CT compensation is more complicated than PT compensation. Due to
the fact that magnetizing currents in CT’s are not exactly proportional
to the load current, a matrix is used. This allows the entry of several
different compensation factors measured at different current levels. The
933A interpolates between the numbers in this table (also complex) to
determine the correction factor to be used.

Correction for energy is performed using the (complex) product of the
PT and CT factors. Correction for voltage or current is performed using
the magnitude of the appropriate factor. Correction for phase angle is
made using the phase of the appropriate component, i.e. the arctangent of
the complex value. The actual calculation performed may be different
than this description, due to computational considerations (a complex
multiplication is far faster than a trigonometric operation such as an
arctangent, for example); however, the end result will be as described.
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9.11 Transformer Compensation

There are two different types of transformer compensation. They are used
to correct for the losses in a transformer when primary-side metering is
used to meter the energy delivered to a customer at the secondary of the
transformer.

Copper compensation is used to correct for the I?R losses in the trans-
former windings due primarily to their (nonzero) resistance. As you would
expect, this effect is primarily active (resistive), although there may be
minor reactive effects, and it is proportional to the current squared. This
factor allows the user to correct for these losses. It is a complex factor,
providing both watts and VARSs correction, and is proportional to current
squared; i.e. so many watts and VARs are to be subtracted from the
registered amounts per ampere squared of load current.

Iron losses (also called core losses) are due to magnetizing currents (the
small amount of current required to generate the flux in the core, which is
unrelated to the load current) and eddy current losses in the core material.
These are approximately proportional to the square (watts) or 4th power
(VARs) of the voltage, and the compensation is performed using the same
basic method as described above for copper loss.

9.12 DC Offsets

DC offsets may be present in the signals applied to the input of the
933A, although this is unusual. More commonly, small dc errors in the
measurement circuit result in nonzero average of the samples.

This potential source of error must be corrected to obtain maximum
accuracy, since the 933 A makes wideband measurements of power, voltage,
and current. Components at any frequency within the measurement
bandwidth, including dc, will affect the measurement. Therefore, part
of the measurement process is to average the (windowed) data, measuring
the dc component. The effects of dc offsets are then subtracted from the
results.
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9.13 Phase and Frequency

As a part of its measurement process, the 933A performs a fast Fourier
transform (FFT) of the windowed voltage and current samples. In
accordance with TEC 61000-4-7, this process is performed twenty times per
second, using overlapping 1024-sample Hanning window data. This yields
new FFT results twenty times per second for each voltage and current
input, for a total of 120 FFT’s per second. Phase angle may be determined
from the relationship between the real and imaginary component of the
fundamental-frequency bin of the FFT. (Since the window is 100 ms wide,
each bin is 10 Hz apart; therefore, this is bin 5 for 50 Hz and bin 6 for 60
Hz.)

So long as there is significant measured energy in the bin, frequency offsets
do not affect the measured phase angle. This is true as long as the signal
being measured is the main source of energy in the bin; i.e. there is
minimal leakage from adjacent bins, and minimal noise. Provided that
the frequency is anywhere near nominal (within 10 Hz or so), the phase
measurement is perfectly usable.

The phase measurements may be compared to determine phase angle
between voltages and currents or between any two voltages or currents.
Because the sampling process may be synchronized via IRIG (GPS) to
UTC, absolute phase angle measurements may be made and compared
between two units located at some distance from one another.

Frequency is measured by taking the difference in phase angle between
subsequent measurements, based on the identity f = d¢/dt. Frequency is
averaged over one second prior to being displayed or made available for
output.

The 933A is the first product to make absolute (i.e. relative to UTC
time) phase-angle measurements available in an economical unit which
will be widely applied. Measurements of phase angle have been available
before, but most products have not offered accurate time synchronization,
and therefore most users are not experienced with the concept of absolute
phase. When synchronized to either GPS or IRIG-B, all phase angles in
the 933A are reported as absolute phase angles, relative to UTC (USNO)
top-of-second. A phase angle of zero degrees is defined as corresponding
to the positive maximum of a cosine wave being coincident with 1PPS-
UTC(USNO). Relative phase angles, for example between phases, or
between a voltage and a current, may be calculated by subtraction.
Relative phases of harmonics may also be found by subtraction; however,
the harmonic number prior to subtraction must multiply the fundamental,
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absolute phase. This is because the subtraction is actually one of time;
the purpose being to ’realign’ the reference point to correspond to zero
degrees on the fundamental. The phase angle corresponding to this time
shift is proportional to the frequency.

9.14 Harmonics

Harmonics are measured using overlapping Hanning window FFT’s of 1024
samples and 100 ms window length. Based on the instantaneous frequency,
the location of the bins containing significant energy for each harmonic are
determined. This is a total of three bins, one approximately centered on
the harmonic and those two adjacent to it. Then, the energy in those three
bins is totaled, resulting in the energy for that harmonic. This can then
easily be expressed as a percentage of the rms signal level, or in whatever
form is required. While there is a closed-form correction, which can be
employed to find the harmonic magnitude in the presence of frequency
errors, this approximation was chosen because it is much faster and gives
adequate performance.

There is an error in this approximation, due to the fact that there will
be a small amount of energy leakage into nearby bins, which will not be
included in the three measured bins. This is generally of little consequence
when the frequency is close to being accurate (which is most of the time),
since the amount of energy outside of the three bins summed is so low.
Finally, with the Hanning window, there is no signal at all outside of
these three bins if the frequency is exact. In the real world, however, the
frequency will be off somewhat, and it is reasonable to ask how large the
error can be. For small frequency errors, say 0.01 Hz, the 50th harmonic
will be 0.5 Hz from the center of the nominal bin. This results in an
error of about 0.005%, which is insignificant. The worst-case error will
occur when a harmonic is very nearly centered between two bins. In this
case, the algorithm described above will 'miss’ a bin containing a signal
with amplitude of about 17% of the actual harmonic amplitude. The
energy contained in this bin is then (0.17)2? or about 2.9% of the total
energy, resulting in a measured energy 0.971x what it should be. The
measured harmonic amplitude will then be (0.971)0.5 or about -1.5% in
error. This is well within the specification limits (5%) of TEC 61000-
4-7. This worst-case error would occur for the 50th harmonic with a
fundamental frequency error of 0.1 Hz. At lower harmonics, the frequency
error must be progressively greater; for example, to result in a -1.5% error
in measuring the 9th harmonic would require a fundamental frequency
offset of 0.556 Hz. The phase angle of the harmonics is determined by
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taking the arctangent of the real and imaginary components of the bin
closest to each harmonic. This information cannot be used, however, in the
averaging process described in IEC 61000-4-7, because this specification
requires the rms average of a series of measurements. This, by definition,
requires magnitude data only. Therefore, there are two different harmonic
tables available from the unit. The averaged harmonic data, in accordance
with TEC 61000-4-7, is provided in a 300-element array (6 channels x 50
harmonics), averaged over the interval specified by the user (typically 10
or 15 minutes). The harmonic magnitude and phase data are provided in
a 600-element array, once per second. The harmonic magnitude is the rms
value over the preceding second, and the phase angle is the ‘instantaneous,’
absolute (based on a 100 ms window centered at top of second) phase angle,
as described in the preceding paragraph.

9.15 Flicker

Flicker is measured in accordance with IEC 61000-4-15, the successor stan-
dard to IEC 868. Unlike the other measurements described above, flicker
measurement is a continuous process. This process is performed using
a sample rate of 640 samples per second (sps). Anti-alias (decimation)
filtering is performed on the 10240 sps data stream, and the resulting
samples are further processed following the block diagram suggested in
IEC 61000-4-15. The resulting measurements of flicker perceptibility are
classified using a 256-level logarithmic classifier at the full 640 sps rate.
Pst is then determined every ten minutes (or as specified), as described by
the standards.

Although no standards currently require it, the 933A also measures
flicker on the current inputs. This information can be useful in determining
whether a customer’s load is causing flicker on the power system, or
whether the customer is being subjected to flicker from other sources. It
is unrealistic to penalize a utility for ‘poor power quality’ at a customer’s
load when the cause of the problem is the load itself.

9.16 Interruptions

Interruptions are monitored on the voltage inputs by comparing the
20/second voltage measurements with a user-supplied threshold. Events
are triggered when the voltage dips below the preset threshold. These can
cause the logging of pre and post-fault data, contact closure, or any of the
other actions described under “Event Logging.”
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9.17 Voltage Fluctuations

Voltage fluctuations are monitored by classifying the 20/second voltage
data, per phase, with a 256-step linear classifier covering a range of +20%
of nominal voltage. These data are then summarized as a cumulative
probability table over a specified interval — typically 15 minutes. In
addition, the minimum, maximum, mean and standard deviation are
calculated. The data may be recorded in flash memory either continuously
or on demand. Voltage fluctuations corresponding to system stability
events may also be monitored and a trigger generated using Schulz-Laios
filtering of the voltages.

9.18 System Time Deviation

System time deviation, which is the accumulated error of a clock using
the system frequency as its reference, compared to an absolute reference
such as UTC, is determined from the 20/second phase data described
earlier. System time deviation is accumulated as integer cycles of error
plus fractional phase, and is converted to seconds as needed. The positive-
sequence voltage phase angle is used for this measurement. Since this is
an integrated value, the constant of integration (initial time offset value)
must be specified by the user.

9.19 Phasor Measurements

Phasor data are formatted and output in accordance with IEEE Standard
1344-1995. Phasors consist of the real and imaginary component of
magnitude for the voltages and currents at a particular point in a power
distribution system, along with suitable time synchronization fields and
other information. This information is available in real time, and is based
on the measured fundamental voltage, current, and phase angle described
above, at a rate of 20 records per second. There is a measurement delay
due to the data acquisition delay of 50 ms, signal processing time of
approximately 15 ms, and data transfer time which depends on the data
rate.

9.20 Phase Balance

The 933A measures phase balance by calculating the symmetrical sequence
components (positive, negative, and zero sequence) for the three-phase
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voltage input. Normally, if the unit is connected properly, the positive-
sequence voltage will be equal to the line voltage and the negative- and
zero-sequence voltages will be approximately zero. In the event that
a user-specified limit on the imbalance (See “Triggering,” later in this
section) is exceeded, an event will be recognized. In addition, the sequence
components are averaged over a user-specified interval (typically 10 or 15
minutes) and may be logged if desired. These calculations are performed
using the voltage magnitude and phase information, 20/second.

9.21 Load Balance

Load balance is calculated in much the same way as phase balance, except
on the customer’s load current. The 933A uses both of these measurements
to identify serious power system problems, such as a dropped phase, which
could cause serious damage to the utility’s and the customer’s equipment.

9.22 Flash Memory and Event Logging

The 933A has two separate 128 megabyte flash memories for data and event
logging. One memory is used exclusively for storing waveform data. The
waveform data is stored for all input channels at the full data rate with 16
bit resolution. One half second of waveform data is continuously stored in
RAM. Once an event designated to record waveform data occurs, this data
is transferred to Flash and waveform data continues to be stored according
to user defined times and conditions. About 10 minutes of waveform data
may be stored.

The other Flash memory may be used to record three basic types of
information: (1) registered quantities, (2) event data, and (3) system
status events. Registered quantities are recorded on a fixed schedule and
may include many more items than a typical energy meter, including just
about any function the instrument can measure. The event data are logged
on the occurrence of an event designated to initiate logging. System status
is used for advanced monitoring and control of the operation of the 933A
and the system node to which it is connected.

Events are defined as any measured quantity exceeding a user-specified
threshold, an external trigger, or an internal state of the 933A (low flash
memory, for example).

There is a great deal of flexibility as to what may be recorded in flash
memory at the time an event is recognized. Recorded information may
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any of the following:

e Time of event

e Type of event

e State of measured quantities

e Pre and post-event data

e Any of the measured quantities - e.g. voltage, power, waveform, etc.

The 933A must be configured in advance to specify the events being
recognized and actions to be taken.

To maximize usage of flash memory, it is important to distinguish
registered quantities from event log data. The amount of memory needed
to record a certain number of registered items for a certain period can be
determined exactly, whereas the amount of memory required to log events
depends on the number and type of events, and the number of items to
be recorded for each type. Since the number and type of events cannot
be known a priori, the amount of memory required also cannot be stated
with certainty. The 933A handles this by allocating sufficient memory as
required for the registered quantities over the specified period of time, and
then making whatever memory is left available for event logging. To deal
with low register or event memory conditions, the 933A can be configured
to initiate an auto-dial call or contact closure when the condition is met.

Two separate 128 MByte flash cards are allocated 1024 blocks each for a
total of 256 MBytes and purposed for different applications. Flash memory
must be erased in blocks, and data cannot be overwritten until its block
is completely erased. Therefore, the normal process will be to first read
out the desired data, and then erase the blocks, making them available
for reuse. Erase memory from the 933A front panel or through PSCSV
software. It is erased all at once; no partial erasures are possible.

9.23 Optional Contacts & Event Inputs

Four contact outputs may be used to report events recognized by the 933A.
In addition to reporting events, these contacts may be used to synchronize
external equipment or to operate load-control switch gear. See Section 7.5.

Four external optically-isolated event inputs are also provided and come
in three groups: (1) one accepts dc signals at levels from 24 to 240 volts,
(2) one at CMOS/TTL (5V) levels, and (3) two sets are contact closure.
Application of a signal to one of these inputs will be time-tagged to one
microsecond resolution. See Section 7.5 for setup information.
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9.24 Serial Channels

The two standard serial channels are RS-232 and USB. Each channel has
access to most functions of the 933A (excluding autolog and programming
Auxiliary I/O module). The RS-232 channel has a RJ11 (6-position)
modular connector useful for connecting with a standard phone cable. Use
a RJ11 to DB-9F adapter at the end of the phone cable to connect the
933A to a computer. These adapters may be rewired in the field to match
interface requirements. Both serial channels may be operated simultane-
ously, each serving different hosts with separate access authorization and
information channels.

9.25 Triggering in the Model 933A

The digital signal processor (DSP) in the 933A Power Sentinel measures
dozens of different parameters of the applied input signals, in many cases
at a rate of 20 measurements per second. Most of these parameters may
be used to trigger an alarm condition, based on preset thresholds and
conditions.

Triggering in the DSP works as follows. First, there are 31 different
measurement, types that may be selected for processing by the trigger
algorithm (Table 2). For each of these, there are (typically) four different
measurement channels, A, C, B and either average, total, or maximum (of
A C, and B). Thus, there are a total of 124 different signals (corresponding
to individual measurement results) which can be selected. Not all of these
are defined at this time, however.

Second, there are 32 trigger channels, which may be configured for use
concurrently (Table 3). Each of these may be set to use any of the 124
signals as their input. For each channel, there is a limit, which may be
set by the user, as well as a reference value, which may be used by the
trigger logic. The limit function logic may be set to any of four modes:
x > limit;x < limit, |x| > limit; or |v — ref| > limit. In addition, each
trigger channel may be made dependent on the results of another channel.
It may be set so that the channel requires the other trigger to be either
active or inactive before proceeding with its own comparison. Comparisons
are made at the 20 per second rate for all channels, even for input signals,
which change more slowly.

Each channel also has a dwell time, or delay time, register. Before it will
generate a trigger, the specified signal must exceed its limit condition for
a number of comparisons equal to this register (plus one). The register
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is a 16-bit unsigned integer, having a range of 0 to 65535 cycles. Since
comparisons are performed 20 times per second, this corresponds to a
range of dwell time of 0 to 3276.75 seconds. A value of 0 allows the trigger
to be recognized at any time the corresponding condition is true; a value of
1 (0.05 seconds) requires the trigger condition to persist for two consecutive
comparisons, and so on.

Considering all of the different input signal possibilities, along with the
different limit modes and inter-channel dependencies, there are an almost
limitless number of possible combinations of settings for each trigger
channel.

9.26 Detecting Oscillatory Transients and
Other Anomalies

Special logic is included in the 933A to implement the algorithms described
by Schulz and Laios [1], which are designed to detect power system
anomalies such as oscillatory transients. There are six channels dedicated
to performing this function in the 933A (Table 4). Each of these may
have any of the 124 signals described above as its input. Each channel
has three outputs: a low-pass-filtered (‘bound’) output, a rate-of-change
output, and an oscillation-detector output. Each channel also has three
control parameters (in addition to the input signal selection): the rate-
of-change filter time constant (T1 in [1]); the oscillation-detector time
constant (T2 in [1]); and the oscillation-detector reset threshold, also
described in [1]. These parameters control only the operation of these
signal-processing blocks, and do not in themselves generate any triggers.
To generate triggers, select one of the three outputs of one of the channels
in this block. This serves as an input to one of the 32 trigger channels. As
recommended by Schulz and Laios, the input filtering for this block is the
BPA #1 low-pass, described in [2], which is a 12-point Hanning-weighted
FIR low-pass filter having a group delay of 0.3 seconds at a 20/second
sampling rate.
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Table 9.2: Signal Functions Available for Triggering

ID#  Function Rate Channels
Available

0 Off 20/sec  N/A

1 Voltage 20/sec  A,B,C, Ave.!

2 Current 20/sec  A,B,C, Ave.?

3 Active Power (Watts) 20/sec  A,B,C, Total®

4 Relative Power (VARs) 20/sec  A,B,C, Total®

5 Apparent Power 20/sec  A,B,C, Total®

6 Power Factor (PF) 20/sec  A,B,C, Total®

7 Sequence Voltage 20/sec  Zero, Pos., Neg.
Components

8 Sequence Current 20/sec  Zero, Pos., Neg.
Components

9 Phase Bal. Ratio, Derived  20/sec  Zero, Pos., Neg.
from sequence components

10 Frequency and Time 20/sec  Freq., DF, df/dt, DT

11 THD Voltage 1/sec  A,C,B, max (A,C,B)!

12 THD Current 1/sec  A,C,B, max (A,C,B)?

13 Harmonic Verms 1/sec A,C,B, max (A,C,B)!

14 Harmonic Irms 1/sec A,C,B, max (A,C,B)2

15 K-Factor, voltage 1/sec  A,C,B, max (A,C,B)*

16 K-Factor, current 1/sec A,C,B, max (A,C,B)?

17 Flicker, instantaneous, 1/sec A,C,B, max (A,C,B)!
voltage

18 Flicker, PST, voltage 1/sec A,C,B, max (A,C,B)!

19 Flicker, instantaneous 1/sec A,C,B, max (A,C,B)?
current

20 Flicker, PST, current 1/sec A,C,B, max (A,C,B)?

21-25  Reserved TBD TBD

26-31  Transient Detector, 20/sec  Bound, rate/ch., osc.
channel 0-5

1. Average or maximum of 3 voltage channels in 3P4W3E and 3P3W2E input mode,
1 channel in 1IP2W1E mode, and 2 channels in other modes. In 3P3W2E mode, the
voltage VAC is derived internally by point-by-point calculation after A/D conversion.
The voltage VB, synthesized internally in 3P4W21/2E mode, does not correspond to
an actual physical quantity and is not included in the analysis, although measurements
can be made on the synthesized signal.

2. Average or maximum of 3 current channels in 3-phase modes, 1 channel in 1P2W3E
mode, and 2 channels in other modes. In 3P3W2E mode, the current Ib is derived
internally by point-by-point calculation after A/D conversion.

3. Total of 3 elements in 3P4W3E and 3P4W21/2E modes, 1 element in 1P2W1E mode,
and 2 elements in other modes.
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Table 9.3: Trigger Channel Parameter Summary (32 Channel)

Function
Input Signal

Channel

Trigger Dependency
Master Channel
Limit Type

Dwell (delay) time
Limit Value

Reference Value

Range or Options

1-31, per Table A.2 above (set to 0 if not
used)

0-3, per right column in table above

0-2, Off, Active, Inactive

0-31, any other trigger channel

0-3; & > limit,z < limit, |x| > limit, |z —
ref| < limit

0-65535, 50 ms/count; 0 to 3276.5 seconds
Floating Pt, in measurement units (volts,
watts, ...)

Floating Pt, in measurement units (volts,
watts, ...)

Table 9.4: Schulz-Laios Transient Detector Algorithm Control

(6 Channel)[1]

Function
T1

T2

Oscillatory detector
Reset threshold

Input Signal
Channel

[1] Schulz, Richard P. and Beverly B. Laios, Triggering Trade offs for Recording

Range or Options

High-pass (rate detector) time constant, sec-
onds Minimum 0.05 seconds, typical 0.5 sec-
onds

Oscillatory detector low-pass time constant,
seconds Minimum 0.05 seconds, typical 5.0
seconds

Threshold in measurement units. Set to any
negative number to disable reset

0-31, per Table A.2

0-3, per right column in Table A.2

Dynamics, IEEE Computer Applications in Power; April 1997, pp. 44ff

[2] Hauer, John F., and Fazlollah Vakili, An Oscillation Detector Used in the BPA
Power System Disturbance Monitor, IEEFE Transactions on Power Systems, Vol.
5 No. 1, Feb. 1990, pp. 74ff
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Chapter 10

Connection Diagrams
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1P2W1E — Direct Connection
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Figure 10.1: 1-Phase, 2-Wire, 1-Element — Direct Connection




10.2 1P2W1.5E — Direct Connection
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Figure 10.2: 1-Phase, 2-Wire, 1-1/2-Element — Direct Connection
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10.3 1P3W2E — Direct Connection
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Figure 10.3: 1-Phase, 3—-Wire, 2-Element Direct Connection
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10.4 3P3W2E Delta — Direct Connection
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Figure 10.4: 3—Phase, 3—-Wire, 2-Element, Delta — Direct Connection
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10.5 3P4W2.5E — Direct Connection
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Figure 10.5: 3—Phase, 4—Wire, 2.5-Element Direct Connection
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10.6 3P4W3E — Direct Connection
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Figure 10.6: 3—Phase, 4-Wire, 3-Element Connection
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10.7 1P2WI1E — Using CT/PT
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Figure 10.7: 1-Phase, 2-Wire, 1-Element, Using CT/PT Connection
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10.8 1P2W1.5E — Using CT/PT
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Figure 10.8: 1-Phase, 2-Wire, 1 1/2-Element, Using CT/PT Connection
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10.9 1P3W2E — Using CT/PT
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Figure 10.9: 1-Phase, 3-Wire, 2-Element, Using CT/PT Connection
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10.10 3P3W2E — Using CT/PT
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Appendix A

Glossary

A.1 DHCP

Dynamic Host Configuration Protocol (DHCP) is a communications
protocol that lets network administrators manage centrally and automate
the assignment of Internet Protocol (IP) addresses in an organization’s
network. Using the Internet Protocol, each machine that can connect to
the Internet needs a unique IP address. When an organization sets up its
computer users with a connection to the Internet, an IP address must be
assigned to each machine. Without DHCP, the IP address must be entered
manually at each computer and, if computers move to another location in
another part of the network, a new IP address must be entered. DHCP
lets a network administrator supervise and distribute IP addresses from a
central point and automatically sends a new IP address when a computer
is plugged into a different place in the network.

A.2 DNS

A Domain Name Server (DNS) is used to map names to IP addresses
and vice versa. Domain Name Servers maintain central lists of domain
name/IP addresses and map the domain names in your Internet requests
to other servers on the Internet until the specified web site is found.
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A.3 DSP

Digital Signal Processing: DSP refers the hardware (DSP microcontroller
and associated components) and firmware (the programming code running
the microcontroller) that process the input signals and calculate the
required output data.

A.4 Ethernet

Ethernet is the most widely-installed local area network (LAN) technology.
Specified in a standard, IEEE 802.3, Ethernet was originally developed by
Xerox and then developed further by Xerox, DEC, and Intel. An Ethernet
LAN typically uses coaxial cable or special grades of twisted pair wires.
Ethernet is also used in wireless LAN’s. The most commonly installed
Ethernet systems are called 10BASE-T and provide transmission speeds
up to 10 Mbps. Connected devices compete for access using a Carrier
Sense Multiple Access with Collision Detection (CSMA/CD) protocol.

A.5 Fast Ethernet

Fast Ethernet or 100BASE-T provides transmission speeds up to 100
megabits per second and is typically used for LAN backbone systems,
supporting workstations with 10BASE-T cards. Gigabit Ethernet provides
an even higher level of backbone support at 1000 megabits per second (1
gigabit or 1 billion bits per second). 10-GB Ethernet provides up to 10
billion bits per second.

A.6 Flash

Nonvolatile memory used for storing programs and data. In the Model
933A, this term primarily refers to the 128-MB memory devices used for
data storage.
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A.7 K Factor

K-Factor is a weighting of the harmonic load currents according to their
effects on transformer heating, as derived from ANSI/IEEE C57.110. A
K-Factor of 1.0 indicates a linear load (no harmonics). The higher the
K-Factor, the greater the harmonic heating effects. It is calculated based
on the following equation:

(Vi x 1)% + -+ (Vao x 50)°

Al KFactor =
(A1) actor TR

where each component is multiplied by the harmonic number
(e.g.1,2,---,50), called a weighting factor.

Harmonic load currents significantly affect power distribution system
design. Harmonics create additional losses through the skin effect at high
frequencies and through higher RMS load currents. By specifying K-Rated
transformers and using other techniques, power distribution systems and
customer equipment should have lower failure rate.

Harmonic Summary data returned from the 933A can be a strong indicator
of what harmonics are being returned to the distribution system location
by users with nonlinear loads. Harmonic content is potentially damaging
both to the power company and the user. Without adequate protection,
equipment will experience early failure and reduced overall efficiency.

A.8 KYZ (Pulse Metering)

KYZ Pulse Metering is a method of measuring energy usage by mechanical
contact closures and openings at the meter. Each opening and each closure
are separately counted as one energy unit, which unit is normally assigned
by the utility provider. KYZ pulse metering is normally counted at the
end of a line connected to the meter.

A.9 Kp Register Scale Factors

Kp register scale factors are used to scale the weighting of pulses in KYZ
pulse metering. For more information on scale factors, see Section 7.5.3.
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A.10 Linking

Establishing communications between the Model 933A and a computer
device. Normally, this is done using PSCSV software.

A.11 RMS K

RMS K is the rms sum of all of the harmonic energy, including the
fundamental (i.e. 1 — 50), with each harmonic multiplied by the square
of the harmonic number. It has the same units as the signal, i.e. volts or
amps. For a clean signal, it will be almost exactly equal to the fundamental
value. RMS K is calculated from the following equation.

(A.2) RMS(K) = +/(Vi x 1)24 -+ (V50 x 50)2

where V7 is the fundamental voltage and includes all the harmonics up to
the 50"

A.12 RMS THD

The RMS Total Harmonic Distortion, or THD, is the rms value of all of
the harmonics 2 - 50 and has the same units, volts or amps. RMS THD is
calculated from the following equation:

(A.3) RMSTHD =/VZ+ -+ V3

where V,, is the harmonic rms voltage, and n equals harmonic number.

A.13 TFTP

Trivial File Transfer Protocol (TFTP) is an Internet software utility for
transferring files that is simpler to use than the File Transfer Protocol
(FTP) but less capable. It is used where user authentication and directory
visibility are not required. TFTP uses the User Datagram Protocol (UDP)
rather than the Transmission Control Protocol (TCP). TFTP is described
formally in RFC (Request for Comments) 1350.
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A.14 THD F

THD F is the Total Harmonic Distortion compared to the fundamental
and expressed as a percentage. THD F is calculated from thee following
equation.

/V2 ... 2
(A.4) THD(F) = Vot  Vo 19

Vi

where V; is fundamental voltage, and V5o is the highest measured har-
monic.

A.1l5 THD T

THD T is the Total Harmonic Distortion voltage compared to the total
voltage (fundamental plus harmonics) and expressed as a percent. THD
T is calculated from the following equation.

VVE+- V2
(A.5) THD(T) = Y22 ot V50 g0
VVE+ -+ VG

where the denominator now includes the sum of rms harmonic voltages
plus the fundamental.
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Appendix B

Uploading New Firmware

The Model 933A Portable Power Sentinel allows you to upload new
firmware via the RS-232 port from a connected computer with a serial
port. If your computer does not have a serial port, then you can use
a USB-to-Serial adapter to connect between the cable/adapter assembly
that comes with the 933A and the computer.

B.1 Obtaining the Latest Firmware

Download the latest firmware version and 933uploader vXXXX.exe pro-
gram from the Arbiter Systems web site. The web address is listed below.

http://www.arbiter.com/pscsv/933index.php

The firmware will be in zipped format and does not need to be unzipped to
use. The uploader program automatically extracts the file before uploading
it to the 933A.

IMPORTANT! Do not halt the progress of uploading the new file
into the 933A or it may not be recoverable. Especially, do not turn
off the power to the 933A when the upload is in progress. If the
upload stops for any reason, do not turn off power to the 933A.
Try to restart uploading the file again.
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B.2 Uploading Procedure

1.

Connect the cable(s) and adapters between the computer and the
933A RS-232 port.

. Start the uploader software, 933Uploader.exe. It should appear as

shown in Figure B.1.

Check the communication settings on the Model 933A. Press the
DISPLAY key, then 9-Config & Status. Under the heading COM-
MUNICATION, make sure you verify the baud rate.

. On the 933A Flash Update Application (933uploader.exe), select

Settings > Serial Port and select the correct port.
Select Settings > Upload Mode > RS-232 Serial Port.

Select Settings > Baud Rate > (select the same baud rate as the
933A discovered in step 3).

933 Flash Update Application
File Settings Taools Help

E]0

933 Upload pragram. ..

Method: R5-232 Port: COM3 Baud: 35400

Figure B.1: Starting the 933A Uploader
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7. Click the Open button or select File > Open.

Browse to locate

the zipped firmware that you downloaded, select the file and click
Open. The uploader should automatically extract the zipped file
ready for upload to the 933A. The uploader window should appear
as in Figure B.2 and provide the firmware information.

933 Flash Update Application

CEX

File Settings Tools Help

=l ©

233 Uplaad pragram. ..

933 firmware file Information:
Mame: 933 _firmware_v106.zip
Path: Ci\Documents and Settings)JimiDesktop
Wersion Dates...
Host: 1.06 17 Sep 2007
DSP; 31 Aug 2007
EBattery Charger: 12 Ock 2004
Current Module: 19 Dec 2006

Method: R5-232 Port: COMS

Eaud: 115200

Figure B.2: File Information for Newly Extracted Firmware

8. Click the Upload button (blue with a white UP arrow) and the file
will transfer to the 933A. The uploader will start by erasing flash in
the 933A, and indicated by the progress screen. After flash has been
erased, the program should indicate the progress of the upload with

a progress bar as seen in Figure B.3.

Upload 933 Unit

3% (16 of 443)

Figure B.3: Uploader Progress Window
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At the completion of a successful upload, the uploader application
will indicate the time that the firmware Update was completed and
that it was successful as indicated in Figure B.4.

933 Flash Update Application
File Settings Tools Help

=l ©

Mame: 933_firmware_v106.zip
Path: C:\Documents and Settings) Jim\Deskkap
Wersion Dates. ..

Host: 1.06 17 Sep 2007

DSP: 31 Aug 2007

Battery Charger: 12 Ock 2004

Current Module: 19 Dec 2006

13

#0333 update starked (15:12:13)
% 033 updated successFully! (15:13:23)

£

Method: RS-232 Port: COMS Baud:115200

Figure B.4: Successfully Uploaded File Information

9. You can close the uploader program.

10. The 933A should be ready to use, and not need to have power cycled.

If you should have any questions about uploading new firmware to
the Model 933A, contact the Arbiter Systems technical support at the
information listed on page ii.
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Appendix C

CE Mark Certification

C.1 Introduction

The following page contains the individual CE Mark Certifications for the
model covered in this manual. This includes Model 933A.
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Declaration of Conformity with European
Union Directives

Date of Issue: March 27, 2008

Directives: 89/336/EEC Electromagnetic Compatibility
73/23/ EEC Low Voltage Safety

Model Number(s): 933A Portable Power Sentinel

Manufacturer: Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446 — USA

Harmonized EN55011 Class A, Radiated and Conducted
Emissions

Standard EN50082-1 Generic Immunity, Part 1

Referenced: Residential, Commercial and Light Industrial
environments

EN61010-1 Safety requirements of Electrical
Equipment for Measurement, Control

and Laboratory Use.

INA

Signatory: Bruce H. Roeder

Signed:

This certificate declares that the described equipment conforms to the
applicable requirements of the directives on Electromagnetic
Compatibility 89/339/EEC, Safety 73/23/EEC, and amendments by
93/68/EEC adopted by the European Union.
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Index

933A Accessories
400 Amp direct CT, 8
811AT current lead set, 7
811CT current lead set, 7
813AT voltage lead set, 5
813BT voltage lead set, 5
816AT current lead set, 6
933A-02, 933A-03
low current modules, 9
adjustable bail, 8
auxiliary I/O module, 11
clamp-on CT, 9
gps antenna module (DISCONTIN-
UED), 10
included, 2
933A Theory, see Functional Description

anticreep, 88, 89
Appendix
A, 158
B, 163
C, 167
application software
PSCSV™) 29
AS007900X, current shunt, 7
Aux I/O port, 22

bandwidth, measurement, 35
battery
charging, 15
specifications, 128
status screen, 16
symbol, 15
type, 1
broadcast values
basic data, 91
energy data, 92
harmonic summary data, 94
harmonic values, 93
list, 97
phasor data, 96
waveform data, 95

button (PSCSV) definitions, 81

CE mark, 167
CE mark certifications, 167
clock
free running, 29, 36, 37
sync with gps (DISCONTINUED),
36
sync with IRIG-B, 36
synchronized mode, 38
UTC or Local, 38
clock (RTC), 28
clock accuracy
free running, 29
synchronized, 29
clock synchronization, description, 130
communication
Ethernet, 86
ports, 21
RS-232, 22
USB, 21
configuration, instrument, 60
configure
measurement parameters
from PSCSV, 88
connection
electrical system diagrams, 145
with pc, see linking
connection diagram
3P4W3E using CT/PT, 157
connection diagrams
1P2W15E direct, 147
1P2W15E using CT/PT, 153
1P2WI1E direct, 146
1P2WI1E using CT/PT, 152
1P3W2E direct, 148
1P3W2E using CT/PT, 154
3P3W2E delta direct, 149
3P3W2E delta using CT/PT, 155
3P4W25E direct, 150
3P4W25E using CT/PT, 156
3P4W3E direct, 151
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connectors

Aux 1/0, 22

communication, 21

current, 19

gps (DISCONTINUED), 20

ground, 18

TEC-320, 22

IRIG-B, 21

list, 18

RS=232C, 22

time sync, 20

USB, 21

voltage, 19
contact outputs, optional, 11, 22
contacts, optional output, 140
copyright, v
CT compensation,

description, 133

CT/PT compensation, 42
current

inputs, 19

measurement, 133
current inputs, description, 130
Current Lead Sets, 6
current module

1 Amp, 9

20 Amp, 19

current shunt, universal test plug, 7

data types
using PSCSV software, 91
DC offsets, description, 134
detecting oscillatory
transients, 142
DHCP, 158
display
key, 23
lighting, 25
Display Menus
Basic Data List, 59
Config & Status

with GPS sync (DISCONTIN-

UED), 61

Config & Status, 60
Energy Tabulation, 57
Harmonic Results, 50
min-max setup, 48
Phasor Display, 58
Power Quality, 55

Flicker information, 56
Power Tabulation, 54
Tabular Results, 49
V & I Tabulation

Impedance, 53
Ratio, 53
Sequence, 53
V & I Tabulation, 52
Waveform Display, 51
DNS, 158
downloading data
broadcast data types, 91
Basic Data, 91
Energy Data, 92
Harmonic Data, 93
Harmonic Summary, 94
Phasor Data, 96
Waveform, 95
using Hyperterminal, 32
using Tera Term Pro, 31
DSP, 159

electrical system diagrams, 145
energy calculation, 132

error analysis, description, 131
Ethernet, 159

Ethernet, Fast, 159

event logging, 139

Fast Ethernet, 159
file transfer
bitmapped, 30
HyperTerminal, 32
Tera Term Pro, 31
flash, 159
flash memory, 139
description, 139
download events, 82
erase, 82
specifications, 124
status, 82
flicker meas. description, 137
frequency meas.,
description, 135
front panel description, 17
function keys, see keys, function
Functional Description
clock synchronization, 130
current inputs, 130
DC offsets, 134
detecting oscillatory
transients, 142
error analysis, 131
flash memory, 139
flicker, 137
harmonics, 136
interruptions, 137
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load balance, 139 on/off, 23

optional contact outputs, 140 print, 26
phase and frequency, 135 review, 26
phase balance, 138 setup, 24
phasor measurements, 138 soft, 24
power and energy, 132 Kp register scale factor, 117, 160
PT and CT KYZ
compensation, 133 Aux I/O Module, 115
serial channels, 141 contacts, 117
signal sampling, 132 pulse metering, 160
system time deviation, 138
transformer linking, 161
compensation, 134 933A and PC, 77
triggering, 141 load balance, description, 139
voltage and current, 133 loss compensation (xfmr), 89
voltage fluctuations, 138
voltage inputs, 130 measurement
fuse basic data, 59
replacing, 22 energy, 57
type, 22 flicker, 56
harmonic, 50
ground min-max, 48
chassis, 18 phasor, 58
power, 54
harmonics power quality, 55
broadcasting, 93 sequence voltages
capability, 3 and currents, 53
graphical, 50 show impedance, 53
measurement, 136 tabular results, 49
summary V I tabulation, 52
toolbar, 82 waveform, 51
summary data, 94 Menus
tabular, 50 edit, 79
toolbar, 82 view, 80
unwanted, 44 menus
high-speed data capture, 112 Display Menus, 47
HyperTerminal, see file transfer Setup Menus, 33
TEC-320 power inlet, 1, 22 neutral
installing synthesized, 19
low-current modules, 45 numeric keypad, 25
interruptions, measuring, 137
IRIG-B timing, 29 operation
issuance, ii ac power, 14
aux I/0 signals, 22
K Factor, 94, 105, 143, 160 basic, 14
keys, function battery, 15
cursor & enter, 25 battery charging, 15
display, 23 battery indicator, 27
display lighting, 25 chassis ground, 18
hold, 27 communication signals, 21
log, 26 connecting current signals, 19
numeric keypad, 26 connecting synchronizing signals, 20
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connecting voltage signals, 19 detecting, 142
data modes, 28

date and time, 28 pausing a download, 82
display phase balance, description, 138
basic, 59 phase measurement, 135
config and status, 60 phasor data, 82, 86, 96
energy, 57 phasor measurement, description, 138
harmonics, 50 power calculation, 132
min-max readings, 48 power input connector, 16, 22
phasors, 58 Power Quality, see measurement
power, 54 power quality, 102, 106
power quality, 55 Powering the 933A
voltage and current, 52 ac power cord, 14
waveforms, 51 battery, 15
gps signal (DISCONTINUED), 20 PT compensation,
internal clock, 28 description, 133
IRIG-B signals, 21
on/off, 23 Reviewing Data, 62
replacing a fuse, 22 changing view rate, 66
reviewing data, 62 data selections, 62
power quality, 70 downloading, 72
review rate, 66 erasing, 63
searching, 68 hold mode, 68
using PSCSV, 71 interpreting, 67
setting triggers, 101 logged, 64
setup per—second data, 73
autolog, 40 power quality, 70
CT/PT, 42 searching, 68
current, 44 selections, 66
custom DST, 43 waveform records, 75
input, 34 RMS K, 161
internal clock, 36 RMS THD, 161
low current modules, 45 RS-232C, 22
RS-232, 39
tabular results, 49 safety information, 12
triggers, 46 serial channels, description, 141
setup or configuration, 24 Setup key, 33
timing modes, 28 Setup Menus
USB or RS-232, 29 autolog, 40
using CT/PT, 42
display key, 25 current (range), 44
function keys, 23 custom DST, 43
hold key, 27 custom input, 35
log key, 26 input setup, 34
numeric keys, 26 internal clock, 36
print key, 26 low current modules, 45
review key, 26 real-time clock, 36
soft keys, 24 RS-232, 39
using PSCSV triggers, 46
configuring 933A, 85 signal inputs, 19
linking to pc, 84 signal sampling, description, 132
viewing modes, 28 soft keys, 24
oscillatory transients specifications
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communications, 124
compensating constants
and ratios, 123
contacts, 125
dsp configuration, 124
environmental, 127
event inputs, 125
flash memory, 124
front panel, 123
input configurations, 122
input connector ratings, 123
input current, 123
input frequency range, 123
input voltage, 122
measurement, 126
accuracy, 126
phasor, 127
physical dimensions, 127
power requirements, 128
protocols, 124
synchronization
GPS (DISCONTINUED), 126
IRIG-B, 125
system frequency, 125
system time, 125
timebase error, 126
VA, Watt, VAR, 123
status indicators, 27
battery level, 27
data modes, 28
date and time, 28
timing modes, 28
viewing modes, 28
status, instrument, 60
stopping a download, 81
support
request, iv
synchronized, 29
synchronizing, 20
using gps (DISCONTINUED), 20
using IRIG-B, 21
synchrophasors, 35
system time deviation, 138

Tera Term Pro, see file transfer
TFTP, 161
THD F, 162
THD T, 162
time (system) deviation, 138
title page, v
Toolbar
flash, 82
Toolbars, 81

broadcast, 81
configure, 83
connection, 81
input, 82
main, 81
records, 83
transformer compensation, 134
triggering, description, 141
Triggers
definitions, power quality, 108
definitions, user, 105
dependency, 105
erasing, 114
example, waveform, 113
high-speed data capture, 112
hysteresis, 109
logging time, 104
power Quality, 102
power quality, 106
power quality reference, 109
recording data, 101
recording methods, 101
relay settings, 117
setting user, 102
setting with PSCSV, 119
sliding reference, 111
user, 102
user trig definitions, 103
using Aux I/O Module, 115
viewing, 1-sec., 114
waveform capture, 112

Universal Test Plug Current Lead Sets, 7
USB, 3, 18, 21, 29
connecting, 85
description, 141
downloading waveform, 72
specifications, 124

version
manual, v
Virtual COM Port (VCP), 21
voltage
fluctuations, 138
inputs, description, 130
lead sets, 5
measurement, 133

warranty, iii
waveform data, see Broadcast
values
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